How can we help you?
Use the links below to find instructions, software training, one-on-one
support, technical specifications, or other resources to get Sage ERP
Accpac working smoothly for your business! Your Sage Business
Partner is also an excellent resource to consult when you have
questions about Sage ERP Accpac.
I'm setting up Sage ERP Accpac and need information or assistance
I'm looking for instructions to complete a task within Sage ERP Accpac
I think something is broken, or I'm getting error messages
I'm looking for downloads, updates, or technical specifications
I want to become a more skilled user of Sage ERP Accpac
I want to share knowledge with other Sage ERP Accpac users
I want to contact a Sage ERP Accpac representative

What's New in General Ledger 6.0
General Ledger 6.0 includes the following new features and
improvements:
Changes in Processing to Respect New Fiscal Period Locks
Fiscal periods are now locked separately for each Sage ERP Accpac
program in Common Services' Fiscal Calendar. Although this change
does not affect the way you enter transactions in General Ledger, you
should note the following points:
The program checks the status of a fiscal period when you enter
dates or when you add transactions.
If a fiscal period is locked for General Ledger, but not for another
Sage ERP Accpac program, you may be able to generate
transactions for General Ledger in the other program, but not post
them in General Ledger.
However, this situation is unlikely if you create and post General
Ledger batches for outstanding transactions in other programs
before locking General Ledger.
Revised Account Groups
In Version 6.0, we have modified the standard set of account groups
that comes with Sage ERP Accpac program .
To use the sample reports that come with Financial Reporter with your
own data, your accounts must be assigned to the same standard
account groups.
To use the new "snapshots" that are available in the Sage ERP
Accpac Portal, allyour accounts must be assigned to account groups
and all account groups must be assigned to group categories.
If you don't want to use general ledger data snapshots, you don't need
to remap existing accounts to new account groups.
If you have not used account groups previously, note that the Account
Groups form appears only if the Use Account Groups option is
selected in the G/L Options form.

New Group Categories
Group categories organize your accounting information especially for
presentation in the Sage ERP Accpac Portal. The new Income
Statement and Balance Sheet snapshots retrieve data from group
categories that are linked to your general ledger accounts through
account groups.
If you plan to use the general ledger snapshots, you must first:
a.

Ensure that all account groups are assigned to an appropriate
category from the new set of group categories. (Assign group
categories using the Account Groups setup form.)

b.

Ensure that all general ledger accounts are assigned to
appropriate account groups. (Assign account groups to group
categories using the Account Groups setup form.)
Rollup Accounts for All Editions
Rollup accounts are now available for all editions of Sage ERP
Accpac. Previously, rollup accounts were available only for the 500
Edition.
New FR Sample Statements
Financial Reporter includes a new set of sample statements that use
the new account groups.
If you want to use the new sample statements with your own data,
you must ensure that your accounts use the new standard account
groups. (If you use different account groups, you must customize the
report forms so that they use your account groups.)
If you do not want to use the new set of sample financial statements,
you can continue to use the statements that shipped with earlier
versions.
New Portal-Related Security Authorizations
Two new authorizations — Balance Sheet Snapshot and Income
Statement Snapshot — allow users to view and configure the Balance
Sheet snapshot and the Income Statement snapshot in the Sage ERP
Accpac Portal.

The new Accpac Inquiry authorization allows users to query General
Ledger data using Inquiry in the Sage ERP Accpac Portal. If they also
have Export General Ledger Data authorization, they can print or
export the results of these queries.
See also
Features Added in General Ledger 5.6
Features Added in General Ledger 5.5
Features Added in General Ledger 5.4

G/L Security Access
Sage ERP Accpac uses security groups to restrict user access to
General Ledger data and functions, such as journal posting.
In Administrative Services, you define security first on a user group basis,
then on an individual basis. At the group level, determine which General
Ledger tasks each group can perform, and then assign the authorizations
that allow members of the group to perform those tasks. You assign each
user to a security group that has the authorization they need.
You can assign the following General Ledger authorizations to users:
Common Inquiry — If a group has access only to Common Inquiry,
users who belong to that group will not be able to update G/L
accounts, Setup forms, Setup reports, or the Account Mapping form.
If a group has access to any General Ledger function, users who
belong to that group will automatically have access to Common
Inquiry, too.
Account Maintenance — allows you to update General Ledger
account information entered in the Accounts form and gives access to
the Account Mapping function. You can view and print from the Setup
functions.
Setup Maintenance — allows you to update G/L Options, Segment
Codes, Source Codes, Source Journal Profiles, Revaluation Codes,
Account Structures, and Optional Fields. If you do not have access to
the Setup tasks, you can view and print the information, but cannot
edit it.
Transaction Maintenance — gives you access to the Consolidate
Posted Transactions function. You can view and print Accounts and
Transaction History and print the G/L Transactions Listing and the
Posting Journal. You can view and print from the Setup functions, and
clear printed posting journals in Clear History.
Transaction Inquiry — allows you to view Transaction History and
print G/L Transactions Listings and Posting Journals. You can view
and print from the Setup functions.

History/Budget Maintenance — gives you complete access to
Account History Inquiry, Budget Maintenance, Source Currency
Inquiry, Fiscal Set Comparison, and Trial Balance. You can view and
print the Chart of Accounts and the Setup functions.
History/Budget Inquiry — allows you to view the Chart of Accounts,
Account History Inquiry, and Budget Maintenance; it gives access to
Source Currency Inquiry and Fiscal Set Comparison; it allows you to
print the Chart of Accounts and Trial Balance. You can view and print
from the Setup functions.
Journal Posting — gives you access to Post Batches and inquiries
associated with posted transactions. Journal Entry rights are not
automatically given when Journal Posting is assigned.
Note: You must set the batch status to Ready to Post before posting a
batch. A separate right, Set Batch Ready to Post, is required.
Journal Entry — gives complete access to Journal Entry, Recurring
Entries (setup), Create Allocation Batch, Create Revaluation Batch,
Create Recurring Entries Batch, Retrieve G/L Batch, Batch List (New
and Delete), Batch Listing, and Batch Status. You can view and print
from the Setup functions.
Journal Entry Inquiry — allows viewing of the Batch List, of entries
in the Journal Entry function, and in Recurring Entries and allows
printing of Batch Status and Batch Listings. You can view and print
from the Setup functions.
Transaction Optional Fields — lets you add or delete optional fields
for Journal Entry, recurring Entries, Create Allocation Batch, Create
Revaluation Batch, and Create Recurring Entries Batch.
Period End Maintenance — gives access to the Period End
Maintenance function. You can view and print from the Setup
functions.
Create New Year — gives access to the Create New Year function.
You can view and print from the Setup functions.
Import General Ledger Data — gives access to the Import command
on the File menu on General Ledger forms.

Export General Ledger Data — gives access to the Export
command on the File menu on General Ledger forms.
Financial Reporter — gives access to the Financial Reporter for
customizing and printing Sage ERP Accpac financial reports.
G/L Security Maintenance — allows users to assign accounts to
other users.
Transaction Optional Fields — lets you add or delete optional fields
for Journal Entry, Recurring Entries, Create Allocation Batch, Create
Revaluation Batch, and Create Recurring Entries Batch.
Set Batch Ready to Post — allows users to set batches ready to
post.
Balance Sheet Snapshot — allows users to view the Balance Sheet
snapshot in the Sage ERP Accpac portal.
Income Statement Snapshot — allows users to view the Income
Statement snapshot in the Sage ERP Accpac portal.
Accpac Inquiry — allows users to query General Ledger data using
Inquiry in the Sage ERP Accpac portal. If they also have Export
General Ledger Data authorization, they can print or export to a file
the results of these queries.
Dashboard — allows access to the Executive Dashboard from the
Accpac Dashboard page. The Accpac Dashboard page is on the
Accpac Dashboard Center, at http://AccpacDashboard/. If you access
to G/L Dashboard, you will be able to access dashboard pages (if
any) based on data stored in General Ledger.
See also
GL Account Security

Setting Up General Ledger
Take the following steps to set up General Ledger.
Step One: Install the General Ledger application program from the DVD.
Step Two: Activate the application for your database.
Step Three: Select the various configuration and processing options you require.
Step Four: Add accounts.
Step Five: Add historical data.

See also
Account groups
Designing Your General Ledger
Before Setting Up General Ledger
General Ledger Options form
Account revaluation codes
Account structures
Segment codes
Source codes
Source journal profiles
Optional fields

Entering Account Balances, Historical Data, and
Quantities
Entering multicurrency historical data
If you want to show source-currency balances for all past periods, you
must enter transactions in each of the originating currencies, along with
the exchange rate at the time, and the functional-currency equivalent
amount.

Modifying historical data
If you need to change account data in the previous year after you have
created your chart of accounts, you should enter the adjustments in a
batch, then post the batch to the previous year.

Entering Current Year-To-Date Transactions
When you set up a General Ledger system partway through a fiscal year,
you must enter the transaction data for the current year to date, in
addition to the closing balances from the previous year.
For ways to add the data,

.

click here

To add existing account balances and quantity data to a new general ledger, click here.

See also
Designing Your General Ledger
Current Fiscal Year after Activation
Setting Up General Ledger

Before Setting Up General Ledger
Before you set up your general ledger, you must:
Decide which ledger options you need (see Designing Your General Ledger).
Design your account number format. One of the first things you do in
the new ledger is set the size of your account numbers and how the
numbers are segmented.
Most General Ledger options are selected on the G/L Options form. However, a
few system-wide options are defined in the Common Services part of the
System Manager:
Common Services options let you select multicurrency accounting,
the number of fiscal periods in your business year, and the start and
end dates of accounting periods.
If you use Sage ERP Accpac Transaction Analysis and Optional Field
Creator, you must set up in Common Services all the optional fields
that you will use in General Ledger and in subledgers. You use the
Optional Fields form in Common Services to set up system-wide
fields.
For more information on Common Services, choose help when at the
company desktop, or refer to the System Manager Help.
The following table describes where ledger and account options are
selected.
Ledger
options
specified in
Common
Services

Account and
ledger options
specified in
G/L Options

Posting options
specified in G/L
Options

Account
segment
options
specified in
G/L Options

Number of
fiscal periods

Multicurrency
option

Lock budget sets

Default
structure code

Multicurrency
option

Default rate
type

Allow posting to
previous years

Account
segment

Functional
currency

Use account
groups

Allow provisional
posting

Segment
delimiter

Default rate
type

Maintain
Quantities

Force listing of
batches

Segment
description
table

Decimal places
in quantities
Default closing
(retained
earnings)
account
Reporting
rounding
account (euro
functional
currency only)
G/L Security
and the
resulting default
access to
accounts

Years of fiscal
sets

Segment
number

Years of
transaction detail

Segment
name

Edit imported
entries

Length

Default source
code

Use in closing
(Yes/No)

Each account number can contain up to 45 characters, including
segment delimiter (separator) characters.
Individual account numbers can contain from one to ten segments, and
you can vary the number and order of segments used in account
numbers in the same general ledger (by using different account
structures).
See also
Account groups
Account revaluation codes
Account structures
General Ledger data entry windows
Segment codes
Source codes
Source journal profiles
Using the G/L Options form

Revaluation Codes
This form lets you define revaluation codes that you can assign to
multicurrency accounts to specify how to revalue functional currency
balances when exchange rates change.
Once you define revaluation codes, you can assign them on an account
basis to each of the currencies that can be posted to an account (using
the G/L Accounts form). See Before using.
The Gain/Loss Accounting Method selected for your company (in the
Company Profile form in Common Services) determines how exchange
gains and losses are calculated. The choices are:
Realized and Unrealized Gain/Loss
Recognized Gain/Loss
If you choose the Recognized Gain/Loss Method, and then save the
Company Profile, you cannot revert to the Realized/Unrealized Gain/Loss
method. Also, you must specify Exchange Gain and Exchange Loss
accounts for each revaluation code. (The program does not use the
Unrealized Gain/Loss accounts specified under the Realized and
Unrealized Gain/Loss method as default Exchange Gain and Exchange
Loss accounts.)
To add revaluation codes
How revaluation works
Notes
Before deleting a revaluation code
After using

For help with the fields on the Revaluation Codes form, click the Field List
button at the top of this page.
Click here for hints on using forms

See also
G/L Options
Source Codes
Source journal profiles
Segment codes

.

Account structures
Account groups
Recurring entries
Optional fields
General Ledger icons

Segment Codes
This form lets you:
Enter a list of valid segment codes for each of the segments you use
in account numbers (other than the account segment).
Assign a separate retained earnings account for each segment code
in the table.
For example, if your account numbers include a department segment,
you would use the Segment Codes table to enter the codes and
descriptions of each of the departments in your company.
And, if you close income and expense accounts at year end by
department, you could specify a separate retained earnings account for
each department code you add.
For the steps on how to add segment codes, click here.

How General Ledger uses segment codes
When you add General Ledger account numbers in the G/L Accounts
form, the program checks the Segment Codes table to be sure that the
segment codes (such as the department numbers) are valid. If a segment
code is not valid, General Ledger will not let you add the account.
The only segment that is not validated is the account segment.
Click here for hints on using forms.

See also
G/L Options
Source Codes
Source journal profiles
Revaluation codes
Account structures
Account groups
Recurring entries
Optional fields
General Ledger icons

Account Structures
This form lets you:
Define account structures code that identifies the format of the
account numbers that are assigned to the account structure code.
Each account must be assigned an account structure when you add
the account. The structure specifies:
Which segments appear in the account number.
The order in which the segments appear.
Once you define account structures, you can begin adding your General
Ledger accounts (using the G/L Accounts form). See Before using.
You can use more than one account number structure within the same
General Ledger. For example, you can define one account structure that
uses only two segments in account numbers (such as the account
segment and a department segment), and another structure for account
numbers that have four segments (such as the account segment, and
segments identifying the department, sales region, and product type).
You normally use the same structure for all accounts in the same account
group. When you are adding an account, you assign the account
structure code that specifies the format of the account number.
General Ledger will not add an account if its account number does not
match the account structure format you've assigned it.
Maximum account structures allowed in each G/L edition
Depending on the edition of Sage ERP Accpac General Ledger you are
using, you can define:
A maximum of three account structures in the General Ledger 100
series.
Up to four structures in the General Ledger 200 series.
An unlimited number of account structures in the General Ledger 500
series.

To add account structure codes
1.Click the New button and type the account structure code. You can
use up to 6 characters for the code — numbers or letters.
You can also just type the code and press Tab: G/L will assume you
are adding a new code if it doesn't already exist.
2.Enter a description of up to 60 characters.
3.If you wish to use the structure code you are defining as the default
structure code, check the Use As Company Default Structure box.
(Once you have assigned the default structure you can change it on
the Segments tab of the G/L Options form only.)
4.In the Choose The Segments To Be Added To This Account box,
highlight the segments for inclusion in an account structure, in the
order you want them to appear in the account structure, then click the
Include button.
5.Click Add.

What account structures do
Account structures let you use different account segments in different
account numbers.
For example, if you define six account segments, you can create one
account structure that includes three of these segments, and another that
uses four. Once you create the account number structures, you can add
the accounts (specifying the structure that each account number uses).
Each structure can use any combination of the account segments you
have defined, arranged in any order, and containing up to 45
characters (including delimiters).
Individual account numbers cannot exceed 45 characters (including
delimiter characters), so if you defined 10 segments, it is unlikely that
any of your account numbers could contain all 10.
You can add new account structures at any time, but you can change
existing structure definitions only if you have not added accounts that
use the structure.

The order in which you select the segments determines their order
within the account structure.
When defining an account structure, move the segments in the exact
order you want them to appear.
You cannot change the structure attached to an account.

Deleting account structures
To delete an account structure, enter the structure code, then use the
Delete command.
You can delete an account structure only if no account uses it.

After Using
If you haven't already done so, use the Segment Codes form to add the
codes that are valid for each segment. (For example, you would list all
the department codes, division codes, etc.)
Click here for hints on using forms.

See also
G/L Options
Source Codes
Source journal profiles
Segment codes
Revaluation codes
Account groups
Recurring entries
Optional fields
General Ledger icons

G/L Recurring Entries
Use the G/L Recurring Entries form to set up journal entries for
transactions that recur on a periodic basis.
As part of the setup, you assign recurring entry codes for easy lookup,
specify the parameters that control when these transactions go into
effect, attach schedules for processing, and define the individual
transactions these entries are composed of.
Transaction fields that appear in the grid section of this form are identical
to those in the Journal Entry form.
This form:
Allows you to define recurring journal entries, as well as modify and
delete them.
Contains fields for specifying each type of recurring entry, assigning a
code to it, defining how it will be processed, and entering transaction
details.
Allows you to attach a defined schedule, or navigate to the Schedule
form to create a schedule that specifies when recurring entries must
be processed.
Displays current credit and debit totals for your entry, along with the
amount (if any), by which the entry is out of balance.
To set up recurring entries, click here.
See also
G/L Options
Source Codes
Source journal profiles
Segment codes
Revaluation codes
Account structures
Account groups
Optional fields
General Ledger icons

Source Codes
This form lets you add new source codes and descriptions, change
descriptions, and delete codes that are no longer needed.
For the steps to add new source codes, click here.

How General Ledger uses source codes
Source codes are used in General Ledger to identify the source (or type)
of transaction details. You can print source journals that include all
transactions with particular source codes.
You must define source codes before you can enter and post accounting
transactions.
All transactions entered in General Ledger must use a source code that
begins with "GL" to identify the transaction with the General Ledger
program.
General Ledger automatically adds new source codes found in subledger
transactions during posting.
Note that when you activate Project and Job Costing, the system creates
default source codes in General Ledger. When you save changes to the
codes in Project and Job Costing, the changes are also effected in
General Ledger.
Source codes in imported batches
Imported transactions must also contain source codes. You can define or
import the source codes you want to use in imported transactions in the
Source Codes form.
Using source codes for reporting
Source codes allow you to organize and print source journals of posted
transactions according to transaction type (for example, sales, checks, or
cash receipts).
Use source journals to group transactions for analysis and auditing
requirements. Batch listings and posting journals group transactions only
by time of entry.

Click here for hints on using forms.

See also
G/L Options
Source journal profiles
Segment codes
Revaluation codes
Account structures
Account groups
Recurring entries
Optional fields
General Ledger icons

Source Journal Profiles
This form lets you:
Add new source journals.
List the source codes used in each source journal, or modify or delete
existing journal definitions.
Source journals select and print posted transaction details according to
transaction source codes. See Before using.

To add new source journals
1.Click the New button and type the source journal name.
You can also just type the name and press Tab: G/L will assume you
are adding a new journal.
2.Add the source codes for the transactions that you want included in
the source journal.
Click here for hints on using forms.

For help with the fields in the Source Journal Profiles form, select from
the keywords listed below:
Profile
Source

Existing source journal definitions
The General Ledger comes with three source journal report definitions:
GLSJ01F.RPT — lists only the functional-currency value of
transactions. This is a single-currency or functional-currency-only
version of the source journal.
GLSJ01S.RPT — lists the source-currency and/or the functionalcurrency value of transactions. This is the full multicurrency version of
the source journal.
GLSJ1SA.RPT — use this report when you want to print sourcecurrency reports on A4 paper.
If these reports suit your needs, you don't have to define any others.
However, if you want to list transactions in a different order (such as by

date or posting sequence number) or you want to include different
information, you must modify these standard report definitions.

After using
Print the Source Journal Profile report, verify it, then file it as part of
your permanent records.
Once the journal profile is defined, print the source journal.
See also
G/L Options
Source Codes
Segment codes
Revaluation codes
Account structures
Account groups
Recurring entries
Optional fields
General Ledger icons

Using Optional Fields in General Ledger
Sage ERP Accpac Transaction Analysis and Optional Field Creator is a
product that you purchase and activate separately for use with General
Ledger and other Sage ERP Accpac programs.
You use General Ledger optional fields to:
.

Customize your G/L accounts

Add custom information to be stored with transaction details

.

Before you can use optional fields in General Ledger, you must define
optional fields for your Sage ERP Accpac system using the Optional
Fields form in Common Services. (For more information about setting up
optional fields in Common Services, see the System Manager help.)
You can then assign the optional fields to specific accounts, using the
Accounts form.
General Ledger includes the optional transaction fields assigned to an
account, and their default values, when you use the account in a
transaction detail. You can edit or delete optional fields in transactions
details in Journal Entry, whether the transactions are entered manually in
Journal Entry or generated automatically in General Ledger (using Create
Allocation Batch, Create Revaluation Batch, or Create Recurring Entries
Batch) or in another Sage ERP Accpac subledger.
Note: If you consolidate posted transactions for which details were
accumulated, any optional field information stored for the transactions is
deleted.

Setting Up Optional Fields for Use in General
Ledger
Once you have set up optional fields for your system, you use the G/L
Optional Fields form to define the optional fields you will use to customize your
chart of accounts and to store additional information with general ledger
transaction details. You can define an unlimited number of optional fields
for General Ledger, as long as you first set them up in Common Services
for use in your system.

Note that while the G/L Optional Fields form is open, users cannot run
other processes in General Ledger. Also, you can modify optional fields
records only when all other users have left General Ledger, and all other
General Ledger forms are closed.

Assigning Optional Fields to Accounts
When you have defined optional fields for use in General Ledger, you can
assign the optional fields to particular accounts.
You use the Optional Fields tab on the Accounts form to assign optional
account fields. You can include optional account fields on your printed
chart of accounts, and when you print the Chart of Accounts Detail Long Form report, you can choose whether to include the optional
account and transaction details fields (and their values) that are
defined for each account. You can also use optional account fields as
selection criteria when printing other types of reports.
You use the Transaction Details Optional Fields tab on the Accounts form to assign
optional transaction fields. If an account to which you have assigned
optional transaction fields is used in a transaction detail, you can edit
the optional field information for the detail.

Including Optional Fields in G/L Transactions

Journal Entry
If the account specified for a transaction detail uses optional transaction
fields, you can use optional transaction fields for the detail.
Journal Entry accepts optional field information from transactions you
create in Sage ERP Accpac subledgers provided they match the optional
transaction fields specified for the account. (The information is
transferred to General Ledger when you create a batch of general ledger
transactions in a subledger.)
The Optional Fields check box on the Journal Entry detail grid and on the
Journal Detail form shows whether the detail account uses optional
transaction fields. (Note that the program sets this optional fields
indicator. If no optional transaction fields are set up for the account, you
cannot add them to the detail.)
If optional fields are used in the detail,

you can add or delete optional fields

.

When you post the journal entry, the program saves the optional field
information. (Note that the Post To Account option for the account must
be set to Detail to save the optional field information.)

Create Allocation Batch
The Optional Fields check box on the Create Allocation Batch form
indicates whether your accounts use one or more optional transaction
fields, and whether they are set up for automatic insertion in transactions.
Note that you cannot change the entry in the check box, but if the field is
selected, you can edit the optional fields used with the transaction.
When you process the allocation, if the specified optional fields match the
optional transaction fields defined for the accounts involved in the
allocation, the optional field information will be included in the journal
entry for the accounts.

Create Revaluation Batch
The Optional Fields column on the Create Revaluation Batch form
indicates whether optional transaction details fields have been defined for
either the exchange gain account or the exchange loss account for a
selected revaluation code. If at least one optional transaction field is
defined, Yes appears in the field.
You cannot change the entry for this field, but, if the Optional Fields
indicator field shows Yes, you can add or delete optional fields for a revaluation batch.
Optional field information specified for the revaluation is included in the
journal entry details generated for an account only if the optional fields in
the revaluation match the optional transaction fields defined for the
exchange gain or exchange loss accounts.

Recurring Entries (Setup Form)
On the Recurring Entries form, the Optional Fields check box indicates
whether transaction optional fields are defined for the account used in a
recurring entry detail.
If the Optional Fields field is set to Yes on the detail entry grid, or is
selected on the detail entry form, you can use the Recurring Entry
Optional Fields form to view or change the optional fields for the detail.
If you have Transaction Optional Fields security access, you can add or
delete optional fields for the recurring entry. Note that you can add only
transaction optional fields that are defined for the account.

Create Recurring Entries Batch
Recurring entries use the optional transaction details fields and values
specified for the recurring entry code. You can edit the default fields and
values in Journal Entry, as for any other journal entry.

Create Accounts
The Create Accounts Preview form lets you

specify optional field information for the

accounts to be created.

The program assigns to the new accounts the optional accounts fields
and optional transaction details fields set for the "model" accounts using
the segment specified in the Default Options From field.

G/L Options Form
This form lets you:
Add or change the contact name, telephone number and fax number
for your general ledger. (Use the Address tab.)
Change account settings, such as turn on the multicurrency option,
the account groups option, and change the default closing account,
on the Account tab.
Note: You cannot enter a Default Closing Account number until after
you have set up the chart of accounts. If this account has the Post To
Account field set as prohibited, you cannot select that account as the
default closing account.
Turn on G/L Security and specify the default user access to General
Ledger accounts.
Specify a default source code for journal entries.
Lock budget sets, turn on or off prior year and provisional posting, set
number of years of history, and view posting statistics. (Use the
Posting tab.)
Add account segments, change segment names, and change the
default structure code. (Use the Segments tab.)
Options are set up when you create your general ledger. Once you have
set up your ledger, you use this form to change some of these settings.

To use the G/L Options form
1.Click the tab that you want to see.
2.Choose Save to keep any changes you make.
Choose Close to leave without changing General Ledger options.
Note: You cannot save options if any other General Ledger forms are
open (on any user's computer).
Click here for hints on using forms.

Click one of the links below for help on other tabs in this form:

Company

Account

Posting

Segments

Before Using
Before changing any of the settings or options, make sure you
understand the impact the options have on processing within General
Ledger.

Changing settings
Company name and address
To change the company name and address, or to change the contact
name, telephone number, and fax number at the company level, use
the Company form in Common Services.
To change the contact name, telephone number and fax number for
the General Ledger administration, use the Options form in G/L Setup.
Multicurrency and quantities settings
You can turn on the Multicurrency or Maintain Quantities options at
any time on the Options form in G/L Setup. But, once you turn them
on, you cannot turn them off.
You can increase the number of decimal places for quantities (up to 3)
at any time. However, you cannot decrease the number.
Account groups and retained earnings account
You can change your choice for the Use Account Groups option, or
change the default closing account at any time.
G/L Security
You can turn G/L Security on or off at any time.
Years of fiscal sets/transaction detail
You can change the number of years to keep these types of data at
any time. You cannot keep transaction details for more years than are
specified to keep fiscal sets.
The number of years of fiscal sets and transaction detail you can keep
depends on your edition of General Ledger.

Account number segments
You can add new segments and change segment descriptions at any
time.
The maximum number of segments you can have also depends on
your edition of General Ledger (3, 4, or 10 segments).
You can delete or change the length of an account number segment
at any time, as long as no account structure uses it.
See also
Source Codes
Source journal profiles
Segment codes
Revaluation codes
Account structures
Account groups
Recurring entries
Optional fields
General Ledger icons

Account Groups
Sage ERP Accpac uses account groups to classify account balances:
On the financial statements that come with Financial Reporter.
These sample statements, which are designed for the Sage ERP
Accpac sample data, retrieve data using standard account groups.
If you want to use these statements with your own data, you must
assign the same standard account groups to your own accounts, or
your reports will not be correct. (However, if you decide to use a
different set of account groups, you can customize the sample reports
to match your own account groups.)
In the Income Statement and Balance Sheet snapshots that you view
in the Sage ERP Accpac portal.
These snapshots retrieve data from a standard set of group
categories that are linked to general ledger accounts through account
groups.
If you plan to use the Income Statement and Balance Sheet snapshots,
note that before you configure the snapshots, you must:
Assign all account groups to appropriate categories from the standard
set of group categories that comes with General Ledger. You can
assign any number of account groups to the same category.
Assign all general ledger accounts to appropriate account groups.
Otherwise, the snapshots may display incorrect information, or no
information.

To use account groups
1.Select the option to use account groups on the Account tab of the G/L
Options form.
2.Ensure that group categories are assigned to all account groups, if
you plan to use the Income Statement or Balance Sheet snapshots.
(You assign group categories in the Account Groups form. For more
information about group categories, see Group Category.)

3.Assign each General Ledger account to an account group. (You use
the G/L Accounts form to assign accounts individually to account
groups.)
You can use the Other account group for accounts that you want to
exclude from your balance sheet and income statement.
You can use the Unclassified account group if you don't want to
specify an account group whenever you create an account. (The
default sort code for the Unclassified Account Group is
ZZZZZZZZZZZZ, but the group code is blank.)
If you don't use account groups, the program assigns accounts to the
Unclassified account group, internally.

Customizing account groups
You can change the descriptions for the account groups to suit your
business needs.
You can reassign account groups to different group categories
(although we recommend that you consider such reassignment very
carefully).
Note: You cannot change the standard set of account categories that
comes with the program.
You can delete any account groups that you don’t need.
If you don’t plan to use the General Ledger snapshots or the standard
reports that come with Financial Reporter, you can add any new account groups
that you need.
See also
Changing Sort Codes
G/L Options
Source Codes
Source journal profiles
Segment codes
Revaluation codes
Account structures
Recurring entries
Optional fields
General Ledger icons

G/L Optional Fields
You use the G/L Optional Fields form to define optional fields for use in
General Ledger.
The Optional Fields form lets you define two types of optional fields:
Account. These optional fields let you extend the type and amount of
information that you can store with accounts. For several General
Ledger reports, you can choose optional fields as criteria for selecting
the accounts to include on the report.
Transaction Details. These optional fields let you store additional
information with transaction details.
Once you define optional account fields and optional transaction fields for
General Ledger, you can assign them to specific accounts using the
Accounts form.
You can print the Optional Fields Report to obtain a list of the optional fields you
have defined for General Ledger.

Deleting Optional Fields
You can delete General Ledger optional fields only if they are not used by
any accounts or in any unposted transactions.
General Ledger warns you when you try to delete an optional field that is
assigned to an account or an unposted transaction. You must remove the
optional fields from the accounts and transactions where they are used
before you can delete them using the G/L Optional Fields form.
See also
Using Optional Fields in General Ledger
G/L Options
Source Codes
Source journal profiles
Segment codes
Revaluation codes
Account structures
Account groups
Recurring entries
General Ledger icons

Data Entry Tools and Shortcuts
General Ledger data entry windows contain many aids to data entry
which you can activate by selecting from a menu command, pressing a
function key, using a mouse, or clicking an icon.
For more information, see the following topics:
Browse button
Changing column order in forms
Working with entry grids
Drop-down lists
Using Help

For more information on data entry buttons that appear on forms, click
the button or command listed below:
New

or
Find

or
Zoom

or
Shift+
Zoom

Drilldown

or
Go

Navigation Buttons

Changing Column Order in Forms
You can permanently or temporarily change the order in which columns
appear on many Sage ERP Accpac forms.
For example, you can change the order to Journal Entry detail columns to
match the field order of a manual form from which you are entering data.
To move a column

Point at the column heading.
Hold down the left mouse button.
Move the column to its new location.
Release the button.
The columns will be in the new order the next time you open the form.
To reset column order
1.On the Sage ERP Accpac desktop, highlight the icon for which you
want to reset column order.
2.Choose Object, Restore Defaults from the desktop menu.
3.Make sure that you choose All Other Settings, and click OK.
The next time you use the function, the columns will be arranged in the
original order.

Changing Column Widths in Data Entry Forms
Double clicking on the division between columns resizes the column on
the left to its minimum size based on the data it contains.

To change the width of columns
Position the pointer on the vertical line separating a column heading
from the next heading to the right.
Drag the column to the right (to make the column wider) or to the left
(to make it narrower).
When you reach the width you want, release the mouse button.
To restore your original settings
From the Sage ERP Accpac desktop menu bar, select the icon for the
form you changed, then click Object, Restore Defaults, then All Other
Settings.
See also
Changing column order in data entry forms
Data entry tools and shortcuts
Using Help

General Ledger Forms
The following list includes each General Ledger icon that you can select
from the Sage ERP Accpac company desktop. Select one of the
keywords below for information on the purpose and operation of the data
entry forms these icons lead to.
G/L Accounts
G/L Transactions
G/L Periodic Processing
G/L Reports
G/L Setup
Financial Reporter

See also
General Ledger menu bar
General Ledger reports

File Menu
The File menu appears on all General Ledger forms. Use its commands
as follows:
Print

begins printing the current report.

enters a printer name and selects orientation, paper source,
and so on.
Print Setup

Customize

allows you to remove fields from the entry form for selected

users.
Import

enters information about the data to be imported, and imports it.

Export

enters information about the data to be exported, and exports it.

Close

closes the current form.

Help Menu
The commands on the Help menu provide different kinds of information
about the Sage ERP Accpac General Ledger program.
Contents Displays the table of contents for the General Ledger online
help system, from which you can select help on various aspects of
General Ledger.
Using help Provides information on how to use help.
About . . . Lists the version number of the Sage ERP Accpac General
Ledger that is installed on your system.

Displaying and Editing Account Information
G/L Accounts
The G/L Accounts folder contains icons that lead to forms for
displaying and editing account information.
These forms let you create account records, display account balances,
maintain budget information, view source-currency information, display
transaction history and fiscal set comparisons, and set account
permissions.
Chart of Accounts
Accounts
Account History Inquiry
Budget Maintenance
Source Currency Inquiry
Transaction History
Fiscal Set Comparison
Create Accounts

(This icon appears in the G/L Accounts folder only after
you select the option, "Use G/L Security" on the Account tab of G/L
Options, then close and reopen your company database.)
Account Permissions

See also
Adding a new account
Changing account information
Deleting an account
Displaying batch information
Editing account information

Create Accounts
You can automatically generate new General Ledger accounts that have
the same characteristics as a set of base accounts. For example, if you
need to create a set of accounts for a new department, you can create a
set of new accounts using the accounts for an existing department as the
model.
You use the Create Accounts icon from the G/L Accounts folder to create
accounts automatically. You can generate new accounts by:
A range of accounts
A range of account groups
A specific segment code
To automatically generate new accounts

See also
G/L Accounts
Chart of Accounts
Create Accounts Preview Report

Changing Account Information
Use the G/L Accounts form to change:
Account description.

.

Account type

.

Normal account balance
Account status

.
.

Segment/account used in closing
Method of posting
Account groups

(detail, consolidated or prohibited).

.
.

Control account option

.

Allocation Information

.

Currency Information

Optional account fields.
Optional transaction fields.
Rollup accounts.

Once you turn on the multicurrency option or quantity option for an
account, you cannot turn them off.
Before you change account information
Notes regarding changes

See also
Adding a new account
Deleting an account
Displaying account information

Deleting an Account
General Ledger will not let you delete accounts unless:
The current-year opening and current balance for the Actual fiscal set
of the account are both zero.
No transactions have been posted to the Actual fiscal set of the
account in the current year.
The account is not assigned as the Default Closing Account in the G/L
Options form.
These restrictions preserve the integrity of your data, and preserve the
audit trail.
You can delete an account with quantities in the Quantity fiscal set and
with amounts in any of the budget fiscal sets.
Before you try to delete an account, be sure that

See also
Adding a new account
Changing account information
Displaying account information

Setting Account Permissions
To set account permissions
1.Turn on G/L Security by selecting Use G/L Security on the Account
tab of the G/L Options form. You must also choose the default user
access (whether, by default, users have access to all accounts or to
no accounts).
2.Open the Account Permissions form in the G/L Accounts folder.
3.Select the User ID for which you want to set permissions:
If you have already added the User IDs to G/L Security, you can
browse through the list of User IDs using the Previous and Next
buttons or you can click the Finder button and choose a User ID.
If you have not added the User ID for which you want to set
permissions, click the Zoom button as shown below to display all
Sage ERP Accpac User IDs, and then select the User ID from the
Finder that appears.
4.Use the Segment tab to specify ranges of department or division
segment codes to allow or restrict access to department or division
accounts:
a.

Click in the first row of the Allow column, then use the Spacebar or
double-click to switch between No and Yes. If you are adding a
line, press the insert key.

b.

Tab to or click in the Segment column, and then click the
dropdown list that appears. For example, you could select the
Division account segment to restrict account access based on the
company's divisions.

c.

Tab to the From column and click the Finder button that appears
(or click the Finder in the column heading). Select the first
segment code in the range that you want to allow or restrict.

d.

Tab to the To column and select the last code in the segment
range.

e.

Press the insert key to specify a second segment range on a new

line.
f.

Click the Save button if you are finished setting account
permissions for this user.
Note: You cannot choose a range of account numbers on this tab.
You must use the Account tab to specify an account range.

5.Choose the Account tab to allow or restrict access to ranges of
account numbers.
a.

Click in the first row of the Allow column, then use the Spacebar or
double-click to switch between No and Yes.

b.

Tab to the From column and click the Finder in the column
heading. Select the first account code in the range that you want to
allow or restrict.

c.

Tab to the To column and select the last account in the range.

d.

Click the insert key to specify a range of account numbers on a
new line.

6.Click the Save button if you are finished setting account permissions
for this user. (If you click the Close button without saving, a message
prompts you to save the record.)

To quickly test user account permissions
Click the Test button to test the account segments you have specified.
The Finder-Accounts form lists the accounts this user has access
permissions to see and work with.

To copy account permissions
If you need to set up identical permissions To set up identical permissions
for several, you can create permissions for one user and copy them to
other user IDs by using the File menu's Import and Export commands to
import and export user permissions.
See also
G/L Accounts
Chart of Accounts

Chart of Accounts
This form:
Lists all the accounts in the general ledger, in account number order,
beginning with the account you specify. See Account Information for a list of
the data displayed in this form.
Lets you select an account and display more detailed information.
Lets you print the chart of accounts.
Lets you list rolled up balances instead of viewing individual accounts.

To list accounts
1.Select a starting account number.
2.Choose the year.
3.Choose the period.
4.Click the Go button.
Select the Use Rolled Up Balances option before clicking the Go button if you
prefer to see only rolled up balances.

To view or edit information for a particular
account
1.Select an account from the account list.
2.Click the following buttons:
, to view details for that account on the G/L Accounts form.

Open

Transactions

, to view transaction history for that account.

, to compare fiscal sets for that account.

Comparison

, to view information for that account on the G/L Budget
Maintenance form.
Budget

History

, to view the account history for that account.

, to view all the source currencies that have been posted to
that account in the selected period.
Currency

To add an account
1.Click the Open button. This button displays the G/L Accounts form.
2.Click

(new) when the form appears.

3.Enter the number of the new account, and all other account
information. SeeAdd a new account.
Click here for hints on using forms.

See also
Changing account information
Deleting an account
Displaying account information
Editing account information

G/L Accounts
This form lets you:
Add new accounts to the general ledger.
Change information for existing accounts.
Delete accounts which you no longer need.
Print the chart of accounts.
Notes: You must purchase and install Sage ERP Accpac Multicurrency to
see multicurrency options. You must purchase and activate Sage ERP
Accpac Transaction Analysis and Optional Field Creator to use optional
fields.
The Currency tab appears when you choose the Multicurrency option
on the Detail tab. (Note that the Currency option appears only for
multicurrency databases. After you select Multicurrency for an
account and choose Save, you cannot change the selection.)
The Optional Fields tabs appear if you use the Sage ERP Accpac
optional fields product.
The Allocation tab appears when you select the Auto Allocation option
on the Detail tab for this account.
The Rollup tab appears when you select the Rollup option on the
Detail tab for this account.
The Subledger tab appears when you select the Control Account
option on the Detail tab for this account.
Click the links below for information on individual tabs:
Detail

Optional
Fields

Trans
Optional
Fields

Allocation

Currency

Subledger

Rollup

Click here for steps to add an account

Entering an account number
You must also assign an account structure code to each new account. The
account structure code verifies the account number when you enter it,

and determines how the number is displayed in windows and printed on
reports.
You set up segment validation rules using Segment Codes in the G/L Setup
folder.
Note: To maintain quantity and currency information for an account, you
must select the options for the company in the G/L Options form.
Click here for hints on using forms.

See also
Account Groups
Adding a new account
Changing account information
Deleting an account
Displaying account information
Editing account information

G/L Account History Inquiry
This form lets you display:
Actual and quantity information for prior years, including the opening
and closing account balances and the net changes and balances for
each fiscal period.
Total quantity and total net change information for the fiscal year.
G/L transaction details for a period (by double-clicking on the period
for which you want more information)
If the account you select is a rollup account, you can view each
account separately or roll up the balances. Amounts will appear in the
Net Change and Balance columns when you select the Use Rolled Up
Amounts option.

To view historical data
1.Enter an account number or select one with the Finder.
2.Select the year for which you want to view balances. (Click the down
arrow.)
3.If you are running a multicurrency database, select a Currency and
the Currency Type.
Choose either Source or Functional in the Currency Type
dropdown list.
If the euro is your functional currency, you can choose an
additional Currency Type option, Reporting. This option only
appears if you specified a reporting currency on the Company Profile form
in Common Services.
If you have a single currency system and your functional currency
is the euro, the Currency Type options you can choose from are
Functional and Reporting.
4.If the option, Show Quantity is available, select it to view quantity data
that's been posted to the account.
Results are automatically displayed when you change any input field.

5.Double-click a transaction detail line to drilldown to the G/L
Transaction History form.
6.If the account you select is a rollup account, select the Use Rolled Up
Amounts option to see the rollup account as well as the rollup
member transactions.
You can also see the rolled up quantity balances by selecting the
Show Quantity option. Note that a rollup account can have the
selection for Show Quantity even though Maintain Quantities is not
used for this rollup account. When the Use Rolled Up Amounts option
is selected, it will check if any of the rollup members do maintain
quantities. If they do, when Use Rolled Up Amounts is selected, Show
Quantity will also be enabled. The quantities balances will then be
rolled up as well.
Click here for hints on using forms

.

See also
Adding a new account
Changing account information
Deleting an account
Displaying account information
Entering ledger account balances

Budget Maintenance
This form lets you:
Enter and display budget data for each G/L account.
If your General Ledger has multicurrency accounts, you can also
enter budget amounts for each of the currencies you use.
The Budget Maintenance form shows two sets of figures for each fiscal
period:
The Budget Amount column contains the budget amounts for the
account you wish to view or edit.
The Inquiry column displays data from any G/L account you choose.
You select the inquiry account by selecting items in the Fiscal Set Lookup
area of the form.

To edit budget data
You cannot edit a fiscal set that has been locked.
1.Choose the account you want to edit or view.
2.Choose the budget set. (If you are using Sage ERP Accpac 500,
General Ledger provides five budget fiscal sets which you can use in
any way you like. )
3.Choose the fiscal year.
4.If you are editing budget data for a multicurrency account, choose the
currency and currency type you want to edit.
For example, if your functional currency is US dollars, you might
choose to edit figures that are in Canadian dollars, but select the
equivalent currency type to enter amounts in US dollars. The Budget
Amount column label displays as Budget Amount (US); the Inquiry
Amount column label displays as Inquiry Amount (CAD).
5.Click the Go button.
6.Click on the Budget Amount field to enter data for a fiscal period, or
use one of the Budget Methods (listed below) to enter budget data for
the currently selected account.

Use the Clear button to zero out any previous data. Use the Delete
button to remove the budget record completely. (This will free up disk
space.)
7.Select data in the Fiscal Set Lookup area, then click the Go button to
see current or previous-year actual figures or budget figures from any
account. The figures in the Inquiry Amount can help you prepare the
budget you are working with.
You can inquire about the account's actual or budget figures in the
Fiscal Set Lookup. You can select the option "Use Rolled Up Amounts",
then click the Go button to see rolled up budget figures. Budgets for
the member accounts can be rolled up to the rollup accounts for
inquiry purposes.
If you have security access to the Rollup accounts, you automatically
get access to member accounts.
8.Click Save once you are satisfied with the budget information you
have entered.

Budget methods
The eight Budget Method options provide you with a variety of ways to
tell the system to calculate budget period amounts based on information
you specify.
Fixed amount
Spread amount
Base, percent increase
Base, amount increase
Copy, as is
Copy, percent increase
Copy, amount increase
Copy, prorated spread

You can use the Add To or Replace buttons to move figures into the
Budget Amount column:
Add To: adds the amounts you are copying or calculating to amounts
already in the column.
Replace: replaces the amounts in the Budget Amount column with
amounts you are copying or calculating.
Note: In a multicurrency system, you must enter the source and
functional equivalents of other currencies separately -- if you want both

sets of numbers.
To calculate the functional equivalent from a source amount, inquire on
the source amount, then use the percent increase budget method. If the
rate is less than one, use a minus percent increase (calculated by
subtracting the rate from 1).

Budget totals
The Total fields at the bottom of the column display the total of budget
amounts for all periods. A total is also given for the Inquiry Amount fields.

Saving the result
You can continue to manipulate the amounts in the Budget Amount fields
using various budget methods or by manually changing the amounts.
When you are satisfied with the result, click the Add button.
See also
Adding a new account
Clearing budget amounts
Deleting budget fiscal sets
Displaying account information
Future year budgets
Importing budgets from a spreadsheet
Locking budget sets

Source Currency Inquiry
This form lets you:
Display all source-currency account balances for a multicurrency
account, as well as the equivalent amounts in the functional currency.
Display all reporting-currency account balances for a multicurrency
account. If euro is your functional currency and you specified a reporting
currency, this form displays a column with amounts shown in the
reporting currency.
Display source-currency account balances for rollup accounts.
Amounts will appear in the Source Balance and Equivalent Balance
columns when you select the Use Rolled Up Amounts option.
Drills down to Transaction History to show individual transactions.

To display source-currency account balances
for an account
1.Enter an Account number or use the Finder to select one.
2.Click the Period icon to select the Period Ending for which you want to
view balances.
Results are automatically displayed when you change any input field.
If the account you select is a Rollup Account, the Use Rolled Up
Balances option appears. Select it to see balances for this account. If you
drill down to Transaction History, it will show the rollup account as well as
the rollup members' transactions.
General Ledger lists all the source currencies that have been posted to
the displayed account in the selected period. If you have posted to the
account only in the functional currency, no balances will be displayed.
Click here for hints on using forms.

See also
Currency information tab (G/L Accounts form)
Displaying account information

G/L Transaction History
This form:
Opens the Journal Entry Inquiry form.
Displays all transactions posted to an account in a particular year and
fiscal period (unless they've been consolidated).
If you wish, you can restrict the list to transactions with a particular
source code or source currency (if you have a multicurrency ledger).
Transaction information includes:
fiscal period
date
source code
reference and description
functional currency for posted amounts and source currency (if you
have a multicurrency ledger)
amount (this option is available only if the euro is your
functional currency and you specified a reporting currency)
reporting currency

quantity
exchange rate, rate type and rate date (if you have a multicurrency
ledger)
batch number, entry number and transaction number
optional fields
If you do not specify a source code or currency, the program lists
the displayed transactions first by year and period, then in order by
currency, source ledger, source type, posting sequence, and detail
record number.
Displays rollup amounts. If Use Rolled Up Amounts is selected and
the Go button clicked, all transactions posted to an account in a
particular year and fiscal period as well as the rollup member
transactions will be displayed. A new field, labeled "Members"

appears in the grid to display the rollup member/rollup account the
transaction was posted to.
If this is an Intercompany Transactions company:
The report will be called ICT G/L Transaction History Inquiry, and will
have an extra field, labelled "Company." In all other respects, the report
does not change.

To display transactions
1.If this is an Intercompany Transactions company, select the company
code in the Company field. (If this is not an ICT company, begin with
step 2.)
2.Enter an Account number or select one with the Finder.
3.Select the Period Ending for which you want to view transactions.
4.To view only one type of transaction, use the Finder to select a
Source Code.
5.Use the Finder in the Currency field to select the currency of the
transactions you will view.
Results display automatically in the detail grid whenever you change
the input fields.
6.If you want to view transactions of rollup members, select the Use
Rolled Up Amounts option, then click the Go button.
7.Double-click a transaction detail to drilldown to the journal entry that
created it.
Click here for hints on using forms.

See also
Account history
Displaying account information

Fiscal Set Comparison
This form lets you:
Display account information for two fiscal sets, to compare the net
changes or period balances.
You can compare actual, quantity, provisionally-posted and budget fiscal
sets, in any combination you choose.
For multicurrency accounts, you can specify amounts posted in a
particular currency, displaying the source-currency amounts, the
functional equivalent of the source, or the reporting currency (this option is only
available if the euro is your functional currency and you specified a
reporting currency on the Company Profile form in Common Services).
The program also displays the monetary difference between the two sets,
and the difference as a percentage of the second set.
If the account you select is a rollup account, the Use Rolled Up Amounts
option appears. You can select it to view the balances, net changes, and
quantities of the member accounts rolled into a single account.

To compare two fiscal sets
1.Open General Ledger > G/L Accounts > Fiscal Set Comparison.
2.Enter an account number or use the Finder to select one.
3.If you choose an account that is a rollup account, the Use Rolled Up
Amounts option appears. Select it if you want to view the rolled up
amounts for this account. (When you create rolled up budgets, create
them in a separate budget.)
4.Select either Net Change or Balance for each period.
5.Select the first fiscal set and the year.
6.Select the second fiscal set and the year.
7.If you have a multicurrency ledger, select the currency type (Source or
Functional).
8.If you have a multicurrency ledger, select the currency.

9.Click the Go button to display the accounts you have specified.
Note that if you clear the Use Rolled Up Amounts option after earlier
selecting it, or if you click the option after clicking the Go button when
it hadn't been selected, you will need to click the Go button again for
the changes to appear.
Click here for hints on using forms

See also
Displaying account information

.

G/L Account Permissions
This form:
Lets you define account access permissions for individual Sage ERP
Accpac users.
Depending on the Default Access setting, you will need to use the
Account Permissions form mainly to grant access to accounts, or to
restrict it.
Note:
G/L Account Permissions is part of G/L Security, an option in the General
Ledger program. The Account Permissions icon does not appear in the
G/L Accounts folder unless you select the "Use G/L Security" option on
the Account tab of the G/L Options form, and then close and reopen the
company database. (After you reopen your company database, the icon
appears in the G/L Accounts folder. The icon does not appear until you
take this step.)

To set account permissions
1.Select the G/L Security option on the Account tab of the G/L Options
form.
2.Close and then reopen your company database.
3.Open the Account Permissions form.
4.Select the User ID for which you want to set permissions:
If you have already added the User IDs to G/L Security, you can
browse through the list of User IDs using the Previous and Next
buttons or you can click the Finder button.
If you have not added the User ID for which you want to set
permissions, click the Zoom button to display all Sage ERP
Accpac User IDs.
5.Use the Segment tab to specify ranges of department or division
segment codes to allow or restrict access to department or division
accounts:

a.

Click in the first row of the Allow column, then use the Spacebar or
double-click to switch between No and Yes. If you are adding a
line, press the insert key.

b.

Tab to or click in the Segment column, and then click the
dropdown list that appears. For example, you could select the
Division account segment to restrict account access based on the
company's divisions.

c.

Tab to the From column and click the Finder button that appears
(or click the Finder in the column heading). Select the first
segment code in the range that you want to allow or restrict.

d.

Tab to the To column and select the last code in the segment
range.

e.

Press the insert key to specify a second segment range on a new
line.

f.

Click the Save button if you are finished setting account
permissions for this user.
Note: You cannot choose a range of account numbers on this tab.
You must use the Account tab to specify an account range.

6.Choose the Account tab to allow or restrict access to ranges of
account numbers.
a.

Click in the first row of the Allow column, then use the Spacebar or
double-click to switch between No and Yes.

b.

Tab to the From column and click the Finder in the column
heading. Select the first account code in the range that you want to
allow or restrict.

c.

Tab to the To column and select the last account in the range.

d.

Click the insert key to specify a range of account numbers on a
new line.

7.Click the Save button if you are finished setting account permissions
for this user. (If you click the Close button without saving, a message
prompts you to save the record.)

To quickly test user account permissions
Click the Test button to test the account segments you have specified.
The Finder-Accounts form lists the accounts this user has access
permissions to see and work with.

To copy account permissions
To set up identical permissions for several users, you can create
permissions for the first user, then copy them to other user IDs using the
File menu's Import and Export commands.
See also
Chart of Accounts
G/L Accounts
G/L Security Program

Adding a New Batch
There are two ways to start a new batch in General Ledger.
On the Journal Entry form
a.

Choose the Journal Entry icon to open the form.

b.

Click the New button ( ) beside the Batch field, then enter a
description for the batch.
From the Batch List form

a.

Click the New button.

b.

When the Journal Entry form appears, enter a batch description.
(You don't click the New button in Journal Entry — a new batch
has already been created.)

You must use the batch number assigned by the system.

Deleting a Batch
To delete a batch
1.Choose Batch List from the General Ledger form.
2.Enter the number of the batch to be deleted or choose the batch from
the Finder.
3.Use the Delete button.
All transactions in the batch will be deleted. If you view the Batch Status
report, the batch will be listed as deleted, and you cannot reuse the batch
number (until you reset batch numbers with Period End Maintenance).

Displaying Batch Information
General Ledger has several windows that display batch and journal entry
information:

G/L Batch List form
This form lists all the batches in the general ledger, in order by batch
number, together with information about each batch, such as:
Batch number
Batch description
Source ledger
Type and status
Whether printed
Dates created and last edited
Whether Ready to Post
Batch total
Number of entries and errors

Reports

Batch Status Report
This report shows all activity that has taken place in currently unposted
batches, and in batches that have been posted or deleted since the last
time the report data was cleared.
For more information about the contents of this report, see report features.

Batch Listing Report
This report lists the contents of unposted batches and identifies errors.
Use it to check transaction batches after retrieving or importing batches
and before posting any batches.
For more information about the contents of this report, see report features.

Posting Journal
To view transactions that have just been posted, print the Posting Journal.
You can view previously posted transactions by printing the G/L
Transaction Listing, printing source journals, or by using the Transaction
History form.
See also
Adding a new batch
Journal entry
Deleting a batch
Displaying account information

Editing a Batch
Notes
You cannot edit batches that have been deleted or posted, or that are
set Ready to Post (on the Batch List form).
You can edit batches that have been provisionally posted.
You can edit imported batches only to the degree you specify for the
Edit Imported Entries option on the Posting tab of the G/L Options
form.
You can allow editing of all fields, the fiscal period only, or prevent any
editing.
To edit the contents of an existing batch

Before Posting
Print and verify batch listings for the batches you want to post. If
necessary, make corrections. (This step is required if you chose the
Force Listing Of Batches option on the Posting tab of the G/L Options
form.)
Make sure that:
The fiscal periods to which you want to post are unlocked for
General Ledger in Common Services' Fiscal Calendar.
The accounts to post to exist in General Ledger and have Active
status.
Entries balance.
You have printed listings for the batches if you use the Force
Listing of Batches option.
You have set each batch that you want to post Ready to Post on
the Batch List form.
If you are going to post provisionally, make sure you have chosen the
Allow Provisional Posting option on the Posting tab of the G/L Options
form.
If you previously posted provisional data, make sure you are ready to
delete it — provisionally posted batches are automatically cleared the
next time you post.
Back up your General Ledger data.

Import Command in File Menu
Use the Import command to transfer data such as account master
information and transaction batches from non-Sage ERP Accpac
programs to Sage ERP Accpac General Ledger. Transferring this
information to Sage ERP Accpac is called importing.
One common use of the import and export functions is to export account
balances (or net amounts) to a spreadsheet for analysis and
manipulation, then import this information as next year's budget
information.
If you are using a script, the fields selected when you created the script
are displayed in the Import dialog box. (If you often import the same data,
you can create a script to speed up the process.)
If you want to view all the fields available for import, click the File menu
and choose Display Import Fields. You can then print the displayed list.
To import account information or transactions, follow these general steps:
1.Open the dialog box for the data you want to import.
2.Choose Import from the File menu. Select the type of imported data if
a drop-down list appears.
Note that, in the Import form, the information columns are dimmed
until you select a file or database to import.
Depending on the Type you select, the label of the field beneath the
Type field will change as shown in the following table:
Type

Field
Label

Excel 2000

File

Excel 2007
Binary
Workbook

File

Single CSV
File

File

CSV File

Path

Access

Database

Access
2007

Database

Excel 5.0

File

dBase 5.0

Path

ODBC

Connection

XML

File

Import checks that the key values for details in CSV flat files match
the header keys.
The Import dialog box has the following columns:
Record - displays the record (or records) that are available for
importing.
Table - displays filenames.
Status - displays "Not Ready" until you choose the file you will
import, then this changes to "Import Ready."
Field - displays field names.
Contents - displays field names from the title record. These are
set at "Default Value" until you select the file to import, and can be
changed back to "Default" or "Default Value."
DataType - displays the type of data (for example, String, Integer,
Boolean, Date/Time, or Float).
3.Select an option in the Action field drop-down list:
To import new records, select Insert.
To overwrite existing records, select Update.
To import new records and update existing records, select Insert
and Update.
4.Click the Browse button to specify an Access database or Excel file;
for a CSV import, specify a path or database.

The Import dialog box reappears; the columns are no longer dimmed,
therefore they can be edited, for example, you can right-click on cells
in the Contents column to change values.
5.Click OK to import the file.
A message appears, displaying the number of updates and insertions,
and the number of items processed.

Export Command on File Menu
General Ledger lets you export data such as account master information
and transaction batches to files that can be read and used by other
programs. Transferring this information to non-Sage ERP Accpac
databases is called exporting.
One common use of the export function is to export account balances (or
net amounts) to a spreadsheet for analysis and manipulation. Then to
import this information as next year's budget information.
To export General Ledger information, follow these general steps:
1.Open the form or dialog box for the data you want to export.
2.Choose Export from the File menu.
3.In the Export dialog box that appears, choose a Type from the
following drop-down list:
Excel 2000
Excel 2007 Binary Workbook
Single CSV File
CSV File
Access
Access 2007
Excel 5.0
dBase 5.0
ODBC
XML
4.Click Browse to choose a file to export to.
If you are exporting to Excel, you must create an Excel file before
exporting from Sage ERP Accpac.
If you are exporting to Access, create a database file before
exporting from Sage ERP Accpac.

If you choose CSV, you must first set up a path to the directory
where you will be exporting the Sage ERP Accpac data.
To export in XML format you will first need to determine a location
to export the file to.
Before you export to an ODBC database, you will need to create
an empty database to use for the export. (Be sure to create it in
the database type you use.)
5.Click the plus sign beside each item if there are fields that you do not
want exported.
Note that the items with a star beside the checkmark are key fields
that must be exported.
6.Click OK to begin the export.
To change the criteria for exported data, click the Set Criteria button
before clicking OK.
When the export is finished, you will receive a message that displays the
number of records exported.

Posting
The process of transferring information from a batch of transactions to
the general ledger accounts is called posting. General Ledger lets you
post transactions directly to accounts, or provisionally post them to test
their effect.
You use the Post Batches form to post all or a range of unposted
batches. You can also post individual batches by selecting the batch you
want on the G/L Batch List form, then choosing Post or Prov Post.
Note: If you use Intercompany Transactions and you are posting an
intercompany batch, the Intercompany Transactions program posts the
batch, as ICT posting is a separate process from G/L posting.

G/L Batch List
This form:
Displays a list of posted and unposted General Ledger and
intercompany batches beginning with the batch number you specify.
You can choose to display or suppress posted and deleted batches,
and you can choose to display batches from a single subledger.
Displayed information includes:
Batch number
Batch description
Source ledger
Type
Status

Whether it's been printed
Dates created and last edited
Whether it's ready to post
Posting sequence if posted
Batch totals
Number of entries and errors
For an ICT company (Sage ERP Accpac Intercompany
Transactions), if one of the companies specified on the ICT
Options form maintains quantities in its General Ledger, a Quantity
Total column appears.
Lets you create a new batch or select a batch for editing, deleting,
printing, posting, or provisional posting. (Provisional posting is not
available for an ICT company.)
Lets you print batch listings, batch status reports, posting journals (by
double-clicking the Posting Sequence column), and posting error
reports (by double-clicking the Number of Errors column).

To list batches
1.Optionally select a starting batch number.
2.Optionally specify the source ledger for the batches you want to list.
3.Choose whether to display posted and deleted batches.
You can use the Refresh button to update the list if other users have
been changing batches.

To view, create, delete, print, or post a batch
1.Select the transaction batch from the list.
2.Click the Open, New, Delete, Print, or Post button to view, create,
delete, print, or post the batch.
To view the transactions in a batch, either open the batch you want to
view, and use the Journal Entry form to review transactions, or print the
batch listing report or preview it on your screen.
For information about using menu commands and icons, see Data entry tools and
shortcuts.

Ready to Post — Yes/No
Double-click the Ready-to-Post column when:
You are ready to post the batch of transactions.
You are finished editing a batch and do not want any unauthorized
changes.
You cannot edit batches which are marked Ready to Post.
Also, you cannot use the Post Batches form to post batches which are
not marked Ready to Post.
If you choose the Post button on this form to post a single batch, the
program will let you override the Ready to Post switch.
You cannot post to an account that has the Post To Account field in G/L
Accounts set to Prohibited.
See also

Displaying batch information
Journal entry

Journal Entry
This form lets you:
Create new batches.
Add journal entries to existing batches.
Change and delete journal entries.
View and reverse posted entries.
Add intercompany transactions if this is an ICT (Intercompany Transactions)
database.
Drill down on posted and unposted entries that originated in other
Sage ERP Accpac ledgers to view the source transactions.
A General Ledger batch is a group of journal entries, each of which contains at
least two transaction details, one for the debit amount and one for the credit
amount.
Journal entries do not affect G/L account balances until you post the
batches.
To add an entry
To drill down to a source transaction
To reverse a posted transaction
Customizing the Journal Entry form
Editing batches
Before posting
Importing and exporting transactions
Click here for hints on using forms.

See also
Adding a new batch
Deleting a batch
Displaying batch information
Editing a batch
Posting batches
Before Posting

Post Batches
This form lets you:
Post batches of transactions to General Ledger. (Note that you cannot
post to accounts that have the Post To Account field in the G/L
Accounts form set to Prohibited.)
Post batches of intercompany transactions to the respective
originating company and destination company General Ledgers (if
you use Sage ERP Accpac Intercompany Transactions).
Provisionally (temporarily) post transactions to General Ledger so you
can test their effects on your ledger before posting them permanently.
The posting process consolidates details for accounts using the Post To
Account In Consolidated option (selected on the Detail tab of the G/L
Chart of Accounts form).

Status of posted batches
Posting changes the status of posted batches to "Posted" on the Batch
Status report.

Batch errors
If you use the Force Listing Of Batches option, all batches to be posted
must be error-free, and you must have printed listings for them before
trying to post them.
If you do not use the option and post a batch that contains errors, the
correct entries will be posted, and entries containing errors will be placed
in a new batch, which uses the next available batch number.
Note: General Ledger cannot detect some errors until you post the batch,
and these errors will not be reported on the batch listing.

Posting sequence and entry
A unique posting sequence number is assigned to each posting run.
The number is printed on the posting journal and appears on the G/L
Batch List form, allowing you to specify which journals to print, as well

as to track data.
A unique posting entry number (consisting of the posting sequence
number and the entry number), indicating the order of posting, is
assigned to each entry that is posted.

Previous-year posting
When amounts are posted to revenue and expense accounts for a
previous year, this form also creates the closing entries for those
accounts, and adjusts the retained earnings account for the year. Closing
transactions are listed on the posting journal.

Provisional posting
Provisional posting copies Actual fiscal set amounts to a Provisional
fiscal set, and updates the Provisional fiscal set so you can see the
combined effect.
Batches are not deleted when you post them provisionally, and you
can make changes to them, if necessary, before permanently posting
them. On the Batch Status report, they are marked as provisionally
posted, and the date and the posting sequence number are included.
You can include provisional transactions on the Batch Status and Trial
Balance reports.
Provisional Posting is not available in an ICT company.

Reversing Entries
Before you can post reversing entries that span two fiscal years, you
must first create a new year using the Create New Year form. If you
do not create a new year first, posting will create an error batch for the
reversing entries, which you can post later.
Provisional posting does not post reversing entries across a fiscal
year boundary — only within a fiscal year.
For the steps to post transaction batches, click here.
If you use Sage ERP Accpac Intercompany Transactions

Create Allocation Batch
This form lets you create a batch of transactions that allocates balances
in accounts that use the Auto Allocation option to other accounts, and
creates the offsetting details.
The program calculates the amounts that will be distributed to each
account based on the information entered on the Allocation tab in the G/L
Accounts form for the source accounts.
To create an allocation batch
Click here for hints on using forms.

Create Revaluation Batch
This form:
Updates account balances in multicurrency accounts at new
exchange rates.
You would revalue accounts typically at period end or when currency
rates fluctuate rapidly. See Before Using.
You should use this form before printing financial statements.
Change the order of columns

in the currency list to suit the information you are

entering.
Split the currency list to view the fields you want to see when you
review the list.
To create a batch of revaluation transactions

What revaluation does
The form revalues the functional-currency equivalents of each specified
source-currency amount using the exchange rate you enter. It posts the
difference between the new functional-currency value and the previous
functional-currency value to the account and to the exchange gain/loss
account.
Realized/Unrealized Gain/Loss Method:
Revaluation transactions are reversing entries. This means that if you
revalue a range of three months, the first month will have an entry
that's reversed in month two. The second month will have an entry
that's reversed in month three, etc.
If you revalue accounts in the last period of a year, you must
create the new year before you post the batch (because the reversing
entry will be posted to the new year).
Recognized Gain/Loss Method:
Because revaluation transactions are considered permanent, no
reversing entries are created when you use the Recognized
Gain/Loss Method.

Entries are assigned to the next open batch, which you can view, edit,
and post in the same way as other batches.
New revaluation accounts need to be set up for the Recognized Gain
and Recognized Loss accounts in the Revaluation Codes setup form
before creating a revaluation batch.
The G/L accounts that had been set up for the Unrealized/Realized
Exchange Gain/Loss will not default, as the Unrealized/Realized
Exchange Gain/Loss accounts are Balance Sheet account types,
while the Recognized Gain/Loss accounts are Income Statement
account types.
The From Period and To Period fields default to the sign-on date’s
period when you use the Recognized Gain/Loss method. When you
select to span a range of periods, a warning appears to remind you to
check your selection carefully, since these transactions are being
revalued permanently.
As an extra precaution, the system won’t allow you to access the
Create Revaluation Batch form when there are unposted revaluation
entries. The revaluation entry has to be posted or deleted first.

Forcing revaluation
You can revalue a currency for an account only if that currency is listed
on the currency tab of the G/L Accounts form, if revaluation is set to Yes
for the account, and if the account has been assigned a revaluation code.
If you force revaluation, you will revalue currencies only if they are set to
NO for revaluation in the G/L Accounts form.
If you are forcing revaluation, all accounts which do not have a
revaluation code assigned will use the default that you specify in the
Create Revaluation Batch form.

Revaluation codes
When you create the revaluation batch, the revaluation code assigned to
an account determines:
The rate type that will be used to display the default exchange rate.

The source code to assign to revaluation transactions.
The gain/loss accounts to which exchange differences will be posted.
Once you define revaluation codes, you can assign them on an account
basis to each of the currencies which can be posted to an account (using
the Accounts form).
You can change the displayed rate for a revaluation run, but you cannot
change the date associated with the rate displayed by the system.
See also
Defining revaluation codes
Create New Year

Create Recurring Entries Batch
This form lets you:
Create a journal entry batch of a single or a range of recurring entries.
If a recurring journal entry has already been scheduled, you can also
create a batch using the Reminder List. (To open the System Manager
help pages for reminder lists and schedules, double-click the Reminder
List icon or the Schedules icon in Common Services, then click F1.)

To process recurring entries
1.Select the Create Recurring Entries icon in the G/L Periodic
Processing folder. The Create Recurring Entries Batch form appears.
2.Enter a date in the Run Date field if your recurring entries are being
created manually in the Create Recurring Entries Batch form. The run
date determines which recurring entries are due to be processed. It
includes all entries up to the date specified. If you process the entry
from the Reminder List, the run date reflects the date the recurring
entry is scheduled to be entered.
3.Enter a single recurring entry code or range of codes in the From
Recurring Entry Code field. To see a list of codes to choose from, click
the Finder.
4.Enter the last code (last, alphabetically or numerically) in your range
in the To Recurring Entry Code field. To see a list of codes to choose
from, click the Finder.
5.Select one of the following in the Method field:
Default. When you select this method, the batch will be appended
to an open batch if both batches have the same run date;
otherwise, a new batch is created.
Create a New Batch. When you select this method, a new batch
is created.
Add to an Existing Batch.When you select this method, a Finder
field appears. Click the Finder to select an existing open batch to
add this batch to (the run dates can be different).

6.Click Process.
Any transactions details optional fields and values specified for the
recurring entry code will be used in the resulting transaction details.

Year End Procedures
At the end of a fiscal year, you must close the income and expense
accounts for the old year, and open them for the next fiscal year. To
maintain clear and complete accounting records, there are other
procedures you may also wish to follow at year end.

To prepare for year-end processing:
Post outstanding batches for the year you are closing.
Print and clear all outstanding posting journals.
If desired, print financial statements and the other reports you require
for your records.
If desired, consolidate posted transactions.
Make sure you have specified the number of years you want to keep
fiscal sets and transaction detail (on the Posting tab of the G/L
Options form), and the retained earnings accounts to which you will
close income and expense accounts.
If you use multicurrency accounting, update exchange rates and
revalue account balances, if needed.
Back up data.

To complete year-end processing:
1.Use the Create New Year form to:
Create and post transactions to transfer the balances in the
income and expense accounts to retained earnings.
Enter the opening balances for the General Ledger accounts for
the new year.
2.Print and clear the Batch Status report and the posting journal created
by Create New Year.
3.Back up data.
4.Use the Period End Maintenance form to delete inactive accounts and
prior-year fiscal sets and transaction details that have been kept for

the number of years specified on the Posting tab of the G/L Options
form.
See also
Create New Year
Create Revaluation Batch
Period End Maintenance

Before Creating a New Year
Use the Fiscal Calendar form in Common Services to define the new
year and to ensure that the closing period is unlocked.
Make sure you have entered the correct default closing account on
the G/L Options form.
If you close by segments, be sure to specify the retained earnings
accounts for each segment code on the Segment Codes form.
Back up your data.

You may also wish to
Enter and post all outstanding transactions for the year that is ending.
If you import batches, import and post the batches you need for the
year.
Print and clear outstanding posting journals.
Print financial statements.
Print any other reports and listings you need for your audit trail and
other records.

After Creating a New Year
Define and print a source journal that lists only the entries associated
with the closing source code, GL-CL.
Print and clear the Batch Status report, selecting all statuses.
Print the opening balance sheet and other reports you need to start
your records for the new fiscal year.
Use the Period End Maintenance form to:
Delete inactive accounts.
Delete outdated transaction detail.
Delete outdated fiscal sets.
Reset batch numbers to 1.
Note that all Period End Maintenance activities are optional, and can
be done at any time.

Period End Maintenance
Use the Period End Maintenance form after running Create New Year at
the end of a fiscal year or as needed. Note that all Period End
Maintenance activities are optional, and can be done at any time.
If G/L Security is turned on, note that the period-end functions do not
check account permissions. For example, you can delete inactive
accounts, even if you do not have account permission.
For the steps to run Period End Maintenance, click here.
See also
Create new year
Year end procedures

Consolidate Posted Transactions
This form lets you:
Reduce detail on reports by consolidating (combining) details in the
accounts for which you do not need a permanent record of every
transaction.
See Before consolidating transactions.

To consolidate transactions
1.Select how you are choosing accounts for consolidation.
You can choose accounts by specifying a range of account numbers,
or a range of a particular segment.
2.Select the range of account numbers or segments that you wish to
consolidate.
3.Select the last fiscal year and fiscal period that you want consolidated.
4.Choose whether you want to consolidate by:
Account and fiscal period, where all transactions for the same
account and fiscal period are consolidated into one transaction. If
you are consolidating by account and fiscal period, enter the
source code to assign to consolidated transactions.
Account, fiscal period and source code, where transactions are
consolidated only if they have the same source code.
Account, fiscal period, and source ledger, where transactions are
consolidated if they share the same source ledger. If you are
consolidating by account, fiscal period, and source ledger, select
the ledgers whose transactions you are consolidating, as well as
the source code to assign to consolidated transactions from the
source ledger.
If you use a multicurrency ledger, amounts are also consolidated by
source currency.
5.Choose Proceed.
Click here for hints on using forms.

Effects of consolidation
When General Ledger consolidates a group of transactions, the individual
details are erased and cannot be listed on source journals or on the
Posted Transactions Listing.
Consolidation removes the posting entry numbers and batch entry
numbers associated with details:
The new posting sequence number is 0.
The batch number and entry number on reports is CNSLD.
The description and reference fields are set to CONSOLIDATED.
Note: When you consolidate posted transactions, you lose the ability to
drill down to the original transaction in the source ledger, and you also
lose any optional fields posted with the transaction.

Consolidating while posting
General Ledger also lets you consolidate transactions during batch
posting.
Use the Post To Account In Consolidated option on the Detail tab of the
G/L Chart of Accounts form to identify the accounts you want to
consolidate when you post batches.
The batch number and entry number used on reports is CNSLD.
The description and reference fields are set to CONSOLIDATED
POSTING.

Recovering disk space after consolidation
Consolidation does not reduce the disk space taken up by transactions.
Instead, it frees up space within the existing file, so the file will not
continue to grow.
If you need to free up space occupied by transactions, you must:
1.Consolidate posted transactions.
2.Use the database utilities for your database to reduce the file size.
See also

After consolidating transactions
Before consolidating transactions
Year end procedures.

Clear History
This form lets you:
Clear all information for printed posting journals.
Clear information for deleted and posted batches (up to and including
the batch number you specify).
Use the Clear History at the end of a fiscal year or as needed. Note that
Clear History activities are optional, and can be done at any time.

To use Clear History
1.Double-click the Clear History icon.
2.Check the procedures you want done. For example, to clear printed
posting journals, select the checkbox beside the appropriate line.
3.Choose Process. To leave without doing any processing, click Close.

Clear printed posting journals
Once you clear posting journals, you can no longer print them. Make sure
that you have copies of all posting journals before you continue.

Clear deleted and posted batches
This choice removes all information for deleted and posted batches. It will
also remove batches from the G/L Batch List and from the Batch Status
report.
See also
Create new year
Period end maintenance
Year end procedures

Create New Year
This form:
Creates and posts a batch of transactions to close income and
expense accounts and enter the opening account balances for the
new fiscal year.
Opening balances for the new fiscal year for balance sheet and
retained earnings accounts are the same as the previous year's
closing balances.
Income and expense accounts have opening balances of zero.
Changes the current fiscal year to the next year.
For the steps to create a new year, click here.

Prior year posting
You may continue to post transactions to the year you have just closed.
Whenever you post to a closed year, the General Ledger will also create
all appropriate closing entries to update retained earnings.

Retained earnings accounts
Each income/expense account is closed automatically to a retained
earnings account at year end.
See also
After creating a new year
Before creating a new year
Year end procedures

Choosing Printer as the Print Destination
Overview

If your printer is already set up, follow these instructions to change
the print destination back to Printer:
1.Click File > Print Destination.
2.Select Printer as the destination.
3.Click OK.
If you have not yet selected a printer for Sage ERP Accpac, follow
these instructions to choose a default printer for printing all reports
from Sage ERP Accpac.
1.Click File > Page Setup.
2.Click the Printer button.
3.From the drop-down list, choose the printer that you want to use.
The printer list includes all printers that have been added to the
Printers and Faxes list in Microsoft Windows.
4.Click the Properties button to change available settings for your
particular printer.
5.Click OK to close the Properties form.
6.Click OK again to return to the Page Setup form.
7.Click the Print Destination button and check that the print destination
is set to Printer.
If you are using a laser printer, you would normally select the Report
Paper Size and Report Orientation options on the Print Destination
form.
8.Click OK on the Print Destination form, and then click OK on the Page
Setup form.
After printing
Additional information regarding print destinations
Related topics

Choosing Preview as the Print Destination
Overview

To change the default print destination to Preview:
1.Click File > Print Destination.
2.Select Preview to view a report on the screen.
You can also print from the Preview window by clicking the Printer
button.
3.Click OK.
After printing
Additional information regarding print destinations
Related topics

Choosing File as the Print Destination
Overview

To change the default print destination to File:
1.Click File > Print Destination.
2.Click the File option.
3.Open the report or form that you want to print.
4.Make your selections in the dialog box, then click the Print button, or
click File > Print.
An Export dialog box opens.
5.Choose the format: Adobe Acrobat, Crystal Reports, HTML, Excel,
TXT, RTF, CSV, XML, etc.
6.Choose the destination: Application, Disk file, Exchange folder, Lotus
Domino, Lotus Domino Mail, MAPI.
7.Click OK, then select All or Page Range in the Export Options dialog
box that appears. Click OK to accept the options.
G/L displays the Choose Export File dialog box.
8.Specify a file name, choose the directory to save the report to, then
click Save.
9.Check in that directory folder to be sure the file went to the correct
location.
After saving as a file
Additional information regarding print destinations
Related topics

Choosing E-mail as the Print Destination
Overview

To change the default print destination to E-mail:
1.Click File > Print Destination.
2.Select E-mail.
3.Select either Adobe Acrobat (PDF) or Rich Text Format (RTF) as the
file format for the e-mail attachment.
You can open PDF files with Adobe Acrobat Reader (available as a
free download from the Adobe Software website).
You can open RTF files with most word-processing programs.
4.Click OK.
Note: When you e-mail audit reports, G/L allows you to clear the data for
them.
If recipient drills down to transaction
When you print with an e-mail destination
Related Topics

G/L Account Groups Report
This report displays account group codes, sort codes, and descriptions.
1.In the Range By field, select either:
Account Group
Or
Sort Code-Account Group.
2.Enter values in the From and To fields, using the Finders if needed.
3.Click Print.
The printed report includes columns for:
Sort Code.
Account Group IDs.
Descriptions.
Note: The entry in the From box cannot be greater than the entry in the
To box.
See also
General Ledger reports

Account Structures Report — Printing
This report lists account structure codes and their descriptions.
For more information on the contents of this report, see Account Structure Report —
features.

Before using
If necessary, set up printing destinations, and turn on and connect the
printer.

To print the report
1.Select File, then Print from the G/L Account Structures form, or
choose Account Structures from the G/L Reports folder.
2.Enter the range of account structure codes to include on the report.
3.Click

Print.

4.When finished, choose Close.
See also
General Ledger reports
Account Structure Report — features

Batch Listing Report — Printing
This report lists the contents of open (unposted) and posted batches. Use
it to check batches before you post them.
If you use the Force Listing Of Batches option, you must print every batch
before you can post it.
For more information on the contents of this report, see Batch Listing — features.

Before printing
Select printing destinations and, if necessary, turn on and connect the
printer.
Determine which batches to list and whether to report amounts in
functional currency only or in both functional and source currencies.

To print batch listings
1.Click the Print button on the G/L Batch List form (or select Print on the
File menu), or choose the Batch Listing icon from the G/L Reports
folder.
2.Select the range of batch numbers you want printed. The default
range includes all open batches.
3.Select the range of source ledgers. The default range includes all
ledgers (" " to "ZZ"). To restrict the report to a particular ledger, enter
the same ledger code in the From and To boxes: such as "GL" or
"AR". (For an Intercompany Transactions company, you enter either
AI or GI.)
4.Enter the range of batch creation dates. (The default range prints all
batches from the first day of the fiscal year to the session date.)
5.Choose whether to reprint batches that have already been printed
(and have not changed since they were last listed).
6.Choose whether to include transaction optional fields on the report.
(This option is not available in an Intercompany Transactions
company.)

7.If the batches have references and descriptions that you require on
the report, choose References and Descriptions in the Include
section.
If you choose Source and Functional in the Currency section, and
then select Letter/A4 as the paper size, references and
descriptions will be included automatically in the printed report;
you cannot change this option.
If this is an ICT company, references and descriptions are always
included; you cannot change this option.
8.If the batches have comments that you require on the report, choose
the Comments option in the Include section.
9.Select the types of batches you want printed:
Entered
Subledger
Imported
Generated
Recurring

10.Select the status of batches you want printed:
Open
Ready to Post
Posted
Provisionally Posted

11. If you have a multicurrency General Ledger, select either Functional,
or Source and Functional in the Currency section.
If you chose Functional, the report prints on Letter-size paper.
If you chose Source and Functional, you will then be able to choose
the paper size:
Legal
Letter/A4. (Note that references and descriptions will always be
printed on this report when you choose Letter/A4 paper size.)

12.When you are satisfied with your selections, click

Print.

Notes
If you use the Allow Provisional Posting option, you can list batches
that have been posted provisionally. (Batches are not deleted when
they are posted provisionally.)
You cannot print batch listings for deleted or posted batches.
If you need to list a posted batch, set up a source journal that includes
all the source codes likely to have been used in the batch, then
choose the batch number as the first means of selection when you
are preparing to print the journal.
Note that source journals do not include comments or transactions
that were consolidated on posting. If you need this additional
information, refer to the posting journal.
Batch listings are optional unless you use the Force Listing Of
Batches option in the G/L Options form. Posting journals are required
reports that provide the audit trail for batches.
Once you list a batch, the status of the batch will change to "Printed"
on the batch status report.

After using
Verify contents, correct any errors, reprint the edited batches, then file
the listings.
Post the batches.
See also
General Ledger reports
Batch Listing — features

Batch Status Report — Printing
This report shows all activity that has taken place in all currently
unposted batches, and in batches that were posted or deleted since the
last time the report data was cleared.
For more information on the contents of this report, see Batch Status report —
features.

Before printing
Select printing destinations and, if necessary, turn on and connect the
printer.
Decide on the range of batch numbers, source ledger codes, creation
dates, and the batch types and statuses to report.

To print the batch status report
1.Choose File, Print from the G/L Batch List form, or select the Batch
Status icon from the G/L Reports folder.
2.Select the range of batch numbers for which you want information.
The default range includes all open batches.
3.Select the range of source ledgers. The default range includes all
ledgers (" " to "ZZ"). To restrict the report to a particular ledger, enter
the same ledger code in the From and To boxes: such as "GL" or
"AR". (For an Intercompany Transactions company, you enter either
AI or GI.)
4.Enter the range of batch creation dates. (The default range prints all
batches from the first day of the fiscal year to the session date.)
5.Choose whether you want to clear information for deleted and posted
batches in the selected range after printing the report.
6.Select the types of batches for which you want information:
Entered
Subledger
Imported

Generated
Recurring

7.Select the status of batches you want printed:
Open
Deleted
Ready To Post
Posted
Post In Progress
Provisionally Posted
Provisional Post In Progress

8.To begin printing, click

After using
File the report.
See also
General Ledger reports
Batch Status report — features

Print.

Chart of Accounts Report — Printing
For information on the contents of this report, see Chart of Accounts — features.

To print a report
1.Choose the Chart of Accounts icon from the G/L Reports folder.
2.Select the format of the report:
Detail - Short form
Detail - Long form
Valid Currencies
Allocation
Control Account Subledgers
Fiscal Set Comparison
Rollup Accounts

3.If you choose Fiscal Set Comparison, select the two sets of figures
you want compared. You specify the fiscal set data type, the year, the
currency type (Functional or Source), and the currency.
If the euro is your functional currency and you specified a reporting currency,
you have the option of selecting reporting as your currency type.
When you select the reporting currency option, the report will print
amounts in the reporting currency, obtained from the reporting fiscal
set.
4.Select the option, "Exclude Accounts with No Activity" to avoid
including accounts on the report that have zero balances and that had
no transactions within the specified period range.
You must select the same year in both the From Year field and the To
Year field.
5.Select the option "Select Account Groups by Sort Code Range" if you
want to print a set of common account groups, but not other account
groups. (To do this, you must first give the same sort code to all
account groups in the set, specify printing by sort code order, and

then choose the sort code of that set.)
6.If you are printing the long form of the report and you use optional
fields, an option to include optional fields appears. Click the Include
Optional Field option to have optional fields information printed on the
report.
7.If you are printing the Rollup Accounts report, select either Members
or Rollup Accounts in the Show field.
8.Select the sort order for the report, and a range of the item by which
you are sorting. You can order the report by account number, any
segment of the account number, account group, account sorted
group. You can sort by account sorted group by choosing the Select
Account Groups By Sort Code Range option.
9.Select accounts by specifying ranges of account groups, account
sorted groups, account number segments (that haven't already been
specified as the sort order), or the range of optional fields.
10.Click

.

Print

See also
General Ledger reports
Chart of Accounts — features

G/L Options Report — Printing
For information on the contents of this report, see G/L Options report — features

To print a report:
1.Choose File, Print from the menu on the G/L Options form, or choose
G/L Options from the G/L Reports folder.
2.Click

.

Print

See also
General Ledger reports

G/L Transactions Listing — Printing
This report lists the net changes, balances and transaction details of all
accounts in the selected range, for the specified fiscal periods.
For more information on the contents of this report, see G/L Transactions Listing —
features.

Before using
Post batches.
Decide which accounts you want on the report, and the range of fiscal
periods that you want reported.
Decide whether to include accounts with no activity (zero-balance
accounts with no transactions posted to them in the period specified
for the report).
Select printing destinations and, if necessary, turn on and connect the
printer.

To print the report
1.From the G/L Reports folder, choose G/L Transactions Listing.
2.Select the

order in which you want the report listed.

3.Select the range of accounts you want printed, whether you print by
account number, by account segment, or by account group.
4.In the Include section of the form, indicate whether to print additional
information on the report. You can select:
Accounts With No Activity
Quantities
Transaction Optional Fields
Balances and Net Changes
Include Posting Sequence and Batch-Entry Numbers

5.Select the year and range of fiscal periods for the report.

6.If you are printing period 12 details, indicate whether to include
adjustment and closing entries (if you have created the next year).
7.Select the

type of currency.

8.If you want to sort transactions by date within the selected accounting
periods on the report, select Sort Transactions By Transaction Date.
9.Select the option, Select Account Groups By Sort Code Range
(optional), then enter a range in the From and To fields of the Sort
Code-Account Group section. Otherwise, leave those fields blank.
10.Select Use Rolled Up Amounts to print the transactions of a rollup
account and all of its rollup member accounts (at any level), rolled up
into a single amount for each transaction. (Note that rollup member
account transactions are included only once in the rolled up
transactions.)
11. If you selected Segment in the Sort By section, you can chose
whether or not to add a page break after each account in the report.
12.Restrict the report further, if you wish, by selecting ranges of segment
codes and ranges of account optional fields.
13.Click

Print.

Notes
Information for each detail includes the batch entry number, posting entry
number (a combination of the posting sequence number and the
sequential number assigned to indicate the order in which the entry
containing the detail was posted), source code, descriptive and reference
text, and the debit or credit amount. Comments do not appear on this
report.

After using
Use the report in combination with the posting journals and batch
listings to trace transactions for auditing purposes.
File the listing with your audit trail reports.
See also
General Ledger reports

G/L Transactions Listing — features

G/L Optional Fields Report — Features
You print the Optional Fields report whenever you need a listing of all the
optional fields set up for your General Ledger.
The report lists separately the optional fields set up for accounts and
transaction details.
For each optional field code, the report shows the description, default
value, whether the optional field is required, and whether the optional
field is set for automatic insertion in new accounts.
See also
General Ledger reports
Printing the Optional Fields report

Posting Journals Report — Printing
This is an audit trail report of all uncleared details that have been posted
on the Post Batches form.
For more information about the contents of this report, see Posting journal —
features.

Before using
Post batches.
Decide whether to reprint posting journals you have printed before.
Note: if the posting journal has been printed and the Reprint
Previously Printed Journals option was not selected, the
corresponding Posting Journal Errors report will be blank, even if
there were errors. You must select the Reprint Previously Printed
Journals option if you are planning to print a copy of the errors report
after printing the Posting Journals report.
If you are only printing an errors report (possibly prior to printing the
posting journal itself), choosing this option is not necessary, that is,
the Posting Journal Errors Report will not be blank (assuming there
were errors).
Decide whether to list transactions by account number or posting
sequence number. (This doesn't apply if you are printing errors only.)
Select printing destinations and, if necessary, turn on and connect the
printer.

To print the report
1.Select the Posting Journal icon from the G/L Reports folder.
2.Select the

report you want to print.

3.Specify whether you want to order the report by posting sequence or
account number.
4.Specify the range of posting sequences you want to print.
5.Select Reprint Previously Printed Journals to print journals that have

already been printed to a printer or file or if you will be printing the
Posting Journal Errors report. If you do not select the option, these
reports will be blank.
6.Select Include Trans. Optional Fields to print optional fields posted
with transaction details. (This option is not available for an Intercompany
Transactions company.)
7.If this is an Intercompany Transactions database, ICT Expansion will
be available. If this is not an ICT company, go to step 8. If it is an ICT
company, choose one of the following:
None
Separate Report
By Entry
By Detail

8.Select a
9.Click

Currency option.

Print.

Notes
You can reprint journals as often as you wish, until you clear the file.
In multicurrency ledgers, you can print both source-currency and
functional-currency information on the journal (on letter, ledger, or A4
paper).

After using
Check that you have a good copy of the report, then file it with other
audit trail reports.
See also
General Ledger reports
Posting journal — features

Recurring Entries Report — Printing
The recurring entries report lists recurring journal entries set up using the
G/L Recurring Entries form.
This report lists recurring entries by code, states which account(s) the
codes pertain to, and shows the type of schedule and its frequency. It can
also include optional fields entered with transaction details, if you choose
to include them.

To print the report
1.Choose the Recurring Entries icon from the G/L Reports folder.
2.Complete these fields on the Recurring Entries Report form:
From Recurring Entry Code.
To Recurring Entry Code.
3.Select Include Schedules if you want to print the recurring
transactions schedule used for each recurring charge.
4.Select Include Trans. Optional Fields if you want to print optional
fields with each transaction detail that uses them.
5.Click

Print.

6.Click Close.
See also
General Ledger reports
Recurring Entries report — Features

Revaluation Codes Report — Printing
This report lists specified revaluation codes and the information entered
to define them in a multicurrency ledger.
For more information on the contents of this report, see Revaluation Code report —
features.

To print the report
1.Choose File, Print from the G/L Revaluation Codes form, or select the
Revaluation Code icon from the G/L Reports folder.
2.Specify the range of revaluation codes to include on the list.
3.Click

Print.

See also
General Ledger reports
Revaluation Code report — features

Segment Codes Report — Printing
For information on the contents of this report, see Segment Code report — features.
1.Choose File, Print from the G/L Segment Codes form, or select the
Segment Code icon from the G/L Reports folder.
2.Choose to print all segment codes you've defined, or print a range of
codes valid for a particular segment.
3.Click

Print.

See also
General Ledger reports
Segment Code report — features

Source Codes Report — Printing
This report lists a range of source codes and their descriptions.
For more information on the contents of this report, see Source Codes report —
features.

To print the report
1.Choose File, Print from the G/L Source Codes form, or select the
Source Codes icon from the G/L Reports folder.
2.Enter the range of source codes to include on the report.
3.Click

Print.

4.When finished, click Close
See also
General Ledger reports
Source Codes report — features

Source Journals Report — Printing
Source journals list the details of posted transactions for the source
codes that you included in the source journal definition.
For more information on the contents of this report, see Source Journals — features.

Before using
Post current batches.
Define source journals in the Source Journal Profiles form.

Printing source journals
You can customize a source journal at print time by choosing:
The sorting order of the report. (By account number, segment, or
account group.)
Account, segment, account group, or account optional field ranges.
Fiscal period, reference, transaction date, posting sequence, and
batch number ranges.

To print the report
1.Open General Ledger > G/L Reports > Source Journals.
2.On the Journal tab:
a.

Select a journal in the Profile field. The journals include:
A/R Clearing Journals
Bank Reconciliation Report
GL Journal Entries
Invoice Journal
Purchase and Receipts Journal
Reallocation Journal
Transaction Journal

b.

Click the Browse button to

c.

In the Currency field, choose either Functional, or Source and
Functional.

select a report format

in the Use Report field.

3.On the Account tab:
a.

Specify whether you want to sort the report by Account Number,
by Segment, or by Account Group.

b.

Specify the range.

c.

Select the option, "Select Account Groups By Sort Code Range,"
(optional) and then select the range. (Note that the Account Group

option in the Sort By section changes to Account Sorted Group
when you select this option.)
d.

Select the option, "Include Trans. Optional Fields" if you wish to
print optional fields that were posted with transaction details.

e.

Use the Finder to select the range of Segment Names.

f.

If you use optional fields, enter a range of account optional fields
to be included in the report.

4.On the Ranges tab of the form, specify ranges of fiscal periods,
references, dates, posting sequences, batch numbers, (and source
currencies, for a multicurrency ledger).
Note: You must enter 000000 in the Batch Number From field when
you print entries for consolidated accounts/transactions.
5.Click

Print.

To change the standard source journal reports
If you want to change the information in the report, or the order that the
report is sorted (beyond the choices provided by the G/L program), you
can define a new report, or modify an existing report.
General Ledger report definitions are found in the ENG subdirectory of
the program directory. The program directory is \ACCPAC\GLxxx, where
xxx is the version number of the General Ledger program.
See also
General Ledger reports
Source Journals — features

Source Journal Profiles Report — Printing
This report lists source journal descriptions and their associated
information.
For information on the contents of this report, see Source Journal Profiles report —
features.

To print the report
1.Choose File, Print from the menu on the G/L Source Journal Profiles
form, or select the Source Journal Profiles icon from the G/L Reports
folder.
2.Enter a range of source journal profiles that you want printed.
3.Choose

Print.

See also
General Ledger reports
Source Journal Profiles report — features

Transaction Details Optional Fields Report —
Printing
This report lists transactions that use optional transaction fields and
optional field values that you specify.
For information on the contents of this report, see Transaction Details Optional Fields
report - Features.

Before using
Post batches.
Decide which accounts and optional fields you want to include on the
report, and the range of fiscal periods that you want reported.
Select printing destinations and, if necessary, turn on and connect the
printer.

To print the report
1.Choose the Transaction Details Optional Fields icon from the G/L
Reports folder.
2.Select the

order in which you want the report listed.

3.Select the range of accounts you want printed, whether you print by
account number, account segment, account group, by account
optional fields, or by sort code range for account groups.
4.If you have a multicurrency ledger, specify the

report currency.

5.Select the year and range of fiscal periods for the report.
If you are printing period 12 details, indicate whether to include
adjustment and closing entries (if you have created the next year).
6.If the report is ordered by account number or segment, you can select
a range of account groups.
7.Restrict the report further, if you wish, by selecting ranges of segment
codes.
8.Specify up to three optional fields and the range of optional field

codes for which you wish to include transactions in the report.
Only posted transactions that use the specified optional transaction
fields and values will appear on the report.
9.Click

Print.

See also
General Ledger reports
Transaction Details Optional Fields report - Features

Trial Balance Report — Printing
This report prints a trial balance report or worksheet that lists selected
account balances for a specified fiscal period. Print it at the end of
accounting periods, when you are ready to calculate adjusting entries.
For information on the contents of this report, see Trial Balance report — features.

Before using
Update account information by entering, retrieving, and posting
batches.
Decide whether to list accounts by:
Account Number
Segment
Account Group
account-sorted Group

Decide whether to include accounts with no activity .
If you have provisionally posted batches, decide whether or how to
include provisional data.
Decide whether to use Rolled Up Amounts. Note: when you choose
this option, the debits and credits on the report may not balance if any
account is a member of more than one rollup group.

To print the report
1.Open General Ledger > G/L Reports > Trial Balance.
2.Select the report format:
Report
Worksheet
Quantity Report
Provisional Quantity
Provisional Included

Provisional Separate
Provisional Worksheet

3.Select either Balances as of Year/Period or Net Changes for the
Period in the Print field. If you selected Worksheet or Provisional
Worksheet as the report format, the only option available in the Print
field is Balances as of Year/Period.
4.Select the desired period(s) for the report. If you chose to print a
Balances report, select a specific period. If you chose to print a Net
Changes report select a range of periods.
5.Select the currency in which you want amounts to appear. If the euro
is your functional currency and you have specified a reporting currency, the
Currency selection list shows the Reporting option. Select Reporting
to print all account balances for the year and period in the reporting
currency.
Note: this field appears only if EUR is your company's functional
currency.
6.Select Include Accounts With No Activity if you want to list accounts
with zero balances, and no postings in the current year.
7.Select Use Rolled Up Amounts to print amounts and quantities of a
rollup account (and all of its rollup member accounts) rolled up into a
single amount or quantity. (The debits and credits on the report may
not balance if any account is a member of more than one rollup
group.)
8.Skip this step if you chose Worksheet or Provisional Worksheet in the
Report Format field. If you chose to print a Net Changes for the
Period report, the Include Net Income (Loss) Total for Listed Accounts
checkbox is selected by default. Clear this checkbox if you do not
wish to include totals for net income or loss for accounts in your
report.
9.Specify whether you want to order the report by account number,
segment, account group, or account sorted group, or optional field,
and specify a range of accounts in that order.
10.Specify the range of accounts, segment codes, account groups,

account-sorted group, and optional fields you want to print.
11. Click

.

Print

See also
General Ledger reports
Trial Balance report — features

Financial Reporter Overview
The Financial Reporter is a spreadsheet add-in program that uses
Microsoft Excel to read and print General Ledger data.
Financial statements are spreadsheets that use special Sage ERP
Accpac functions to extract data from the Sage ERP Accpac accounting
database.

Financial Statement Designer starts Microsoft
Excel
Whenever you choose the Statement Designer from Sage ERP Accpac (to create
or edit a financial statement), Excel (with the Financial Reporter add-in)
starts automatically.
It is important to remember that this spreadsheet add-in is available only
when you start Excel from the Statement Designer icon.
Note also that Microsoft Excel is not shipped with Sage ERP Accpac
General Ledger. If you want to use Excel to create financial statements,
you must purchase it separately.
To print a Financial Report

Key Financial Reporter Concepts
The Financial Reporter is based upon a few, simple concepts:
A financial report is a spreadsheet containing functions that read data
directly from General Ledger.
You can place Financial Reporter functions anywhere in a
spreadsheet. The spreadsheet program looks up the General Ledger
values when it recalculates the spreadsheet.
You can also use any other spreadsheet functions you want to further
manipulate that data.
A financial statement specification is a structured description of the
statement you want to produce. Financial Reporter creates a
statement based on the specification and the options you choose
when you want to print or view the final statement.

Statement specifications allow you to assign default functions and
formulas to columns of the spreadsheet, and to specify that a range of
accounts will be expanded to many rows on a final statement.
Statement specifications make statements easier to create and more
flexible, but you don't have to use them.
Financial Reporter lets you choose and restrict data at print time by
account segment range, account group, fiscal period, and by fiscal set
(actual or provisional amounts).
Keep in mind when designing statements that a generalized financial
statement can be printed with the actual or provisionally-posted
amounts of any particular department or division.
If you are including rollup accounts, be sure you designed the rollup
group in such a way that you do not end up with doubled amounts in
the report.

Layout of a Financial Report Spreadsheet
All Sage ERP Accpac financial statements are Microsoft Excel
spreadsheet files that contain the functions required to read general
ledger data.
Generally, each of these spreadsheet files has two separate regions:
The Spec range — the region containing the specification.
The Report range — the region containing the final statement.
The Report range also contains a third range called the Print range,
which excludes all audit information that can be generated in the first
columns of the Report range.
Remember, however, that you don't need to create a specification to
extract and print information. You can extract and print balances from the
General Ledger by placing a few formulas in a spreadsheet, recalculating
the spreadsheet, then choosing the File, Print command.
You can also save the spreadsheet, then use General Ledger's Print
Financial Statements form to print the values in future. (If you don't have
a statement specification in the spreadsheet, Financial Reporter
recalculates all the formulas, then prints it out.)

Specification and Report Ranges
If you use a statement specification to generate financial statements, the
statement specification and the report it creates both reside in a single
spreadsheet.
The report specification occupies a named range of the spreadsheet
called the Spec range, and the report is generated in a named range
called the Report range.
When you generate a financial report from a specification, the Financial
Reporter processes all the specification information in the Spec range,
and creates the final report in the Report range.
(Financial Reporter actually prints a smaller area of the spreadsheet than
the Report range — called the Print range -- which excludes columns A to
D.)

The report template starts in column E
The first four columns of the Spec range (A through D) are reserved for
control information for the financial reporter. All other columns form a
template which determines the appearance of the report and the kinds of
data which will appear.

The Spec range can occupy any columns
A specification can actually begin in any column of a spreadsheet. The
only requirement is that the first column of the Spec range must be the
first column of the specification.
However, for simplicity, this help always refers to the first column of the
specification as column A. There is really no reason why you should start
a specification anywhere else.

Report Range of the financial report spreadsheet
The Report range is generated from the Spec range when you print the
financial report. The Report range contains the data that is generated by
running the reports, and the data extracted from the General Ledger.

The printed report starts in column E
The control information in the first four columns of the specification has
been replaced by audit information in the report range (this is an FR View
command option).
When you print out the report, Financial Reporter prints all but the first
four columns of the Report range (omitting the audit information). This is
called the Print range.
If you do not have a Spec range.If you did not create a report
specification, the Financial Reporter recalculates the sheet and prints it
when you print the report. If you don't want to print the whole
spreadsheet, you can use the Financial Statement Designer's Options,
Set Print Area command to define the area you wish to print.
If you have a Spec range.If you have a Spec range, Financial Reporter
will automatically regenerate the financial statement before printing it

when you use the Financial Reporter form.

Generating Reports from Specifications
If you print a financial statement by choosing the Print Financial
Statements icon, you do not see the report specification. Instead, the
Financial Reporter program does the following:
Continues to display the Financial Statements form while it starts
Microsoft Excel.
Loads the specification spreadsheet.
Generates the specification commands in the Spec range of the
spreadsheet.
Prints the final report.
If no Spec range exists, Financial Reporter recalculates the sheet
and prints it
If the spreadsheet doesn't contain a Spec range, Financial Reporter:
Recalculates the spreadsheet (taking into account any restrictions
placed on account selection by the Print Financial Statements form).
Prints the whole spreadsheet (or the region defined in the
spreadsheet as the print area).
Depending on the Print Destination settings under the
Options/Preferences command, you may print directly to a printer. Or,
you can preview the report before you print it, save it as text or send it as
an e-mail.

Generating statements in the Financial
Statement Designer
When you edit a report specification (using the Financial Statement
Designer), you can also test the statement specification you are editing.
FR View command to generate the report
To generate the final report, choose the FR View command (from the FR
menu) in the Financial Statement Designer.
FR View lets you generate the report using the same print options that

you use to print a report from the Print Financial Statements icon;
however, it provides two additional options:
Audit information
Formulas
If you generate audit information, Financial Reporter will list the results
of the account number references in column A of the report range of the
spreadsheet. This information allows you to check the numbers of all
accounts included in your statement (as long as you use the "D" option in
column D of the report).
If you generate formulas, Financial Reporter will insert a formula in
each cell of the final report where you need to insert General Ledger
information. You can then update the report at any time by recalculating
the spreadsheet.
Once you have generated the report, you can preview it with the Print
Preview from the Financial Statement Designer's File menu.
Note that spreadsheets with formulas are much larger than standard
report specifications. Note also that generating statements using Include
Formulas takes longer, because Excel calculates the value of each
formula as it generates them.
For details on using FR View, see FR View.

Setting the Spec Range
Before you can generate and print a financial report from a report
specification, you must define the Spec range.
The Spec range is a named range of cells in the spreadsheet.

To define the Spec range in Excel, follow these
steps:
1.Mark the complete report specification, from the first row and column
to the last row and column. (To mark, place the mouse point on the
first cell of the range, hold down the left mouse button, and drag the
pointer to the last cell of the range.)
2.Choose Insert, Name, Define.
3.Type "Spec" as the range name, then click OK.
You must type exactly these letters (the capitalization doesn't matter).
You don't define a Report range
Note that you don't need to define a Report range within the spreadsheet.
Financial Reporter defines the Report range when it generates the report
from a specification.

Enlarging the Spec Range to Extend the Right
Margin of the Print Area
In some reports you might find that information is cut off the report
because it extends beyond the right edge of the spreadsheet print area.
There are two ways you can modify a report specification to make sure
that report information isn't truncated by the right edge of the print area:
Widen the particular column of the spreadsheet that contains the
extra wide material.
Redefine the Spec range in the report spread so it includes the
spreadsheet columns that the information overlaps.
Right boundary is set by the Spec range
The second approach works because the right print area boundary of a
financial statement that is generated from a specification is the same as
the Spec range boundary.
All the columns that you include within the Spec range will be included on
the printed statement (except columns A, B, C, and D).

What Each Column Does in the Financial Report
Specification
Most of a financial report specification is a template for the report it
produces. For example, all report formatting -- such as column widths,
fonts, highlighting and underlining -- appears on the financial report
specification.
The first four columns of the report specification (usually columns A
through D) contain important control information.
Column A determines the purpose of a row
For example, a row can be a comment, a title line, a default line
specification, a line of text on the final report, or an account detail line.
Column B restricts the set of accounts specified in column A
For example, you can restrict the account range to income accounts
with a normal credit balance.
Column C removes zero-balance lines from a report or overrides a
default condition to remove zero lines
You can also suppress lines that meet other criteria (such as less than
5,000).
Column D consolidates ranges of accounts or lists them
individually
Allows you to consolidate by account number segment, and to
consolidate transaction details or list them individually.
See also
Purpose of Column A
Purpose of Columns B, C, and D
Column E of the Spec_Range
How to Set the Spec_Range
Enlarging the Spec_Range
Using Column D to Consolidate by Transaction Details

Column A Determines the Purpose of a Row
The contents of column A of each row (the first column of the Spec
range) determine the purpose of all the columns in the row.
There are five possible types of rows in a report specification:
Comment rows:
If column A starts with "..", the row is a comment row.
"As is" rows:
If column A is blank, the row is part of the report and will appear "as
is" on the final report.
Default rows:
If column A starts with "\\", the row is used for setting up defaults for
the remaining rows on the report. You can have more than one default
specification row; each applies to the rows between it and the next
default row.
Title rows:
If column A starts with "\T", the row is used for defining title lines on
the final report. You can have up to five title rows; which will appear at
the top of each tab of the report (immediately under the header lines).
Body specification rows:
Rows that start with account number references are called body
specification rows.
If column A contains any other data, that data is assumed to be a
reference to one or more account numbers. And, if an account number
appears in column A, it generally means that all the printed columns in
the row will contain data from that account.

Adding Explanatory Comments (..)
You can make any line of a report specification a comment line by
starting column A with two periods. For example, the following four lines
are in cells A1 through A4 of a report specification:

These lines will appear when you view the specification file, but will not
be printed on the actual financial statement.
We suggest you begin every specification with a few comment lines
describing it, and add comments throughout to explain important sections
of your specifications.

Adding Title Lines (\T)
The Financial Reporter allows you to specify up to five lines that can
appear at the top of each tab of a Financial Statement.
You can only define one set of title lines in a specification, and all title
lines must be together (contiguous). If you have defined more than one
set of title lines, Financial Reporter will use the last set in the
specification.
The first five lines of the report specification are the title lines, which will
be repeated at the top of each tab of the report, as shown below.
The Universal Corporation
Balance Sheet
As at October 31, 1999
Current Balance
Petty cash

274.57

Bank account

8,437.54

Bank account, CAD
dollars

4,372.96

Total:

13,085.07

If you wanted the title to appear only on the first tab of the report, leave
the first column for these rows blank. The rows will be transferred "as Is"
to the beginning of the Report range.

Using title lines in Excel instead of \T lines
Note that the title lines generated by Financial Reporter use the standard
Excel mechanism for title lines, so if you use the Financial Reporter "\T"
line, you cannot separately mark a group of cells as title lines. Note also
that title lines must be consecutive, and cannot be split by a tab break.

Columns B, C and D Filter Accounts Specified in
Column A
Although you specify account numbers for a row or group of report rows
in column A of the report specification, you can use columns B, C and D
(columns 2 through 4 of the Spec range) to refine the account selection.
For example,
Column A can specify a range of accounts.
Column B can contain a filter that restricts the range of accounts to a
particular account group or account type or account name. For
example, the expression, A.ACCTCLASS="Sales" filters for the value
of an optional field called "Sales".
Column C can remove any lines from the report that have zero
balances, override a default condition to suppress zero balances, or
meet a condition such as "balances less than $1,000".
Column D can consolidate the balances of the range of accounts,
consolidate by account segment, list each account separately,
consolidate all values from retrieved optional fields, or print the
optional field value of the first retrieved record.

Using Column D to Consolidate by Transaction
Details
Column D constants for use in the spec area are the indicators for listing
by transaction details, by transaction consolidated total, and by
transaction total. Values must begin with “P”.
Cell Value of
Column D

List By
Transaction details in posted
transaction order
Transaction consolidated total
Transaction consolidated by
account
Transaction consolidated by
journal date
Transaction consolidated by
posting sequence

PD
PT
P(POSTRAN)
P(POSTDATE)
P(POSTSEQ)

Transactions can also be listed by consolidated account segments and
account groups as listings by accounts. When consolidating by a specific
account order in listing by transactions, the column D value must start
with P instead of with D.
For example, P(ACSEGVAL02) is the consolidation of transactions with
account segment 2 retrieving records from a transaction, while
D(ACSEGVAL02) is the consolidation of account history with account
segment 2 retrieving records from an account.
To list the details by transaction, FR requires the spec to provide a
correct sorting order, as illustrated in the following table:
Exclusive
Sorting Order

Meaning

POSTTRAN

By Posted Transaction, in
account order

POSTDATE

By Date Order

POSTSEQ

By Posting Sequence Order

POSTACCT

By Account Posting
Sequence

If the account reference is specified with exclusive sorting order at
column A from a spec line and the order is an account order (for
example, 1000:9000|ACCT), FR does not generate the transaction
details of the spec line.
The sorting order must be POSTTRAN if consolidation value in
column D is P(POSTTRAN).
The sorting order must be POSTDATE if consolidation value in
column D is P(POSTDATE).
The sorting order must be POSTSEQ if consolidation value in column
D is P(POSTSEQ).
If the consolidating total is retrieved by any defined account switches,
like P(ACSEGVAL02), it can be sorted by any defined account order,
similar to listing by accounts.
Listing by transaction is only limited to the inquiry of transaction
records from the inquired period.

The Report Template Starts in Column E of the
Specification Range
The report template actually starts in Column E, the fifth column of the
Spec range. Any value or formula placed in the report template area is
part of the final report.
The following spreadsheet shows a report specification displayed in
formula view.

In the above example, the first three lines of column F which appear on
the report are:
=FR("CONAME"), a Financial Reporter function that puts the
company name on the statement.
The text "Schedule of Expenses."
The text and function ""For the period ending " &FR("END")." The
function inserts the period end date from the database.
Row 9 of the specification sets the default contents of statement
columns. Column A of this row starts with two backslashes.
The next row with text contains the headings for columns G, H, and I.
These headings are printed "as is." Note that to underline these column
headings, you use the Financial Statement Designer's cell formatting

controls.
The next row with text will be expanded on the printed report to include
all accounts in the range between 6000 and 6999 which meet other
selection criteria specified in cells B, C, and D, or entered at print time in
the Print Statements form. In the spreadsheet's formula view, it looks like
this:

In the above row, the "\" in the right three columns indicates that each
cell value will be generated from the default formula set for the column.
(The Financial Reporter inserts the account reference in column A into
any default formula which requires the account reference parameter.)
For example, the default formula for column G is "=FRAMTA("NETP")".
FRAMTA is a Financial Reporter function that prints the account period
balances or net amounts from the account fiscal sets. In this case, the
formula specifies the net amount for the current period.
When the Financial Reporter processes this cell of the statement
template, it expands the formula with the account reference from column
A, for example, =FRAMTA("NETP", "6000").
The remaining two columns also use a default formula; in this case,
bringing in the net changes for the quarter to date and the year to date.
The final row in our example is the total line. Notice that the template
uses the Financial Statement Designer's cell formatting capabilities to
place a single underline above the total, and a double underline beneath
it.

Notice also that the total formula for each column refers to a single cell
(or list of cells) in the specification range. In our example, the single cell
in the specification range formula will be replaced in the report range
formula by a range reference which contains as many rows as there are
accounts in the account range specified on line 12.

Controlling Overall Financial Statement Format
All formatting of financial statements is controlled by the Financial
Statement Designer's formatting commands. For more information on
controlling tab size, tab headings, font size and style, refer to the online
help and the printed documentation for Excel.
The Financial Statement Designer has format styles
The most efficient method for formatting the area and the text within a
cell is to create a style that includes various attributes (such as bold text,
dollar format, right alignment, etc.), and apply the style to spreadsheet
cells.
A style includes the number format, border, font, pattern, number
alignment, and cell protection settings. By using styles, you can set these
elements in one step, rather than using a group of commands to format
each cell.

Formatting Report Lines
The format you apply to a line of a report specification is used for every
line that it generates on the final report. In the following example, column
titles are bold and underlined, and column G uses right alignment:
A

BCD
E
F
\\
Z T =FRACCT("ACCTID") =FRACCT("ACCTDESC") =FRAMT("BAL
Account Number
Account Description
Current
1100:1300 \ \ \
\
The column titles in the generated report are also bold and underlined,
and all the figures in column G (Current Balance) are aligned to the right:
Account
Number
1100
1200
1300

Account
Description
Cash
Bank Account
Receivables

Current
Balance
462
8,946
73,986

If you put a border around one cell of the specification, all cells that use
the bordered cell as a template will have borders.

Formatting Column and Row Widths
You may change the width and height of cells using the Format Column
Width and Format Row Height commands. Or, you can position the
cursor on the vertical line to the right of the column heading, or on the
horizontal line below the row heading, and drag the line to change the
cell sizes.

If a number is too large
If you adjust cell width so that a number will no longer fit in the cell, the
Financial Statement Designer will display "####" when you view the
report or print it using the Financial Reporter.

Hiding a column
You can hide columns using the Format Column Width command.

Hiding Rows on the Final Report
It's often useful to have statement rows that you don't want printed on
your final report. (For example, you may have statement rows that
contain intermediate rounding calculations.)
You can hide a row on a financial report by hiding the row in the
specification.
To hide a row, choose Format, Row Height, or simply drag the bottom
border up until the row disappears.

Hiding Columns on the Final Report
If you hide a column on the report specification, it will not appear on the
report.
To hide a column, you make the specification column (and, hence, the
report column) so narrow that it no longer exists on the report. You do this
by choosing Format, Column Width, or by dragging the right border to the
left.

Formatting Numbers
You can change the number format of one or more cells by selecting the
cells you want changed, then choosing the Cells command on the Format
menu. In the Number tab of the Format Cells dialog box, select a
category, then make the desired changes.
The Financial Statement Designer provides a variety of built-in number
formats that are available to every financial statement. You can also
create your own custom formats. See the Excel online and printed
documentation for details.
Formats force rounding
If the format 0.00 is applied to a cell, the Financial Statement Designer
rounds the number to two decimal places. If you choose a format with no
decimal places, the Financial Statement Designer will also round to fit
that format.

Formatting Text
You can change the type style, size, and color of selected text. You may
choose from any of the fonts available with the printer driver currently
selected for reports.
Use the Format Alignment tab in the Format Cells dialog box to force
text to the right or left edges of the cell, or to center it. (You can also
use the Left, Center or Right buttons on the Tool Bar for the same
thing.)
Use the Font tab in the Format Cells dialog box to change the font,
style, size, and color of text.
Note that the Financial Statement Designer lets you create and use
styles for formatting spreadsheet cells. By using styles, you can apply
more than one cell attribute easily, rather than using a group of separate
formatting commands.

Formatting Page Layout
The File Page Setup command controls the page layout and allows you
to set headers, footers, and margins in a spreadsheet.

Printing column headings with Options/Set Print
Titles
To print recurring column headings at the top of each page, use the
Financial Statement Designer's Set Print Titles feature.

Setting page breaks
If you set a page break in the report template, Financial Reporter will
treat the page break as an "As is" row and insert it in the corresponding
point in the final report.
The main use of page breaks is to begin new sections of a statement at
the top of a page, or to ensure that all columns to the right of the page
break appear on a separate page. Page breaks create a horizontal and a
vertical division where you insert them in a spreadsheet.

The above diagram shows the effect of setting two page breaks: one in
cell A11, which creates a horizontal break, and one in cell H23, which
also creates a vertical break.
Page breaks are of limited use if you write statements containing account
references that are expanded into many rows. They work best for starting
sections of a report on a new page.
Generally, for multi-page reports, you can either leave the pagination to
the Financial Statement Designer, or you can print the report to a file (or
copy it to a word processor), then add whatever embellishments you
want in the report file before printing a final report.

Using Formulas to Specify General Ledger
Information in Columns and Cells
You gain access to account data -- and all other data in the General
Ledger -- with Financial Reporter functions.
The Financial Reporter functions are:
Financial
Reporter
functions

Information they provide

FR

G/L option & company data, and statement print
options

FRACCT

account data

FRAMTFRDEBIT

,

,

FRCREDIT FRAMTA

,

fiscal set data

FRFISCAL

fiscal calendar dates

FRRATE

exchange rates

FRSDESC

segment code descriptions

FRTRN

net totals and net quantities from transaction history

FRTRNA

net amounts and net quantities from posted
transactions for a specified period

FRTRNCR

net credit totals and net quantities from transactions

FRTRNDR

net debit totals and net quantities from transactions

FRPOST

account and transaction records, including optional
fields from posted transactions

Because you can use them in conjunction with other spreadsheet
functions, Financial Reporter functions provide a very powerful way of
getting data out of the general ledger and placing them in a report.
You use Financial Reporter functions in two main ways:

To place one piece of information in one particular cell of a report.
In a default row (or single row) of a report specification to define the
information that will appear in each column of a financial report.

Use FR Paste to create formulas
Each of the above functions can be pasted into a financial statement
using the FR Paste command on the FR menu bar in Financial Statement
Designer.
The FR Paste command inserts a function into the current cell, and
prompts you for each parameter of the function (so you don't have to
memorize them). See FR Paste.
For a detailed description of each function used by Financial Reporter,
see FR Functions.
See also
FR Paste
Sample Column Specifications
Setting Default Column Specifications
Specifying Columns
Specifying Information for a Single Cell

Specifying Information for One Cell
The Financial Reporter lets you insert account record information or fiscal
set values anywhere on a financial statement using special spreadsheet
functions.

Account information
For example:
FRACCT("ACCTDESC","1000-333")
gets the account description (for example, "Cost of goods sold") from
account 1000-333 and places it in the current cell.
FRAMT("ABALP.1998","1000-333")
gets the actual balance of account 1000-333 for the current fiscal period
for the year 1998.
Note that the easiest way to enter Sage ERP Accpac financial functions
is to use FR Paste.

Specifying the fiscal set
You can specify "PBALP" for provisional balance, "QABALP" for actual
quantity, "QPBALP" for provisional quantity, or (in Sage ERP Accpac 500)
the numbers 2 to 5 for the budget sets (for example, 1BALP or 2BALP).
For Sage ERP Accpac 100, you can specify budget sets 1 and 2; for
Sage ERP Accpac 200, you can specify budget sets 1, 2, and 3.
If BALP is specified without an "A" or "P" prefix for actual or provisional
amounts, it will default to the report setting chosen at print time.

Company information
You can also extract company information for financial reports, as in the
following example:
FR("Coname")
The FR function provides company information from the currently open

company, in this case, the company name, and places it in the cell.

You can create report specs that identify each
item
As you can see from the previous examples, you can construct your
financial statements by placing a Financial Reporter function at each
point where you want to print financial information. However, this is a
time-consuming and rigid way to define your statements.
A better way to create statements is to create a statement specification.
In a specification, you set up default formulas for each column, then
indicate the group of accounts to which the column formulas will apply.
See also
FR Paste
Sample Column Specifications
Setting Default Column Specifications
Specifying Columns

Specifying Information for Columns of a Report
Most values in a financial report depend on both the row and the column
that the value is in.
In the following example, the row defines the account, and the column
defines the kind of information that is taken from the account.
Current
Balance

Last Year
Balance

Petty cash

274.57

358.00

Bank account, US
dollars

8,437.54

5,932.90

Bank account, CAD 4,372.96
dollars

3,665.39

Accounts
Receivable, US

16,948.23

14,875.85

Accounts
Receivable, CAD

11,776.77

8,434.73

You could use ten functions to print the ten numbers shown above on a
financial report. However, building statements cell by cell is timeconsuming, and the resulting statements must be changed every time
you modify your chart of accounts.
For this reason, the Financial Reporter has two separate mechanisms to
make statement specifications more flexible and easier to design:
Default column specifications. Financial Reporter lets you define the
default contents of a column, then use it for any rows you wish until you
change the default.
Single specification lines that apply to ranges of accounts. Financial
Reporter lets you define a report line that applies to a range of accounts.
At print time, the single line will be expanded to as many lines as there
are accounts in the range. In other words, a report that printed the current
balances of all accounts in the general ledger can be defined by a single

line that specifies the range of all accounts.
See also
Consolidating Account Ranges
FR Paste
Sample Column Specifications
Setting Default Column Specifications
Specifying Account Numbers in Formulas and Rows
Specifying Information for a Single Cell

Default Column Specifications
The following lines use default column specifications and specification
lines that apply to a range of accounts. The default specifications are
defined in the first line, then used with a range of accounts in the last line.

Remember that the actual report area starts from column E.

Lines with default column specs start with "\\"
The line starting with two backslashes "\\" in column A contains default
column specifications. These default column specifications are in effect
(can be used) until you define a new set of defaults.
To use the currently defined default column specification, you simply type
a "\" into a cell — as in the last line of the example above.
Note: You can also follow the "\" symbol with "-" or "+" to print the inverse
or the absolute value of the formula result.
Advantages of using default column specifications instead of
individual formulas
Both of the following examples print exactly the same information. The
first example uses a complete formula to get each value; the second
example uses default column specifications and an account reference to
a range of accounts.
For each of the following examples, assume that accounts 1100, 1200,
and 1400 are consecutively numbered accounts in the general ledger.

In the above example, note that you require one formula to print each
piece of information.

To print the current balance of 200 accounts, along with their
descriptions, you would require 400 formulas — and you would have to
change the specification each time you added to the chart of accounts.
In the next example, note these points:
The default column specifications line begins with two backslashes.
The default column specification assigns a particular formula to the "\"
symbol. In our example, the formulas have used only Financial
Reporter functions. Alternatively, you could assign a value to "\" or
make use of spreadsheet functions in your formulas.
Note also that you can follow the "\" symbol with "-" or "+" to print the
inverse or the absolute value of the formula result.
The default column specifications are exactly the same as the
formulas in example one, except that they do not include the account
reference.
When you generate the statement, Financial Reporter inserts the
account references for the line into the default formula.
The account reference is for a range of accounts. The single line in
this example will be expanded to as many lines as there are accounts
in the range.

Using default column specifications to place values in a statement.
This second example also shows how the Financial Reporter lets you
define a report line that applies to a range of accounts. At print time (or
when using FR View in the Financial Statement Designer), the single line
will be expanded to as many lines as there are accounts in the range.
In other words, a report that prints the current balances of all accounts in
the general ledger can be defined by a single line that specifies the range
of all accounts. (Financial Reporter provides a shorthand way to specify
all accounts in the ledger: %%. See Specifying Account Numbers in Formulas and Rows for
details.)
Selection criteria in columns B, C, and D

There is one final point that these examples do not illustrate: columns B,
C, and D may contain selection criteria that affect the range of accounts
and whether the final value will be printed at all.

Adding default information for columns B, C and
D
Look at the following example of default column specifications. Note that
in this case, we are setting up default values for columns B, C, and D, as
well as for the printed columns of the report.
Note also that you do not have to specify a "\" in columns B, C or D to
inherit the defaults. If you want anything but the default values, you must
specify them.

Financial Reporter will evaluate the last line of the above spreadsheet
and perform the following actions:
1.Evaluate all accounts in the account number range specified in row 3
to see that they are type "B" accounts.
2.Get the account balance of each account in the range that is a
balance sheet account.
3.Total the balances — because the "T" code in column D stipulates
that a single total line will be generated from the account range, rather
than one line for each account to list the details.
If you leave column D blank, or specify a "D", Financial Reporter will
list all the details.
4.Check whether the amount in column F is zero (because of the "Z" in
column C). If it is, Financial Reporter will not print the line.
Financial Reporter looks only at the numbers on a line to decide if
zero-suppression should take place, so, in this example, the
description in column E does not affect whether the line is printed.
If you do not want to suppress zeroes on a single line, enter the letter
"N" in column C on the line that you want to print.

For details on specifying selection criteria and suppressing lines, see
also:
Consolidating Account Ranges
Excluding Lines
Specifying Selection Criteria

For details on the Financial Reporter functions, see:
Financial Reporter Functions

Sample Default Column Specifications
This section contains some standard report formats together with the
column specifications that created them.

Example 1: balance this period and last period
This example produces a comparative balance sheet. Column E lists the
current balance, and column F lists the balance in the previous period.

Example 2: this year / last year balances with
percentage of total columns
This example produces a comparative balance sheet with four columns
of data. Column G lists the current balances and column I lists the
balances for the corresponding period in the previous year. Columns H
and J compare each account as a percentage of the totals for the
corresponding year.
Note from the formulas in columns H and J that the range of accounts is
defined in row 3 of the report specification, and the total calculation is in
row 4. Financial Reporter recalculates these cell references for the
generated report.

Example 3: period and year-to-date expenses
This example produces a comparative expense schedule with two
columns of data. Column E lists the expenses this period, and column F
lists the expenses year-to-date.

Example 4: current period and year-to-date
expenses as a percentage of sales
This example produces a comparative expense schedule, with each
current period and year-to-date expense listed as a percentage of sales.
The range of expense accounts is defined in row 13, and uses the default
formulas defined in row 11 of the report specification. The total sales
calculation is in row 9. Financial Reporter recalculates all formula cell
references for the generated report.

Example 5: current period and year-to-date
expenses compared to last year
This example produces a comparative expense schedule with six
columns of data. Column G lists the current period expense and column
H lists the expense for the corresponding period in the previous year.
Columns J and K list the year-to-date expenses, and columns I and L
compare each amount as a percentage of the amount in the previous
year.
Note that the range of expense accounts is defined in row 21 of the
report specification, but the formulas in I18 and L18 reference the default
formula cells which are used in row 21. Financial Reporter recalculates
these cell references for the generated report.

Example 6: side-by-side departmental
statements
This example produces a side-by-side departmental comparative balance
sheet with three columns of data.
The processing order is set in column A to Account order, and column D
indicates that each time the account number changes, the Financial
Reporter should create a new line.
Column E lists the name of each account, column F provides the current
balance of accounts that meet the criterion of department "A," and
column G provides the balance of accounts that meet the criterion of
department "B."

See also
Specifying Account Numbers in Formulas and Rows

Specifying Account Numbers in Formulas and in
Rows
An account number reference specifies the accounts from which you
want to take data.
You can specify:
A single account number
or
A range of account numbers.
You can choose to print a range of information in one of two ways:
consolidated (in a single row)
detailed (one row for each account in the range)
You can use these formulas for account groups:
\\acctgroup (sort by account group)
\\acctgroupsort (account-sorted group)
The rules for specifying an account number reference are the same,
whether the reference is in a function or in column A of a specification
row:
A sample formula that places data from a range of accounts into a
single spreadsheet cell:
=FRAMT("BALP","1200:1500")
A reference in column A of a specification row that indicates which
account data to use for the row (a D or a T in column D will determine
whether each account is listed separately or totaled on a single line):
A
B C D
%-1000~1100
In this example, the "%" sign is a wildcard character that takes the
place of one or more characters. (See Wild-card Characters in Account number
References.)

Use FR Paste
If you cannot remember how to specify accounts and account ranges,
choose FR Paste from the FR menu of Financial Statement Designer. FR
Paste lets you use the Finder and various range fields to specify the
accounts you want. See FR Paste.

Account references affect performance
Remember that Financial Reporter can generate your reports faster when
it doesn't have to perform a lot of extra account lookups. For this reason,
check that the account processing order in the report matches the way
you specify account references. (See Account Ordering, Processing Order, and Account
Segment Ranges.)

Standard account reference notation
These are examples of acceptable account number references. Note,
however, that all of these examples assume that segment 1 is the
account segment and segment 2 is the department segment. See also:
Specifying Ranges of Accounts when the Account Segment is not First in the Account Structure.

100-C

Account 100, department C

100:200

Accounts between 100 and 200, no matter which
department they are in

100-A:200-F|ACCT

Accounts between 100 and 200 in departments
A through F, processed by account segment.

100~200-F

Accounts in department F with an account
segment value between 100 and 200

Account number references can contain the following symbols:
"-" Account segment separator defined in G/L Options. (The hyphen
is the default separator.)
":" Separates account numbers in a range.
"~" Separates segment codes in a segment range.

You can enter account references in any of the following ways:
aaaaaaaa

or aaaa-aaaa

aaaa-A:bbbb-B
aaaa%%

or aaaa:aaaa

aaaa~bbbb-A
aaaa~bbbb
%-aa~ff-% | ACCT
aaaa[ACCT], bbbb~cccc-A[MANU]
aaaa-%, bbbb~cccc-A~B, gggg-D

See also
Account Ordering, Processing Order, and Account Segment Ranges
Specifying Account Structures
Wild-card Characters in Account Code References

Specifying Account Structures
You can restrict account number selection to a particular account
structure.
aaaa[ACCT], bbbb~cccc-A[MANU]
An individual account number and a range of account numbers. The
square brackets indicate the account structure codes used by the
account numbers.

Use FR Paste to specify account numbers
You can paste account numbers into a financial statement using the FR
Paste command, located under FR on the Financial Statement Designer
menu bar.
The FR Paste command displays the Finder, from which you can choose
the account numbers. It then inserts the account numbers into the current
cell, where you can edit them further.
See also
Account Ordering, Processing Order, and Account Segment Ranges
Specifying Account Numbers in Formulas and Rows

Wild-Card Characters in Account Numbers
Note that Financial Reporter allows you to use two wild-card characters
when specifying account numbers:
_ (the underline character, which is a place holder for one character)
% (percent character)
The underline and percent characters are place holders for one or more
characters.
For example, D_6834 specifies all single segment accounts sharing the
same first character (D), followed by one character of any value, and
ending with the same four characters (6834).
FR Paste does not support wildcard characters with the Finder. You must
type in the wildcard characters yourself.

"%%" is not a wild-card character
Although "%%" resembles a wild-card character, it is used in only two
very specific ways:
%% specifies all account numbers in the ledger. (See the "QUIKINC"
and "QUIKBAL" statements that come with General Ledger.)
6000%% specifies all account numbers starting with 6000 — no
matter how many segments they have. (This specification has the
same effect as 6000:6000.)
In the following spreadsheet example, the account number selection is
based solely on the account group specified in column B. The Financial
Reporter will list all Current assets, then all Fixed assets, and, finally, all
Other assets.
A
B
%% ACCTGRPCOD=1
%% ACCTGRPCOD=2
%% ACCTGRPCOD=3
Note: Using "%%" will not be very efficient if the Financial Reporter is

forced to process every account in the ledger to see if it fits the criterion
in column B. The above report should specify account group order.

Don't mix account ranges and wild cards
Note also that you cannot combine account reference ranges with wildcard characters. For example:
A123%:B567% is not allowed.
However, you can combine account references in a list (as shown below).
1000:1099, 1100~1199-B, 1250-A
See also
Account Ordering, Processing Order, and Account Segment Ranges
Specifying Account Numbers in Formulas and Rows

Calculated Columns
Calculated columns contain figures resulting from calculations on data in
other columns of the statement. To define a calculated column, use
standard spreadsheet formulas in the default column specification row.
For example:
Current
Balance

Last Year
Balance

Curr/
LYear

358.00

.77

Bank account, 8,437.54
US dollars

5,932.90

1.42

Bank account, 4,372.96
CAD dollars
13,085.07
Total:

3,665.39

1.19

9,956.29

1.31

Petty cash

274.57

In this statement, the default formula for the last column (column H on a
report specification) is "=(F1/G1)". The formula states that this column
contains the value of column F divided by column G.

When the report is generated, Financial Reporter adjusts the relative cell
references on each line.

Using Currency Exchange Rates in Column
Calculations
The Financial Reporter also provides access to the exchange rates kept
by Sage ERP Accpac, so you can create financial reports in any currency
you maintain -- using the exchange rates from any fiscal period.
You use the FRRATE function to get exchange rate information. FRRATE

lets you specify a functional currency, a source currency, a rate type, and
a date. From this data, it provides the rate of exchange.
For example,
=FRRATE("USD","JPN","AV",FR("END"))
will return the average rate in effect for converting Japanese Yen to US
dollars at the end of the fiscal period for which the report is being printed.
A ledger which used the Yen as functional currency could report its
earnings in US dollars with the following formula in the US dollars column
(assume that Yen are reported in cell F9, and that the rate is a multiplier):
=(F9*FRRATE("USD","JPN","AV",FR("END")))
The FR function in the above examples is used instead of a date, to allow
the rate to match the period for the report.
If no date is specified (the date is an optional parameter), Financial
Reporter will use the period-end date for the default fiscal period of the
report. If there is no period-end date (this is possible if you open a sheet
with formulas that has no specification), the program will use the session
date.

Exchange rate is expressed as a multiplier
Note that the rate returned by the FRRATE function is always used as a
multiplier to convert source currency to functional even if you defined the
rate as a divisor.
If the rate is defined in the System Manager as a divisor, Financial
Reporter returns the reciprocal of the rate.

Totaling and Subtotaling Columns
Financial statements contain columns of figures which are subtotaled and
totaled according to account type. The most common arithmetical
operation involves summing the balances or net changes of groups of
accounts at a particular moment in time -- as in the following example:
Current
Balance

Last Year
Balance

Petty cash

274.57

358.00

Bank account, US
dollars

8,437.54

5,932.90

Bank account, CAD
dollars

4,372.96

3,665.39

Total:

13,085.07 9,956.29

If this was a spreadsheet, you would place a formula in each of the "total"
cells that looked something like this:
=SUM(B3:B5)
This formula would add together the values in cells B3, B4 and B5, and
put the total in B6 -- the total cell.
Totaling a column of figures with Financial Reporter is just as easy. All
you do is refer to the cells or range of cells in the specification, and the
Financial Reporter will translate the cell references in the final report. You
may refer to a single cell, a list of cells, or a cell range.
Look at the following example:

In the above example, the formula =SUM(F3) will be translated when you
generate the report to the appropriate range of cells in the Report range

to add the balances of all accounts in the range 1100 to 1300.
In summary, to perform any mathematical operations within the financial
report, use standard spreadsheet formulas and functions.

Handling Rounding on Balance Sheets
If you've spent much time working with financial statements, you'll know
that balance sheets don't balance when you round account totals. You
always have to force a balance by adding a rounding difference to one of
your accounts or account sections.
The next two spreadsheet examples show two ways to ensure that your
balance sheets will balance:
Example 1 shows a simple mechanism that rounds all balances on
the statement, then forces the totals of rounded assets to balance
rounded liabilities.
Example 2 produces a more theoretically correct balance by summing
all unrounded account balances, then forcing the statement to
balance to this sum.
Example 2 makes use of a hidden column of unrounded account data,
and so will require a larger spreadsheet and more memory to run.

Example 1: Forcing a Rounded Balance Sheet to
Balance
This sample statement rounds and sums all printed figures on each side
of the balance sheet, then forces liabilities and owner equity to balance
with the assets. Any rounding differences are lumped with owner equity.
The specification for the statement includes a few rows that must be
hidden before generating the final report (row 11 and row 14).

The specification listed above performs the following actions:
1.Prints the rounded balances of all asset accounts it retrieves from the
general ledger using "=ROUND(FRAMT("BALP"),-3)."
The "-3" indicates the number of digits to the left of the decimal place
to which the value is rounded -- in this case, thousands.
Because "D" is specified in column D, each account is printed on a
separate line. (This is on row 5.)
2.Totals the rounded balances of all asset accounts. (Row 6.)
3.Prints the rounded balances of all liability accounts it retrieves from
the general ledger using the same formula. Again, each account is
printed on a separate line. (Row 9.)
4.Totals the rounded balances of all liability accounts. (Row 10.)
5.Retrieves a single balance for equity. This amount is calculated on a
hidden row, because the difference between the rounded assets and
the rounded liabilities plus equity will be added to the equity section.
(Row 11.)
6.Calculates the difference between the balances. (Row 14.)
7.Sums the difference between the balances and the equity amount.
(Row 12.)
8.Plugs in the balance for total liabilities and equity. Since this balance
must match assets, the specification uses the same total. (Row 13.)

This specification assumes no missing accounts
Note that if any accounts are missing from this statement, it will still
balance (because we have forced a balance between the assets and the
liabilities plus equity).

Example 2: forcing a balance to the rounded
total of unrounded account balances
The following statement example shows another way to set up a
rounding mechanism in balance sheets to handle rounding differences.
This method has two main advantages over example 1, above:
It more accurately reflects an unrounded balance sheet, because the
final balance is derived by summing unrounded balances instead of
by summing rounded ones.
It is self-auditing.
In example 1, you are forcing assets to balance liabilities and equity,
so even if you leave accounts off the statement, the report will
balance.
In example 2, the rounded statement won't balance if you leave out an
account.
Before generating the final report, you have to hide column F, as well as
rows 6, 9, and 10. (See the final report example, below.)
The rows are hidden with the Format, Row Height command. The column
is hidden with the Format, Column Width command.

The specification listed above performs the following actions:

1.Inserts the unrounded balances of all accounts in column F of the
spreadsheet, and inserts the rounded balances of all accounts in
column G.
2.Calculates a rounded sum of column F (in G8) and column G (in G9)
of the spreadsheet.
Note that the rounded total to which we want to balance is the total in
G8. The total in G9 contains the cumulative effect of all rounding
differences.
3.Calculates the difference between the rounded totals (G8 and G9) in
G10 of the spreadsheet.
4.Lumps the difference between the totals into the last range of
accounts (in row 7 of the spreadsheet).
By lumping the rounding difference with the last group of figures,
we've forced the figures in column G to equal the total in G8.
You must also handle liabilities and equity
You handle the credit side of balance sheet similarly, summing all
liabilities with owner equity, then deciding where you want to put the
difference between the sums of the rounded and unrounded balances.
The generated statement includes lines and columns that would be
hidden on the final report (shown in bold):
Description
Cash
Receivables
Fixed assets
Total assets:

37657.35
89576.73
356526.85

Current
Balance
38,000
90,000
357,000
356,000
484,000
485,000
(1,000)

Overriding Print Range Options within a Report
Financial Reporter selects which account data is to appear in a financial
report by evaluating three separate account number filters:
The account number reference in column A of the report line.
The account filtering expression in column B (if there is one).
The print range options for the entire report.
Normally, an account has to satisfy the requirements of all three filters in
order to be included in the report. However, the Financial Reporter also
provides a mechanism for specifying a report range — and including
accounts which lie outside that range.

Specifying a particular segment to override a
segment range
You can override a segment range specified in the Print Financial
Statements dialog box by including the particular segment values you
want on the line in the column A account number reference.
For example, if you want to compare the performance of each
department to the total sales for the organization, you can specify the
total organization's sales on a line like this:
4000~4999-A, 4000~4999-B, 4000~4999-C, 4000~4999-D
Then print reports specifying a segment range of A, of B, etc.

Using the "$" prefix for account number
references
The "$" prefix turns off report-level account range filtering for the
particular account number reference.
If you use the "$" prefix, any account numbers that match the account
reference you specify and match the selection criteria in column B will
appear on the report, regardless of the restrictions imposed by the
Financial Reporter print dialog box.

You can use "$" with "%%"
You can also use the "$" prefix with "%%" to include any account in the
ledger allowed by the criteria in column B for the row. ("%%" is an
account number reference that includes all accounts, no matter what their
account structure.)
See also
Account Ordering, Processing Order, and Account Segment Ranges
Specifying Account Numbers in Formulas and Rows

Selection Criteria for Filtering Accounts
The easiest way to define the selection criteria is to use FR Paste.
You can include selection criteria:
In column B of a specification to restrict the accounts selected from
the Account Code reference specified in column A.
If you enter a criteria on a default line, it is used for all subsequent
lines that do not have a criteria defined for them. In other words, if you
do not want the default expression on a particular line, you must
override it.
You do not need to specify a "\" on lines for which you wish to use the
default selection criteria.
In formulas that use FRAMT, FRAMTA, FRCREDIT, FRDEBIT,
FRTRN, FRTRNA, FRTRNCR, and FRTRNDR functions to retrieve
account balances, net amounts and quantities from posted
transactions, or net amounts from the general ledger.
Don't use selection criteria if you can achieve the same result with a
more selective account number reference.
Financial Reporter performs all account lookups for a line or function,
then eliminates accounts on the basis of criteria. You can improve report
performance best by restricting the number of initial lookups.
Example of a selection criteria expression:
ACCTTYPE = "B" AND ACTIVESW = "ACTIVE"
This expression selects all accounts with an account type of "B" (for
balance sheet) and an active switch set to "ACTIVE".
"AND" means that the accounts must meet both criteria. "OR" means
they can meet either one.

Using FR Paste to build selection criteria
expressions
Selection criteria expressions can be built using the FR Paste command

on the Financial Statement Designer menu bar (under FR). See FR Paste.
The FR Paste command first lets you choose what you want to paste: an
account number, a function, or a selection criteria expression.
If you paste the expression into a formula, the selection criteria acts on
the formula only. If you paste the expression into column B of a statement
line, the selection criteria further refines the account number reference
specified for the current line.
See also
Syntax for Selection Criteria Expressions
Account Master Fields

Syntax for Selection Criteria Expressions
The easiest way to create a selection criteria expression is to use the FR
Paste function on the Financial Statement Designer menu bar. See FR
Paste.
However, you can also enter expressions directly into spreadsheet cells
by using the guidelines listed below.
The format of the expression is:
expression ::= [(...] condition [)...] [Boolean-operator [(...] condition
[)...]...]
where:
condition ::= field-name relational-operator operand
Boolean-operator ::= AND | OR
operand ::= <field-name | constant>
relational-operator ::= > | < | = | <= | >= | != | LIKE
Hence expressions would be along the lines of:
ACCTTYPE = "I" AND QTYSW = "Yes" OR ACCTDESC LIKE
"%sale%"
ACCTTYPE and QTYSW (quantities switch) are fields in the account
master file. All other fields in this file are listed in the next section.
Selection criteria use account master fields only.
Use brackets to force evaluation sequence
Spaces separate parts of the expression
LIKE
Criteria are text parameters

Account Master Fields
You can use a selection criteria expression with any of the fields in the
general ledger account master (listed below).
Note that you must enclose field values in quotation marks if the field
value is text, and it is best to enclose values in a second set of quotation
marks if the text contains a space.
For example:
ACCTDESC = ""Accounts Receivable%""
Note also that many of the values can be expressed in more than one
way.
For example, the quantity switch can be 1 or "Yes" if the account keeps
quantities, or 0 or "No" if it does not. A criteria expression for this field can
look like either of the following:
QTYSW = 1
QTYSW = "Yes"
FR Paste will always supply the text value of G/L account master fields
("Yes" in the above example). If you want to see the non-text values and
the text values of these fields, see the Object Information for the
GLACCOUNT view in the Macro Editor.
The following table shows the G/L account data field names:
Name

Contents of the field

ACCTID

Account number, including all
segments.

Date the account was created.
CREATEDATE Dates are specified as
"yyyymmdd".
ACCTDESC

Account description.

ACCTTYPE

Account type I, B or R for income
statement, balance sheet, or
retained earnings account.
1 for normal debit; 2 for normal

ACCTBAL

credit.

ACTIVESW

"ACTIVE" or "INACTIVE".

CONSLDSW

"Do not consolidate journals" or 0 if
transactions are not consolidated;
"Consolidate journals" or 1 if
transactions are consolidated on
posting

QTYSW

"Yes" or 1 if quantities are used
with account; "No" or 0 if not.

UOM

The unit of measure if quantities
are used.

ALLOCSW

If account can be reallocated:
"Yes" or 1 is yes; "No" or 0 is no.

ACCTOFSET

Account number for reallocation.

ACCTSRTV

Allocation transaction source code.

MCSW

Multicurrency switch: "Yes" or 1 is
yes; "No" or 0 is no.

SPECSW

If posting is in all or specific source
currencies. "All currency" or 1 is all;
"Specific curency" or 0 is specified.

ACCTGRPCOD Account group code.
If account is a control account.
CTRLACCTSW "Control account" or 1 is yes; "Non
control account" or 0 is no.
SRCELDGID

Source ledger if control account
(e.g. AR, AP). (Reserved field)

ALLOCTOT

Total of different allocation rates
(100).

ABRKID

Account structure code.

YRACCTCLOS Year of the last close.

The account segment by which the
POSTOSEGID account is closed.
DEFCURNCOD

Default currency code for the
account.

ACCTFMTTD

Formatted account number.

ACSEGVALn

Account segment value 01 to 10.

ACCTSEGVAL Account Segment Code
Account group COPY. A copy of
ACCTGRPCPY the group code that is a string
instead of an integer.
ROLLUPSW

Rollup switch. If unformatted, 1 if
account is a rollup account, 0 if
not. If formatted, "Yes" or "No".

To retrieve account optional fields, add the prefix A before a field name
(for example, A.ACCTID). Be sure to include the period after the prefix.
See also
Transaction Fields

Transaction Fields
Transaction fields include account master fields and account optional fields defined in G/L
Setup, and the following transaction fields and transaction optional fields
defined in FRPOST:
Name

Contents of the Field

FISCALYR

Fiscal Year

FISCALPERD

Fiscal Period

SRCECURN

Source Currency Code

SRCELEDGER Source Ledger Code
SRCETYPE

Source Type

POSTINGSEQ Posting Sequence Number
CNTDETAIL

Detail Count

JRNLDATE

Journal Date

BATCHNBR

Batch Number

ENTRYNBR

Journal Entry Number

TRANSNBR

Journal Transaction Number

CONSOLIDAT Consolidation in Posting
JUNLDTLDESC Journal Detail Description
JNLDTLREF

Journal Detail Reference

TRANSAMT

Journal Transaction Amount

TRANSQTY

Journal Transaction Quantity

SCURNAMT

Journal Source Amount

RPTAMT

Journal Reporting Amount

RATETYPE

Date of Currency Rate Selected

RATEDATE

Date of Currency Rate

CONVRATE

Currency Rate for Conversion

RATEOPER

Currency Rate Operator

To retrieve account optional fields, add the prefix A before a field name
(for example, A.ACCTID). To retrieve transaction optional fields, add the
prefix T before the field name (for example, T.QTY). Be sure to include
the period after these prefixes.
See also
Account Master Fields

Testing Field Information Before Printing
The Financial Reporter provides several ways that you can test account
information to decide whether it should appear in a report.
Test the contents of the line using a formula in column C. Financial
Reporter lets you specify conditions for excluding generated lines from a
report based on the contents of the line. See the next section for details
on using selection criteria in column C of a financial report.
Use FR functions with spreadsheet functions. Financial Reporter
functions can replace parameters of spreadsheet functions, and vice
versa, so you can test the contents of fields before printing the report, or
manipulate them as you wish.
For example, you can include formulas like this in Financial Reporter
cells (where the balance is printed only if it exceeds 6000; otherwise, the
program reports a 0 amount):
=IF(FRAMT("BALP","1000")>6000,FRAMT("BALP","1000"),0)
or ones like this example (which prints the average value of the two
accounts):
=AVERAGE(FRAMT("BALP","1000"),FRAMT("BALP","2000"))
See also
Excluding Lines from Reports Based on Contents

Excluding Lines from Reports Based on Contents
Financial Reporter lets you specify conditions for excluding generated
lines from a report based on the contents of the line. You define the
criteria for excluding a report line by adding a formula to column C of the
line.
Suppressing lines that have zero values
To specify zero line suppression, you enter the letter Z in column C.
Financial Reporter will check all report columns to see if the values are
zeros. If all values are zero, Financial Reporter will not print the line.
If you do not want to suppress zeros on a single line, but you specified Z
in the default specification, enter the letter N in column C of the line you
want printed.
If the formula = True, the line will not be printed
Alternatively, you can place a logical value formula (TRUE/FALSE) in
column C. If the formula in column C returns a TRUE, the Financial
Reporter will not print the line. If the formula returns FALSE, the line will
be printed.
Let's look at another example:
=G12 < F12

10%

will check if the value in column F is less than 10% of the value in column
G. Again, if the statement is TRUE, the line will be omitted from the
report.
Default line
Note that anything that appears in column C on a default specification
line will be used by all subsequent lines unless you specifically override
it.
See also
Testing Information Before Printing

Account Ordering, Processing Order, and Account
Segment Ranges
The Financial Reporter will list ranges of accounts in the order set in the
financial report specification or (if not set in the specification) in the order
chosen at print time in the Financial Statements print dialog box.
You can sort accounts by any account segments, and you can specify a
range of values for each segment you sort by. You can also sort by
account group, using the formula \\acctgroup or by account-sorted group,
using the formula \\acctgroupsort.
For example, if your accounts have two segments, the following account
reference will generate two possible account listings, depending on the
sort order you specify:
100~120-A~B
If the accounts are sorted by segment 1, the above reference will
generate a series of lines like this:
100-A
100-B
120-A
120-B
However, if the accounts are sorted by segment 2, they will be listed like
this:
100-A
120-A
100-B
120-B

Order is specified on the print/preview
statements screen
The default order for processing accounts is the order specified at print
time on the Financial Statements screen (or the FR View screen when
editing specifications).

Specifying account order in the default row

specification
You can also enforce the order of processing accounts in ranges for all or
part of a report by specifying the order in the first column of the default
row specification (immediately after the backslashes "\\").
You may process account numbers in any of the following orders:
\\ACCTIDAccount number order
\\ACCTAccount segment order
\\ACCTGROUPAccount group order
\\ACSEGVALnAccount segment #n order
\\Segment_descto list accounts by the segment with description
Segment_desc. For example, "\\REGION"

Affects print order and processing speed
The order you specify has two separate affects. It determines:
The order in which accounts in expanded account references are
printed.
The ease (and, consequently, the speed) with which the accounts can
be retrieved by the Financial Reporter.
In the following example, account numbers have two segments: a
department segment and an account segment. The department segment
is first (not recommended), and there are only two department codes in
the ledger, but a large number of accounts. The first account segment in
the ledger is 1000.
If the Financial Reporter processes accounts in order by the account
segment, it will only have to process accounts 1000 through 1100
(specified like this).
A
B C D
\\ACCT
%-1000~1100
The accounts will appear in the following order on the report (by account
segment, then by department):
A-1000

B-1000
A-1100
B-1100
If, on the other hand, the Financial Reporter processes accounts in
account number order (which lists the department segment first) it will
have to scan each account in the ledger to see if it matches the range.
A
B C D
\\ACCTID
%-1000~1100
The final report will also be in account number order, which, in this case,
will be in department order for the indicated range.
A-1000
A-1100
B-1000
B-1100
Note that the order of segments in an account number is defined by the
account's structure code -- not by the order of segments shown in the G/L
Options form.
Consequently, if you have different structures that have different first
segments, ACCTID order will produce odd results, and you should order
accounts by a particular segment or by account group.
If you choose to print by the account segment, the order for processing is
first by that account segment, and second by the complete account
number (as defined by its structure).
If you print by the account group code, the order is first by account group,
second by account segment code, and third by account number.
The default sort order remains in effect until you specify another sort
order, or unless it is overridden in a specific account reference (see the
next section).

Specifying account order for one account
reference

Finally, you can choose to process a single account reference in a
different order than indicated by a default row specification or by the
report options on the Financial Statements screen.
You specify a processing order for an account reference by placing it
immediately after the account reference:
Account reference | Order
Note the following examples. For information on specifying account
references, see Specifying Account Numbers in Formulas and Rows.
1000-% | ACCTuses account order, so processes only account 1000.
Segment 2 will appear in any order.
1000-% | ACSEGVAL2uses segment 2 order, so will scan all account
numbers. However, segment 2 will be in order.
1000:3000[REGION] | ACCTIDuses account number order for
accounts that use the REGION account structure. Will
only process particular accounts in the range.
Note: If the account reference specifies a range using the symbol ":", this
reference will be processed in account number order unless you set an
order for the referece using the "|" (no matter what order is set in the Print
dialog box or in the default row specification).
As you can see from these examples, you can affect the efficiency of the
Financial Reporter by the way you reference accounts.

Using Column D to Consolidate Account Ranges
The Financial Reporter lets you perform two operations on a group of
accounts that are extremely useful:
Consolidate all the lines of an account range instead of printing out
the details.
Print subtotals for groups of accounts according to changes in
particular account segments.

Consolidating account ranges and summarizing
by account segment code
Financial Reporter gives you the choice of generating separate lines for
each account in an account range, consolidating the account reference in
a single line, consolidating account data by account group, or
consolidating the account data by account segment code.
You specify this choice in column D of a report specification. In addition,
you can use the column D setting to override the account order
processing on a line-by-line basis.
Column D can have the following values:
D (for detail) to print one line for each account number.
RD (for rollup account detail) to print all the top-level rollup details as
well as accounts not in rollup groups.
T (for total) to consolidate the data.
D(ACCT)to consolidate by the account segment code (setting the
account number sorting order to account segment order for
this single account reference).
D(AcctGroup)to consolidate by the account group.
D(ACSEGVALn)to consolidate by account segment number n.
D(AcctSegID)to consolidate by the named account segment. For
example, D(REGION).
In each case where consolidation is performed on the basis of a property

of the account number, Financial Reporter processes the account
number in the order required for consolidation. (For example, if
consolidation is by account group, the account numbers will be
processed in account group order.)

Default specification line
Note that anything that appears in column D on a default specification
line will be used by all subsequent lines unless you specifically override
it.

Examples of "T" and "D" consolidation settings
The following examples show the effect of "T" and "D" settings in column
D of a report specification:

"D" prints out all accounts
The above specification contains a "D" in column D. The resulting report
lists each of the accounts between 1100 and 1200 on separate lines.
Current
Balance
Petty cash

274.57

Bank account

8,437.54

Bank account, CAD
dollars
Total:

4,372.96
13,085.07

In the second example, the "T" in column D indicates that all accounts in
the range are consolidated.

"T" consolidates all accounts
The above specification contains a "T" in column D. The resulting report
totals the balances of all the accounts between 1100 and 1200, and
reports the total on a single line.
Current
Balance
Liquid assets

13,085.07

Example of the D(ACCT) account order override
In this example, the "D(ACCT)" in column D indicates that all accounts in
the range are to be listed in account segment order and consolidated by
the account segment.

Current
Balance
Petty cash
Bank account
Total:

274.57
12,810.50
13,085.07

Two lines are printed in the above example, because there are two
account numbers with an account segment code between 1100 and
1200.
The first account segment code (1100) is for petty cash, and the second
account segment code (1200) is for Bank Accounts. Two separate
account numbers have an account segment code of 1200, but these two
accounts (shown in the previous example) have been consolidated.
The "D(ACCT)" code summarizes by account segment code all other
segments that happen to be within the ranges specified when printing the
report.

For subsequent rows, the order will revert to the order that was in effect
prior to this specification row.
See also
Using Column D to consolidate by transaction details

Financial Reports
Sage ERP Accpac's Financial Reporter is a powerful tool that uses
Microsoft Excel to manipulate, format, graph, and print general ledger
data.
Financial reports are printed like other Sage ERP Accpac reports. You
open the print form, choose the report you wish to print and choose from
a number of print options. (See Print Financial Statements.)

Report information
Financial statements can include as many columns of data as you wish,
and can contain any of the following account information:
Current or historical balances for any range of accounts.
Net changes for a fiscal period, quarter, half-year or year.
Balances or net changes in the functional currency or any of the
source currencies in a multicurrency ledger.
Comparative figures from complete or to-date time spans.
Budget figures from up to five fiscal sets.
You can also use any of the following information in a financial statement:
Company information such as the name, address, phone number, and
company contact.
The starting and ending dates of a given fiscal period.
The exchange rate entered for a particular currency, rate type,
functional currency, and date.
The options selected for printing the financial statement, such as the
print date, the department range, and the period-end date. You can
also include provisionally posted transactions, and rollup amounts.

Standard reports
General Ledger comes with the following standard financial statements,
which you can use as is or modify to suit your requirements:

Balance Sheet statements
Balance Sheet summaries
Financial Analysis statements
Financial Forecasting statements
Income Statements
Income Statement summaries

See also
Consolidating Financial Statements of Multiple Companies in Microsoft Excel
General Ledger reports

FR View
The FR View command is part of the Financial Statement Designer. You
use it to test financial statement specifications.
FR View is on the FR Menu in the Financial Statement Designer (Excel).
When you select FR View, it displays a dialog box from which you can
choose various report generation options.
For information on report generation options, select one of the keywords
listed below:
Fiscal Option
Report Type
Report As
Include
Sort by
Select Accounts

Differences between printing with FR View and
printing from the Print Financial Statements icon
The FR View print form is not identical to the Financial Statements form
which appears when you choose the Print Financial Statements icon.
The FR View differences are as follows:
You can generate an audit information page, account audit
information, and include drilldown information in the first column of the
report. (See Include.)
The audit information page lists information such as the print ranges
and any specified processing order.
You can generate formulas for each value that appears in the report
range instead of the values themselves. (See Include.)
This lets you create a report that you can update simply by
recalculating the spreadsheet. (Note that spreadsheet formulas make
the spreadsheet a lot larger.)
If you create a series of reports by choosing the Separate button,
each report will be created in a separate worksheet in the Excel
workbook. The worksheet names will reflect the segment IDs for each

separate report.
When you print a set of statements using the Print Financial
Statements icon, the program repeats the report generation process
for each account segment. In the Report Designer, you can view all
generated reports.

Keep financial ratios and graphs in a formula
sheet
There are two main advantages of a report that is composed only of
formulas:
1.The report has the same cell references each time you use it.
2.The report area remains intact when you recalculate the report. (If you
generate a report from a specification, the old report is cleared before
the new one is generated.)
Because the spreadsheet remains the same each time you use it, you
can include graphs in your reports and be sure of the data you are
referencing.
The most common type of "formula-only" report is one that keeps
financial ratios.

See also
Printing to a File
Print Preview Command
Grid Lines, Tab Breaks and Other Report Formatting
Copying and pasting text and DDE links
Include (for information on creating "hot-linked" spreadsheets)
Saving Spreadsheets Under Different Names and File Formats
If nothing happens when you choose OK . . .
Troubleshooting
Printing Optional Fields in Financial Reports

Printing Optional Fields in Financial Reports
You can print account optional fields and transaction optional fields detail
using Financial Reporter.
Account optional fields are retrieved using FRACCT.
Transaction optional fields and account optional fields can be
retrieved with FRPOST.
If the result of an FR command is derived from more than one
transaction, the optional fields data can be consolidated for the following
optional field types:
Amount
Integer
Number
For the above optional field types, you can print a consolidated total that
sums up all values from the retrieved optional fields or print the optional
field value of the first retrieved record that has optional field values.
That is:
If the specified field name in the first parameter of the FRACCT or
FRPOST command is one of the optional field types (Amount, Integer,
or Number), and is appended with [U], only the first optional field
value will be reported.
If the specified field name is not appended by anything or is appended
by [C], a consolidated total will be printed.

Fiscal Option
The Financial Reporter lets you choose the year and the fiscal period for
the report. You can print financial reports as of any past period for which
you have data in General Ledger.
See also
Report Type
Report as
Include
Sort by
Select Accounts

Report Type
Financial Reporter allows you to choose between two groups of data:
Actual includes only those amounts which have been permanently
posted to general ledger accounts.
Provisional includes amounts that have been provisionally posted to
general ledger accounts, as well as permanently posted amounts.
Note, however, that this option affects only those formulas that you have
not explicitly set as Actual or Provisional.

Prefix for Net and Bal determine the fiscal set
NET and BAL can have a prefix A, P, Q, QA, QP, 1, 2, 3, 4 or 5 to
indicate Actual, Provisional, Quantity, Actual Quantities, Provisional
Quantities, or any of the five budget sets.
For example, "ABALP" provides the actual balance at the current fiscal
period; "1BALP" provides the balance from budget set 1 for the current
fiscal period; "BALP" will be either the actual balance or the provisional
balance, depending on the report type chosen at print time.
If you don't specify a prefix or if you select Q, the default is either
actual or provisional, depending on the report type.
See also
Fiscal Option
Report as
Include
Sort by
Select Accounts

Report as
You can print a single, consolidated report, or you can print separate
reports for different account number segments.
For example, if one of your account number segments is a department
code, you can print a separate report for each department.
You must choose "Sort by" before you can select Separate
To print separate reports with the Financial Reporter you must print by
any segment of your account numbers (except the account segment). In
other words, if you have three segments in your account numbers,
Region, Department, and Account, you have to sort by the Region
segment or the Department segment before you can choose "Report as
Separate."
To print separate reports by Region and Department, you choose the
Region or Department segment for the Sort by selection, then, in the grid,
choose "Separate" for the other segment.
You can print separate segments using FR View or the Print Financial
Statement icon.
If you use the Print Financial Statements icon, it repeats the report
generation process for each account segment code, printing each
separate report in turn.
In previous versions, if you chose Separate reports in FR View, FR View
generated the last report of the series. For example, if you print by
department, and you specify a range of departments that includes
departments 10, 20 and 30, FR View generated the report for department
30. To generate the report for department 20, you would have to select a
range of departments that starts after department 10.
See also
Fiscal Option
Report Type
Include
Sort by
Select Accounts

Using the Include section of the Financial
Statement Designer
You can include the following four options when printing financial
statements from the G/L Financial Statement Designer (click FR on the
menu bar, then select FR View):
Report Options
Audit Information
Formulas
DrillDown Information
Report Options and Drilldown Information can also be selected when you
open the G/L Print Financial Statements form from the Financial Reporter
folder (in General Ledger on the Sage ERP Accpac desktop).
Note: To select Drilldown Information, you must first choose File or EMail in the Print Destination area of the form.
The recipient of an e-mailed report must be using the same database,
with G/L installed, if they expect to drill down to underlying transactions in
the report.

Report Options
When you chose Report Options in the Include section, the first page of
the report displays the following:
Statement name
Fiscal year and period
Report type (actual or provisional)
Account processing and sorting order
Account selection ranges
This is what the options page looks like on the report:

Company:

Sample Company Ltd.

Date:
11/22/2010 4:41:58
Financial Statement: quikbal1.xls
Report Options:
Year:
Period:
Report Type:
Report As:
Sort by:
From Account
To Account
Account Selections:
From Account
Group
To Account Group
From Account
To Account
From Division
To Division
From Region
To Region

2010
6
Actual
Consolidated
Account Number
[1000]
[ZZZZZZZZZZZZ]

[]
[ZZZZZZZZZZZZ]
[]
[ZZZZ ] - Consolidated
[]
[ZZZ ] - Consolidated
[]
[ZZ] - Consolidated

Audit Information
This option is available only when using FR View in the Financial Report
Designer. When you choose Audit Information, FR View lists the
information from the control information columns of the spreadsheet
(columns A through D), as well as the report columns that are usually
printed.

Formulas
This option is also only available when you use FR View in the Financial
Statement Designer.
Usually, when you generate a report from a financial report specification,

the Financial Reporter performs database lookups and inserts balances
and net amounts from the database into the generated financial report.
However, if you choose Formulas, the Financial Reporter will create a
financial report from the specification with a formula for each general
ledger balance or net that appears in the final report.
You can then update that financial report with current database values by
recalculating the spreadsheet (pressing F9). Manual calculation is set in
Excel.
Hint:To keep the hot-linked spreadsheet, save the file under another
name, then remove the report specification from the renamed
spreadsheet.
Financial Reporter automatically refreshes General Ledger data the next
time you load the hot-linked spreadsheet in the Financial Statement
Designer. The sheet will also be recalculated and printed if you choose
the Print Financial Statements icon.
If you want to change the report, for example, add new accounts in the
chart, you need to regenerate the report to have the changes
incorporated in your statement.
Note:Spreadsheets with formulas are much larger than standard report
specifications — and they are less flexible.
Keep financial ratios in a formula sheet
The most common type of report that is composed only of formulas is
one that keeps financial ratios.
DRILLDOWN INFORMATION
You can include a DrillDown link in a spreadsheet, when using the
transaction functions: FRTRN, FRTRNA, FRTRNCR, FRTRNDR.
NOTE: A spreadsheet containing a large number of drilldown link
comments may not be able to open in FR Excel nor in the regular Excel
program.
See also
Fiscal Option
Report Type

Report as
Sort by
Select Accounts

Sort By
You can order accounts on financial statements by Account Number, by a
particular segment of the Account Number, by the Account Group, or by
Account Group Sort Code. You may then specify a range of the item by
which you are ordering the report.
The sort order you choose at print time will not override account sorting
orders that are specified within the report. If the sorting order is crucial to
the contents of the report, you should built it into the report specification.

The sort order of non-consolidated reports
To print separate reports with the Financial Reporter you must print by
any segment except the account segment. In other words, if you have
three segments in your account numbers, Region, Department, and
Account, you have to sort by the Region segment or the Department
segment before you can choose "Report as Separate."
To print separate reports by Region and Department, you choose either
the Region or Department segment for the Sort by selection, then, under
Select Accounts, choose "Separate" for the other segment.

Sort order affects account ordering and
processing speed
Sorting order affects the order in which accounts within a range will
appear on a financial report, and it affects the report processing
efficiency.
Example 1
If the Account Number reference is %%, and the report prints a separate
line for each account, the order and number of accounts will be totally
determined by the sorting order and range you select at print time.
This is Account Segment order:
A-1000
B-1000
A-1100

B-1100
This is Department Segment order (Account Number order will be the
same):
A-1000
A-1100
B-1000
B-1100
Example 2
The following example is from the Quick Reports that come with the
Financial Reporter. The default specification line sets the processing
order to Account Group, and the details of an expansion in Account
segment order.
The first actual row of the statement retrieves all accounts that are in
account group 1. If the order was not by account group, the program
would have to scan all accounts in the general ledger. This report is more
efficient than that because it uses the group number to look up accounts:
it will stop fetching accounts when the account group changes to "2."

You can set an order for the report and for single account range
references
You can set a report order on the first default specification line of the
report specification, and it will remain in effect until it is replaced by a
subsequent default line (unless it is overridden on a single line of the
report).
See also
Account Ordering and Segment Ranges
Consolidating Account Ranges
Overriding Print Ranges
Using Selection Criteria
Selection Criteria Syntax
Fiscal Option
Report Type
Report as
Include

Select Accounts

Select Accounts
Select Accounts lets you restrict the accounts included on a financial
statement to:
A range of account groups (unless the report is ordered by account
group), and
Ranges of account segment codes (such as a range of departments
and/or range of regions).
Also, it allows you to print separate reports by account number segments.
For example, to print separate reports for each department in each region
of your company, you choose Sort by Region, then in Select Accounts,
choose Report as Separate (by double-clicking Consolidated).
See also
Fiscal Options
Report Type
Report as
Include
Sort by
Print Destination

Print Financial Statements to a File
This option applies only to the Print Financial Statements form.
The Print Financial Statements form allows you to change print
destinations so reports are sent to files or to e-mails instead of to the
printer. You select the print destination on the bottom of the Print
Financial Statements form.
When you use File as the print destination, the Financial Reporter lets
you choose whether to save the file in Excel format or in text format.
Then, it saves all the values in the Print range in that file format.
File naming
When you print to a file, Financial Reporter assigns new filenames that
are based on the original Financial Report spreadsheet name, followed
by a sequence number. For example, if the original spreadsheet was
named BALANCE.XLS, the print file spreadsheet would be named
BALANCE.001 or BALANCE.001.xls, depending on the format you
chose.
Note, however, that if statement printing generates a series of reports (a
departmentalized report, for example), the separate reports will be
numbered BALANCE.001, BALANCE.002, BALANCE.003, etc.
Related topics

Saving In Other Formats (Save-As)
The Financial Statement Designer lets you save the data in your
spreadsheet in a number of other file formats, according to the Excel
spreadsheet program.
See also
Printing to a File
Copying and pasting text and DDE links
Creating "hot linked" spreadsheets

Copying and Pasting Text and DDE Links
You can copy data from your spreadsheet to other programs operating
under Microsoft Windows by using standard Copy and Paste commands.
To copy a group of spreadsheet cells, mark the area you want to copy,
and choose Copy from the Edit menu. Then switch to the program to
which you are pasting (such as a word processor) and choose Paste
from that program's Edit menu.

Using DDE (form's Dynamic Data Exchange)
If the destination program supports DDE, you can paste a link from the
Financial Statement Designer instead of the data itself. In future, you can
then update the destination data by recalculating the Financial Report,
then opening the document (or database) containing the DDE link.
Note: A DDE link is a reference to a specific spreadsheet cell in the
Financial Statement Designer. This procedure works only if the cell usage
stays constant in the financial statement. (In other words, it works best
when you have a statement containing formulas only — not a
specification.)

Print Preview Command
To see how a generated report will appear on the printed page, use
Financial Statement Designer's Print Preview command, located on the
File menu.
Once you have generated the financial report, you can use Financial
Statement Designer's Print Preview command to see how the report will
be printed.
When you leave Print Preview, you can move around both the
specification and the report ranges of the spreadsheet.
To preview a report using the Print Financial Statements form, choose
Preview as the print destination at the bottom of the form.

If Nothing Happens When You Choose OK . . .
If nothing happens when you choose OK from the FR View dialog box,
check whether you have defined a spec range.

To check for ranges
Choose Formula, Define Name from the Financial Statement
Designer menu.
If the name Spec does not appear as one of the names in the
spreadsheet, you must define it.
You must have a Spec range defined before you can generate a report
from a report specification. The Spec range is a named range of
spreadsheet cells that begins with the first row and column of the report
specification, and includes all cells that are part of the specification.
If your spreadsheet has formulas only, and does not have a report
specification, you press F9 to calculate the values of the formulas — you
do not use FR View.

Financial Reporter Troubleshooting
If you have questions about creating, printing, or reading reports, click the
following topics:
How do I create an FR report with drilldown that doesn't show the FR code?
How do I enlarge the Spec range?
How do I exclude accounts from a range in FR?
How do I generate reports from specifications?
How do I turn off the Comment box when drilldown is selected?
How do I print recurring column headings at the top of each financial report page when the report has multiple
pages?
How do I set grid lines and tab breaks?
How do I set the Spec range?
How do I show Constant titles in FR?
What does "Error: Invalid Account Reference in Cell XX" mean?
Why can't I view some account descriptions in financial reports?
Why does the date display in short date format even when the Excel cell format is set to long date format?
Why is the bottom of the report missing when it is printed?

See also
Financial Reporter Error Messages

Grid Lines, Tab Breaks and Other Report
Formatting
You set all formatting for financial reports using the Financial Statement
Designer's format commands.
For example:
To select the character font, bold type, left or right alignment, number
appearance, cell borders and patterns, you use the commands on the
Format menu.
To turn the spreadsheet grid on or off for printing, and turn on or off
the row and column labels, you use the Display command on the
Option menu.
To force a tab breaks in the printed report, use the Set tab Break
command in the corresponding position of the report specification. Set
the tab break in column A of the spreadsheet. (Note that the cell
containing the tab break creates a vertical tab break as well as a
horizontal one.)
All formatting applied to rows or columns in a report specification will also
be applied to the rows and columns of the generated report.
To see the effect of all tab formatting in the Financial Report Designer,
use the Print, Preview command after generating the report with FR
View.

FR Commands on the Financial Statement
Designer Menu Bar
The Financial Reporter has four commands on the FR menu that make it
easier to create and edit Financial Reporter specifications. The
commands are:
FR View

Generates financial statements from report specifications.

Inserts Financial Reporter functions, account numbers, and
selection criteria.
FR Paste

FR Clear

Clears a previously generated financial statement.

Lets you carry forward the opening budget and opening
quantity amounts on a financial statement from the year prior to the
one you are inquiring on.
FR Options

Lets you drilldown to associated transactions after you
generate a financial statement that contains formula for transactions.
FR Drilldown

The FR Help command opens the Financial Statement Designer online Help
page.

FR Paste
In the Statement Designer, FR Paste is on the FR Menu.
FR Paste lets you paste the following items into spreadsheet cells:
Account numbers
Account selection criteria
Rolled Up Amounts

(query-by-example expressions)

(for FRAMT, FRAMTA, FRCREDIT, FRDEBIT only)

Financial Reporter functions:
G/L option & company data, and statement
FR
print options
account data

FRACCT

,

FRAMT FRAMTA

,

fiscal set data

FRCREDIT FRDEBIT

fiscal set data

FRFISCAL

fiscal calendar dates

FRRATE

exchange rates

FRSDESC

segment code descriptions

FRPOST

retrieves G/L posted transaction and
account optional fields details

,

FRTRN FRTRNA

,

FRTRNCR FRTRNDR

retrieves data from transaction details
transaction data for stated fiscal period

When you choose a function, FR Paste displays fields where you
select all the function parameters. For the FRAMT, FRAMTA, FRDEBIT,
FRCREDIT, FRTRN, FRTRNA, FRTRNCR, and FRTRNDR functions,
this includes account numbers, account ranges, selection criteria and
currency type. You can also include defined names as parameters.
If you choose account numbers, you can select individual account
numbers, or choose a range of account numbers.
When you click the Selection Criteria button, FR Paste opens the

form in which you can build an account selection criteria. A selection
criteria expression applies a filter to a given account or account range.
You would normally paste the expression into column B of a statement -immediately to the right of the account number.

Using FR Paste
1.From the FR menu, select FR Paste.
2.In the FR Paste form, choose a function, account reference or
expression from the Function list.
In the bottom left corner of the form, the function builds as you select
options.
3.Select from a list of options for the function, account reference or
expression you have chosen.
Refer to the functions individually for details about each of the option
fields:
FR
FRACCT

,

FRAMT FRAMTA

,

FRCREDIT FRDEBIT
FRFISCAL
FRPOST
FRRATE
FRSDESC

,

FRTRN FRTRNA

,

FRTRNCR FRTRNDR

4.Go to the cell where you want to paste your currently-constructed
function, account number, or expression, by pressing the Next Row,
Prev Row, Next Column or Prev Column button. If you don’t choose
one of these buttons, the function, account number, or expression will
be pasted into the cell listed in the bottom left corner of the form.
5.Click Paste.
For details on using the Finder and on specifying record selection criteria,
see the System Manager Online Help. The record selection dialog box is
the same as the one used by the Finder.

Pasting Single Values and Default Column

Specifications
These are typical single values you will paste in a Financial Report:
Company name
Period-end date (or today's date)
Division or department for which the report is printed
A single account balance
For each of the above items, you will paste a complete formula and will
probably not have to edit the result.

Pasting Column Formulas
If you are pasting a formula to use as a default column specification, do
not enter an account reference (because you will be supplying that in
column A of each line that uses the default column specification).
For example, a single cell has a formula like this:
=FRAMT("BALP","1000")
But a default column formula looks like this:
=FRAMT("BALP").
See also
Function Overview

FR Clear
The FR Clear command deletes the Report range from a specification
spreadsheet.
FR Clear is on the FR Menu.
You don't need to use FR Clear before generating a report with FR View.
You usually use FR Clear before saving a final version of a specification
after developing and testing it.
By clearing the Report range before saving it, you save a much smaller
spreadsheet and one that will take less time to load whenever you print
the financial report.
See also
FR Menu Commands

FR Options
You use the FR Options command to specify whether the opening budget
or opening quantity amounts on a financial statement should be carried
forward from the year prior to the year being inquired.
You choose FR Options from the FR Menu in the Financial Statement
Designer (Excel), then select:
Use Budget Opening Balance — to display the budget amount carried
forward from the previous year.
Use Quantity Opening Balance — to display quantities carried forward
for accounts that use the Maintain Quantities option.
These options are not selected as defaults.
Note that whenever you change one of these options, you will need to
run FR View to update the report.
See also
Printing to a File
Print Preview Command
Grid Lines, tab Breaks and Other Report Formatting
Copying and pasting text and DDE links
Include (for information on creating "hot-linked" spreadsheets)
Saving Spreadsheets Under Different Names and File Formats
If nothing happens when you choose OK . . .
Troubleshooting

FR Drilldown
Using the FR Drilldown command (located on the FR Menu), you can
view original transactions after a report has been generated in the
Financial Statement Designer. (You need to run the FR View function
before you can use FR Drilldown).
Note that FR Drilldown works only with formulas that contain the following
transaction functions:
FRTRN
FRTRNA
FRTRNCR
FRTRNDR
You can see how FR Drilldown works by opening the sample
spreadsheet, quickinc4.xls. Run FR View, right-click on a results cell,
then choose FR Drilldown from the ensuing drop-down menu. (Only
results cells with a red mark in the upper-right corner can be used for
drilldown.) The original transaction details will appear in a separate
window.
Note: The FR Drilldown feature is not available for edited FRTRN,
FRTRNA, FRTRNCR, FRTRNDR commands even though running
FRView will yield the correct amounts. The following are examples of
edited commands:
=FRTRN(“NETP”)+100
=ROUND(FRTRN(“NETP”),0)
To drill down from a transaction in Journal Entry, click the Drilldown
button. This opens the underlying transaction. See Drilldown Button.
A drilldown information option has been added to the G/L Print Financial
Statements form and to FR View so that you can include drilldown
information in generated output. This feature is available when saving the
output in Excel file format or when sending the output to E-mail in Print
Financial Statements. (The recipient of an e-mailed report must be using
the same database, with G/L installed, if they expect to drill down to

underlying transactions in the report.)
Note: A spreadsheet containing a large number of drilldown link
comments may not be able to open in FR Excel nor in the regular Excel
program.

FR
Syntax
FR("option", formatted)
Description
The FR function provides information stored by the Common Services
Company form, the Calendar form, and the G/L Options form.
Arguments
option
The name of a field from the Company Profile, a runtime parameter,
or a print option (listed below).
formatted
Optional. Indicates that the return value should be formatted
according to the presentation defined in the view. The default if
omitted is formatted.
"FORMATTED", "F", or "FMT"
"UNFORMATTED", "U", or "UNFMT"
The Option can be one of the following:

General Ledger Options information
Name
"Orgid"
"Coname"
"Address1"
"Address2"
"Address3"
"Address4"
"City"
"Province"
"State"
"Zip"
"Postal"
"Country"
"Phone"
"Fax"
"Contact"
"FuncCurr"
"RPCurr"

"RPACCT"

Contents of the field
The 6-character organization ID
(e.g. UNICO)
The company name.
The 1st address line.
The 2nd address line.
The 3rd address line.
The 4th address line.
The city.
The province or state.
The province or state.
The zip code or postal code.
The zip code or postal code.
The country.
The phone number.
The fax number.
The ledger contact name.
The ledger functional currency.
The reporting currency code when
the Euro is the functional currency.
The rounding account defined in
G/L Options for the reporting
currency when the Euro is the
functional currency.

Financial Reporter runtime fields
Name
"SessionDate"
"Year"
"Period"

Contents of the field
The date entered at
signon.
The fiscal year.
The fiscal period number.

"Start"
"End"
"QStart"
"QEnd"

"ReportType"

"ReportAs"

"SortBy"

"SortByAcSeg"

"From AcctID"
"To AcctID"
"From AcctGroup"
"To AcctGroup"
"AcSegNamen"

The period start date.
The period end date.
The quarter start date.
The quarter end date.
Unformatted: "1" for actual
and "2" for provisional
report. If formatted, it will
return "Actual" or
"Provisional".
Unformatted: "1" for
consolidated, "2" for
separate. If formatted, it
will return "Consolidated"
or "Separate".
Unformatted: "1" for
Account ID, "2" for
Segment ID, "3" for
Account Group. If
formatted, it will return
"AccountID," “SegmentID,"
or "Account Group."
The number of the
segment (unformatted) or
the name of the segment
(formatted) by which you
are sorting.
The starting AcctId in the
print range.
The ending AcctId in the
print range.
The starting AcctGroup in
the print range.
The ending AcctGroup in
the print range.
The name of the nth acct
segment (e.g. Division or

"AcSegReportAsn"

"FromAcSegn"

"ToAcSegn"

"CurAcSegValn"

"Acctgroupsort"
"acctgroup"

Dept.)
If ReportAs = 2 (separate),
this is the consolidation
setting of the nth segment.
The starting value of the
nth segment in the print
range.
The ending value of the
nth segment in the print
range.
The current value of the
segment for the current
report. This value is only
appropriate when the
report type is separate
(AcSegReportAsn = 2).
Sorting by account-sorted
group.
Sorting by account group.

Examples
This statement Returns this
=FR("CONAME") The Garden Inc.
=FR("END")
4/30/02

Date formats
The date formats in some versions of Excel are set to jj/mmm/aa instead
of dd/mmm/yy if you choose Canada[English] for the country setting in
the Windows Control Panel. If you have problems with dates in your
statements, choose the International icon from the Control Panel, and
select US or Other Country instead of Canada.
See also
FRACCT
FRAMT
FRAMTA

FRCREDIT
FRDEBIT
FRFISCAL
FRPOST
FRRATE
FRSDESC
FRTRN
FRTRNA
FRTRNCR
FRTRNDR

FRACCT
Syntax
FRACCT(fieldname, account reference, criteria, formatted)
Description
The FRACCT function provides account master information stored by the
General Ledger Accounts form, including optional fields.
Arguments
fieldname
The name of a field from the G/L account view.
account reference
The number of the account from which the value of fieldname should
be returned.
criteria
An expression that imposes selection criteria on the accounts. The
account reference and expression together determine which accounts
are included in the calculation.
formatted
Optional. Indicates that the return value should be formatted or
unformatted. The default is "Formatted". If you leave the default, no
indicator appears in the formula. If you clear the default, a "U"
appears in the formula (for "unformatted").
Result
The value of the field specified in the formula. (For special treatment of
the account description for a range of accounts, see "ACCTDESC for a
Range of Accounts," below.)
Examples
This statement

Returns
this
"Cost of

FRACCT("ACCTDESC","1000333")

goods
sold"

FRACCT("QTYSW","1000"Yes"
333","F')
FRACCT("ACCTTYPE",
"Income"
"1000-333","FMT")
FRACCT("A.ACCTCLASS","4000") "Sales"

General Ledger Account Data Field Names
Field names from the General Ledger account view:
Name

Contents of the field

ACCTID

Account number, including all segments.

CREATEDATE

Date the account was created.

ACCTDESC

Account description.

ACCTTYPE

Account type. If unformatted, I, B, or R. If
formatted, "Income," "Balance sheet," or
"Retained earnings."

ACCTBAL

Normal balance. If unformatted, 1 for debit or 2
for normal credit. If formatted, "Debit" or
"Credit."

ACTIVESW

Active switch. If unformatted, 1 for active or 0
for inactive. If formatted, "Active" or "Inactive."

CONSLDSW

Consolidation switch. If unformatted, 1 if
transactions are consolidated on posting; 0 if
they are not. If formatted, "Consolidate journals"
or "Do not consolidate journals."

QTYSW

Quantity switch. If unformatted, 1 if quantities
are used with account; 0 if not. If formatted,
"Yes" or "No."

UOM

The unit of measure if quantities are used.

ALLOCSW

Allocation switch. If unformatted, 1 if account
can be reallocated, 0 if not. If formatted, "Yes"
or "No."

ACCTOFSET

Account number for reallocation.

ACCTSRTY

Allocation transaction source code.

MCSW

Multicurrency switch. If unformatted, 1 if
multicurrency, 0 if not. If formatted, "Yes" or
"No."

SPECSW

Specific source currencies switch. If
unformatted, 0 is in all currencies, 1 is
specified. If formatted, "All currency" or
"Specific currency."

ACCTGRPCOD

Account group code.

CTRLACCTSW

Control account. If formatted, 1 is yes; 0 is no. If
formatted, "Control account" or "Non control
account."

SRCELDGID

Source ledger if control account (e.g. AR, AP).
Reserved field.

ALLOCTOT

Total of different allocation rates.

ABRKID

Account structure code.

YRACCTCLOS

Year of the last close.

ACCTFMTTD

Formatted account number.

ACSEGVALn

Account segment value 01 to 10.

ACCTSEGVAL

Account Segment Code

POSTTOSEGID

The code for the segment by which account
posting is done.

DEFCURNCOD

The code for the default currency.

ACCTGRPSCD

Account Group Sort Code

ROLLUPSW

Rollup switch. If unformatted, 1 if account is a
rollup account, 0 if not. If formatted, "Yes" or
"No".

To retrieve account optional fields, add the prefix "A." before the field
name (include the period).

"ACCTDESC" for a Range of Accounts
Generally, if you specify a range of accounts for a particular statement
line, you will type an account description, rather than use FRACCT.
If, however, you do want FRACCT to retrieve a range description, you
should know what behavior to expect.
The function, FRACCT("ACCTDESC","1000-333:1000-400"), will print a
description that includes all the words common to each account in the
account range.
For example, if the accounts in the range have the following descriptions:
Accounts Receivable: customers
Accounts Receivable: employees
Receivable: over 90 days
The program will print the following word:
Receivable
If you try to print information from a non-existent account, Financial
Reporter will print a hyphen.
See also
FR
FRAMT
FRAMTA
FRCREDIT
FRDEBIT
FRFISCAL
FRPOST
FRRATE
FRSDESC
FRTRN
FRTRNA
FRTRNCR
FRTRNDR

FRAMT
FR Paste form
When you select the FRAMT function from the Function list in the FR
Paste form, the right side of the form shows a set of fields and two
buttons which launch popup dialog windows: Selection Criteria, Currency
Options, and Use Rolled Up Amounts.
You can select an individual account or a range of accounts to apply this
function to. Or, you can build account selection criteria by using the
Selection Criteria popup dialog box to create a filter that will be applied to
an account or account range. The purpose of using a filter is to restrict
data records within an account or account range.
Using the Currency Options popup dialog box, you can select a specific
currency or a currency type, such as home, source, source-equivalent in
functional currency, total functional currency or reporting currency. (The
reporting currency option is only available if you selected the euro as
your functional currency and specified a reporting currency in the
Company Profile form in Common Services.)
By choosing values for the fields related to the FRAMT function, you build
this function according to the following syntax and arguments.
Syntax
FRAMT(field name, account reference, criteria, currency)
Description
The FRAMT function provides monetary, budget and quantity balances
and net amounts from the general ledger accounts.
All amounts provided by FRAMT respect the type of the account. This
means that debit balances in debit accounts and credit balances in credit
accounts are both returned as positive numbers. (Credit balances in debit
accounts and debit balances in credit accounts are returned as negative
numbers.)
FRAMTA differs from FRAMT by returning all debit balances as positive
numbers and all credit balances as negative numbers — for both debit

and credit account types.
Arguments
field name
The name of a field from the general ledger account master with an
optional fiscal designator prefix and optional year suffix.
Prefixes are:

A

to retrieve the rollup amount (must be first
character and can be used in conjunction
with other prefixes)
for actual account set

P

for provisional

Q

for quantities

QA

for actual quantities

QP

for provisional quantities

R

1 to 5 for the budget sets
The year can be a 4-digit year, L1, L2, etc. for the last years, or N1,
N2 for the next years (budgets only). See Field Names.
account reference
A string specifying the account number reference. See Specifying Account
Numbers and Number Ranges.
criteria
A string containing an expression that imposes selection criteria on
the accounts. The account reference and expression together
determine which accounts are included in the calculation. See Using
Selection Criteria.
currency
A string containing the currency reference. A currency reference is on
the form "CCC.T," where CCC is the currency code, and T is "S" for
source currency, "E" is the functional equivalent of the source amount,

and "F" is the functional currency total. (Note: For reporting currency,
the currency reference is simply "CCC," without an extension.)
Result
The total values of fiscal field code from all accounts selected for a given
fiscal set.
If the account does not exist, or if no accounts exist in the specified
range, the Financial Reporter will print a value of 0.
Examples
This statement

Returns this

FRAMT("PBALP.L1","1000-33248"; "DEM.S")

The provisionally-posted balance of
Deutsche Marks (in source currency)
to account 1000-33-248 for the current
period last year.

FRAMT("QBALP","2000")

The quantity balance of the current
period for account 2000

The total actual balance for all
FRAMT("ABAL.1999","1000%%", balance sheet accounts for the year
"(ACCTTYPE="B")")
1999 whose account numbers start
with "1000".
See also
Fiscal Set Field Names
FR
FRACCT
FRAMTA
FRCREDIT
FRDEBIT
FRFISCAL
FRPOST
FRRATE
FRSDESC
FRTRN
FRTRNA
FRTRNCR
FRTRNDR

FRAMTA
Syntax
FRAMTA(field name, account reference, criteria, currency)
For a complete parameter description, see FRAMT.
Description
The FRAMTA function is almost identical to FRAMT: it has the same
parameters as FRAMT, and returns all the same data, including
displaying Use Rolled Up Amounts. However, FRAMTA returns all debit
amounts as positive numbers and all credit amounts as negative
numbers.
By contrast, FRAMT returns debit balances in debit accounts as positive
numbers and credit balances in credit accounts as positive numbers. In
other words, the sign of the number returned by FRAMT depends on the
type of account; whereas, the sign of the number returned by FRAMTA
does not.
The following table illustrates the differences between FRAMT and
FRAMTA.
Command Acct. Type Value FR Display
FRAMT Debit Acct. 100 DR 100
Debit Acct. 100 CR -100
Credit Acct. 100 CR 100
Credit Acct. 100 DR -100
FRAMTA Debit Acct. 100 DR 100
Debit Acct. 100 CR -100
Credit Acct. 100 CR -100
Credit Acct. 100 DR 100
Another way of viewing this is to say that FRAMTA flips the sign of Credit
accounts, allowing you to sum the value of a range in a single account

number reference.
FRAMTA has two main uses:
It provides compatibility with the Financial Reporter in ACCPAC Plus
for DOS.
It lets you sum a range of accounts without worrying about the
account type.
See also
Fiscal Set Field Names
FR
FRACCT
FRAMT
FRCREDIT
FRDEBIT
FRFISCAL
FRPOST
FRRATE
FRSDESC
FRTRN
FRTRNA
FRTRNCR
FRTRNDR

FRCREDIT
Syntax
FRCREDIT(field name, account reference, criteria, currency)
For a complete parameter description, see FRAMT.
Description
This function is the same as FRAMT, except that it includes only those
accounts that have credit amounts — whether or not the account is a DR
or a CR type of account. You can also select Use Rolled Up Amounts.
Use the criteria parameter to restrict this function to CR account types.
In the following table, FRCREDIT returns a blank when the value of a
debit account is zero or a debit amount, but returns a zero when the
value of a credit account is zero.
Command Acct. Type Value FR Display
FRAMT
Credit Acct. 100 CR 100
Credit Acct. 0
Debit Acct. 0

0
0

Debit Acct. 100 CR -100
FRCREDIT Credit Acct. 100 CR 100
0
Credit Acct. 0
Debit Acct. 100 CR 100
Debit Acct. 100 DR blank
See also
Fiscal Set Field Names
FR
FRACCT
FRAMT
FRAMTA
FRDEBIT
FRFISCAL
FRPOST
FRRATE

FRSDESC
FRTRN
FRTRNA
FRTRNCR
FRTRNDR

FRDEBIT
Syntax
FRDEBIT(field name, account reference, criteria, currency)
For a complete parameter description, see FRAMT.
Description
This function is the same as FRAMT, except that it only includes
accounts that have debit amounts (balances or net changes). You can
also select Use Rolled Up Amounts.
Use the criteria parameter to restrict this function to DR account types.
Notice in the following table that FRDEBIT returns a blank when the
value of a credit account is zero or a credit amount, but returns a zero
when the value of a debit account is zero.
Command Acct. Type
FRAMT

Value FR Display
Debit Acct. 100 DR 100
0
Debit Acct. 0
0
Credit Acct. 0
Credit Acct. 100 DR -100

FRCREDIT Debit Acct. 100 DR 100
0
Debit Acct. 0
Credit Acct. 100 DR 100
Credit Acct. 100 CR blank
See also
Fiscal Set Field Names
FR
FRACCT
FRAMT
FRAMTA
FRCREDIT
FRFISCAL
FRPOST
FRRATE

FRSDESC
FRTRN
FRTRNA
FRTRNCR
FRTRNDR

FRSDESC
Syntax
FRSDESC(segment number, segment code)
Description
The FRSDESC function provides the description for a segment code,
given a segment number and segment code.
Arguments
segment number
The segment number is 1 to 10.
Segment code
The code of the given segment (such as "1000" or "WEST").
Results
FRSDESC returns the segment name from the General Ledger segment
codes table. The following examples assume that segment 1 is the
department segment.
Examples
This statement

Returns this

FRSDESC(1,"USEAST")

Eastern
United States

FRSDESC(1,"SALES")

Sales
Department

FRSDESC(1,FR("CurAcSegVal1"))

Sales
Department

See also
FR
FRACCT
FRAMT
FRAMTA
FRCREDIT
FRDEBIT
FRFISCAL

FRPOST
FRRATE
FRTRN
FRTRNA
FRTRNCR
FRTRNDR

FRFISCAL
Description
The FRFISCAL function provides dates from the fiscal calendar (in
Common Services).
Syntax
FRFISCAL(option, fiscal year, fiscal period, formatted)
Arguments
option
The period or quarter date you want. Can be Start, End, QStart, or
QEnd for the starting or ending dates of the period or the quarter the
period is in.
fiscal year
Optional. Assumed to be the current year if not specified. Specify as
YYYY (2008), or N1 or L1.
fiscal period
Optional. Assumed to be the current period if not specified. (This field
is an integer. It is not enclosed in quotation marks.)
formatted
Optional. Indicates whether the date should be formatted or not. The
default if omitted is formatted.
"FORMATTED", "F", or "FMT"
"UNFORMATTED", "U", or "UNFMT"
Results
FRFISCAL returns the date as a string.
Examples
This statement

Returns this

FRFISCAL("Start")

11/01/2009

FRFISCAL("Start","","O","U") 20081101

FRFISCAL("Start","L1",
VALUE(FR("Period")),"F")

11/01/2008

Date formats
The date formats in some versions of Excel are set to jj/mmm/aa instead
of dd/mmm/yy if you choose Canada[English] for the country setting in
the Windows Control Panel. If you have problems with dates in your
statements, choose the International icon from the Control Panel, and
select US or Other Country instead of Canada.
See also
FR
FRACCT
FRAMT
FRAMTA
FRCREDIT
FRDEBIT
FRPOST
FRRATE
FRSDESC
FRTRN
FRTRNA
FRTRNCR
FRTRNDR

FRPOST
The FRPOST function allows you to retrieve detail optional fields from
G/L posted transactions and account optional field data for the account
specified in the transaction record.
Details can be consolidated or not consolidated. That is, if the result of an
FR command (that is, the FRACCT or FRPOST commands) is derived
from more than one transaction, and if these results are from the Integer,
Number, or Amount type optional fields, you can print a consolidated total
that sums up all values from the retrieved optional fields or print the
optional field value of the first retrieved record that has optional field
values. If you do not choose the option to consolidate (that is, when you
clear the default checkmark from the “Consolidate Optional Field” option),
the value of the first retrieved record will be printed.
A consolidated total will be printed if the first parameter is not
appended by anything, or is appended by [C].
Only the first optional field value will be reported when the specified
field name is appended with “[U].”
Syntax
FRPOST(field name, account reference, criteria, formatted)
Arguments
fieldname
The name of a field from the G/L account view.
account reference
A string specifying the account number reference. This can be a
single account or a range of accounts.
criteria
An expression that imposes selection criteria on the accounts. The
account reference and expression together determine the accounts
that will be included in the calculation.
formatted

Optional. Indicates that the return value should be formatted or
unformatted. The default is "Formatted". If you leave the default, no
indicator appears in the formula. If you clear the default, a "U"
appears in the formula (for "unformatted").
Results
FRPOST returns data retrieved from transaction records, G/L account
data from the account specified in the transaction record, transaction
optional fields, as well as G/L account optional fields data from the
account specified in the transaction record.
Examples
This statement
FRPOST("TRANSAMT",
"1000","(POSTINGSEQ =
100)","U")
FRPOST("TRANSAMT",
"1000","(JRNLDATE =
20100110)","U")
FRPOST("ACCTDESC","1000")

FRPOST("T.QTY","4000")

Returns this
Retrieves unformatted
transaction amounts for
Account 1000 that have a
posting sequence number of
100.
Retrieves the unformatted
transaction amount from
Account 1000 from January
10, 2010.
Retrieves the account
description from Account
1000.
Retrieves the transaction
optional value for QTY for
Account 4000 for the inquired
period.

Note that the account number is usually set in Column A, and other
criteria (such as the transaction date), is set in Column B. The above
examples placed account numbers and transaction dates in the formula,
but it is not a requirement.
The FR Post command includes all account record fields defined in
FRACCT, including account optional fields, all transaction optional fields

defined in G/L setup, plus the following transaction fields:

Field Name
FISCALYR
FISCALPERD
SRCECURN
SRCELEDGER
SRCETYPE
POSTINGSEQ
CNTDETAIL
JRNLDATE
BATCHNBR
ENTRYNBR
TRANSNBR
CONSOLIDAT
JNLDTLDESC
JNLDTLREF
TRANSAMT
TRANSQTY
SCURNAMT
RATETYPE
RATEDATE
CONVRATE
RATEOPER
RPTAMT

Meaning
Fiscal Year
Fiscal Period
Source Currency Code
Source Ledger Code
Source Type Code
Posting Sequence Number
Detail Count
Journal Date
Batch Number
Journal Entry Number
Journal Transaction. Number
Consolidation Occurred on Post
Journal Detail Description
Journal Detail Reference
Journal Transaction Amount
(functional amount)
Journal Transaction Quantity
Journal Source Amount
Currency Rate Table Type
Date of Currency Rate Selected
Currency Rate for Conversion
Currency Rate Operator
Report Currency Amount

Account optional fields begin with the prefix A. (Add a period between the
A and the field name, for example, A.ACCTCLASS.) Transaction optional
fields begin with the prefix T. (Add a period between the T and the field
name, for example, T.QUANTITY.)
See also
FRACCT

FRRATE
Syntax
FRRATE(functional currency, source currency, rate type, date, rate
option)
Description
The FRRATE function returns the exchange rate for converting amounts
from the source currency to the functional currency as a multiplier. (In
other words, if the rate is defined as a divisor, ACCPAC provides its
reciprocal.)
Arguments
functional currency
The functional currency code.
source currency
The source currency code.
rate type
The rate type code.
date
Optional. Financial Reporter uses the period-end date of the report
fiscal period if not specified, or it uses the session date if the report is
not generated from a specification (i.e. there is no period-end date).
The date is specified as DATE(YYYY,MM,DD). Note that DATE() is a
spreadsheet function that returns the serial number of the date.
The date formats in some versions of Excel are set to jj/mmm/aa
instead of dd/mmm/yy if you choose Canada[English] for the country
setting in the Windows Control Panel. If you have problems with dates
in your statements, choose the International icon from the Control
Panel, and select US or Other Country instead of Canada.
rate option
Optional. This parameter is only required for handling the exchange

rates which involve euro-member currencies that use the Euro
Conversion Rates table (such as francs or schillings). You do not have
to use it to get exchange rates from the currency rates table.
The rate option lets you choose which portion of the euro-membercurrency to non-euro-currency exchange rate you want to the function
to provide.
RF returns the floating portion of the exchange rate — i.e. the portion
not fixed between the euro and non-euro-member currencies. (RF
returns a "1" if the currencies are euro-member, and the year is
greater or equal to 1999.)
RC returns the composite exchange rate (the effective rate between a
non-euro currency and a euro-member currency). This is the default if
no parameter is specified.
Considerations:
For non-euro currencies, RC will look up the rate in the Currency
Rate table.
If the source currency and functional currency are both euromember currencies, RC will return the rate obtained from the Euro
conversion table.
If the functional currency is the euro, and the source is not a euromember currency, RC will return the effective exchange rate
between the two currencies.
The last example, below, shows the floating exchange component
between the Austrian schilling and the US dollar — which is rate
between the euro and the dollar.
Results
FRRATE returns the exchange rate as a multiplier given the information
you provide.
Examples
This statement

Returns
this

FRRATE("USD","CAD","AV")

.75

FRRATE("USD","CAD","SP",
DATE(2009,10,31))

.75

FRRATE("USD","CAD","SP",
DATEVALUE(FRFISCAL("Start")))

.75

FRRATE("ATS","EUR","AV",
13.760300
DATEVALUE(FRFISCAL("Start")),"RC")
FRRATE("USD","ATS","AV",
.88274
DATEVALUE(FRFISCAL("Start")),"RF")
DATEVALUE is a spreadsheet function that converts a textual
representation of the date to a serial number which FRRATE accepts.
(FRFISCAL provides the date in text format.)
See also
FR
FRACCT
FRAMT
FRAMTA
FRCREDIT
FRDEBIT
FRFISCAL
FRPOST
FRSDESC
FRTRN
FRTRNA
FRTRNCR
FRTRNDR

FRTRN
The FRTRN command retrieves net amounts and net quantities from
posted transactions for the period that you specify. FRTRN provides net
amounts only, it does not calculate balances or include provisionally
posted transactions.
FRTRN formulas are similar to FRAMT, but FRTRN retrieves totals from
transaction history, whereas FRAMT retrieves totals from account history.
Syntax
FRTRN(field name, account reference, criteria, currency)
Description
The FRTRN function provides data from transaction detail records.
Arguments
field name
The name of a field from the General Ledger with an optional fiscal
designator prefix and optional year suffix.
Fiscal designator prefixes are restricted to:
A

for actual account set

Q

for quantities

QA for actual quantities
account reference
A string specifying a single account or a range of accounts. (See
Specifying Account Numbers.)
criteria
A string containing an expression that imposes selection criteria on
the accounts and on transaction fields (for example, optional fields).
The account reference and expression together determine the
accounts that will be included in the calculation. See Using Selection Criteria.

currency
A string containing the currency reference. A currency reference is on
the form "CCC.T," where CCC is the currency code, and T is "S" for
source currency, "E" is the functional equivalent of the source amount,
and "F" is the functional currency total. (Note: For reporting currency,
the currency reference is simply "CCC," without an extension.)
Result
Retrieves net totals, actual values (not provisional values), and summary
totals (by both account and transaction fields).
Examples
This statement

Returns this

FRTRN("NETLQ","1000")

Net transactions for the last
quarter for account 1000.

FRTRN("NET#P","1000")

Net transactions for inquired
period for account 1000.

FRTRN("NETQTD","1000")

Net transactions for the quarter to
date for account 1000.

See also
FRAMT
FRTRNA
FRTRNCR
FRTRNDR

FRTRNA
The FRTRNA command retrieves net amounts and net quantities from
posted transactions for the period that you specify. Like FRAMTA, it
displays debit amounts as positive numbers and credit amounts as
negative numbers. FRTRNA does not calculate balances nor include
provisionally posted transactions.
Syntax
FRTRNA(field name, account reference, criteria, currency)
See also
FRTRN
FRAMTA

FRTRNCR
This function is the same as FRCREDIT. It yields net totals (credit
amounts only) from transactions. Use the criteria parameter to restrict
this function to CR transactions.
Syntax
FRTRNCR(field name, account reference, criteria, currency)
See also
FRTRN
FRCREDIT

FRTRNDR
This function is the same as FRDEBIT, and yields net totals (debit
amounts only) from transactions. Use the criteria parameter to restrict
this function to DR transactions.
Budgets and provisional amounts cannot be retrieved using this
command.
Syntax
FRTRNDR(field name, account reference, criteria, currency)
See also
FRTRN
FRTDEBIT

How do I create an FR report with drilldown that
doesn't show the FR code?
In an environment where multiple users may be accessing Financial
Statement reports, and the report specifications are not to be edited, the
Financial Statement criteria can be removed from the report.
Solution
Remove the FR codes by going through the following steps:
1.Design and save a financial statement using the G/L Statement
Designer.
2.Open Financial Reporter > G/L Print Financial Statements.
3.Select the report you created in step 1.
4.In the upper right hand corner, in the Include section, check Drilldown
Information.
5.Enter the rest of the report criteria (Fiscal Option, Report Type, Sort
By, etc).
6.In the Print Destination section, select File or E-mail.
7.Click Print.
Note: Reports created in this manner must be opened using Statement
Designer. You will not be able to view these reports by accessing
Microsoft Excel directly, as you require the FR Macro loaded. The FR
Macro can only be loaded by accessing Microsoft Excel through the
Statement Designer.
See also
Financial Reporter Troubleshooting
FR Error Messages

Date displays incorrectly in Financial Reporter
Problem
The cell format in Excel has been changed to display long date formats
but dates are still displayed in short style in Financial Reporter.
Date format is a function of Excel. As date formats are displayed as
strings, a formula would be required in Excel to change the format.
Solution
Change the format by using the Excel formula DATEVALUE. Any string
value within the parentheses will be changed to implement the cell format
properties.
Example:
To change date format for session date use the following formula:
=DATEVALUE(FR("SessionDate"))
See also
Financial Reporter Troubleshooting
FR Error Messages

How do I exclude accounts from a range in FR?
You can specify selection criteria on a default specification line, on
individual specification lines, and in formulas. With all these possibilities
for account selection, you must be very clear which criteria are actually in
effect.
Accounts must meet restrictions and criteria specified on the FR
View form
The first restriction you place on account selection is with the FR View
form (or with the Print Financial Statements form). Report-level account
range filtering is in effect for any account reference that specifies a range
of accounts.
Overriding account ranges
You can override FR View form ranges in two ways:
By specifying segment codes that are outside the ranges defined in
the FR View form.
By using the “$” prefix in particular account number references.
Unless you override the FR View form, accounts must both fall within the
specified range and meet other criteria specified on the View form.
Overriding default lines
If you specify any selection criteria in column B of a default specification
line, that criteria is in effect unless you override it.
Overriding line criteria
You can override the criteria on a single line by placing a new criteria
expression in column B. The criteria expression is in effect only for the
line on which you define it. If you specify a criteria for a single formula in
the line, the line criteria is ignored.
See also
Financial Reporter Troubleshooting
FR Error Messages

Why can't I view some account descriptions in
Financial Reports?
Problem
When I use the Financial Reporter module in the General Ledger, I
cannot see some of the account descriptions appearing in my financial
reports.
Solution
Check to see if the individual account descriptions have any common
description, for the accounts that are being consolidated in the report.
You may need to edit their account descriptions in order to have them
print out.
Example:
Account number 6200-100 and 6200-200 are being consolidated into
account 6200.
If the description of account 6200 is "office expense total", 6200-100 is
"office expense Richmond"and 6200-200 is "office expense Toronto",
then the description on the financial report will show as "office expense",
which is the common name for all three accounts.
If account 6200 had a description of "miscellaneous account" instead,
then it would come out as a blank in the financial report as there is
nothing in the description that is common.
See also
Financial Reporter Troubleshooting
FR Error Messages

I Cannot Generate a Report
Problem
Not able to generate a report.
Solution
Before you can generate a report from a report specification, you must
define the Spec range for your spreadsheet.
The Spec range is a named range of spreadsheet cells that begins with
the first row and column of the report specification, and includes all cells
that are part of the specification.
See also
Financial Reporter Troubleshooting
FR Error Messages

Print Financial Statements
The Financial Reporter form contains two Financial Reporter icons:
— lets you select and print financial statements
using a large variety of print options. General Ledger uses Microsoft
Excel to generate and print Financial Statements. You must purchase
Excel separately.
Print Financial Statements

Financial Statement Designer — lets you create, edit and test
financial statement specifications using Microsoft Excel.
For more information on creating and using financial statements, see:
Overview of the Financial Reporter

See also Printing Optional Fields in Financial Reports.

The Print Financial Statements Icon
When you select Print Financial Statements, it displays a form from which
you can choose various report printing options.
For information on particular options, select one of the keywords listed
below:
Fiscal Option
Report Type
Report as
Include
Sort by
Account Selection
Print Destination

See also
Copying and pasting text and DDE links
Differences between printing from the Financial Statement Designer and printing from the Financial Statements icon
Grid Lines, tab breaks and other report formatting
If nothing happens when you choose OK . . .
Print Preview command
Printing to a file
Saving spreadsheets under different names and file formats
Troubleshooting
Using "Include" to create "hot linked" spreadsheets

How do I print recurring column headings on
multiple pages?
Problem
How to print recurring column headings at the top of each financial report
page when the report has multiple pages.
Solution
To print recurring column headings at the top of each page, use title lines.
Title lines begin with a \T in column A of the Spec range.
You can define up to five consecutive title lines.
All title lines must be together; they cannot be separated by a page
break.
If you have defined more than one set of title lines, Financial Reporter
will use the last set in the specification.
See also
Financial Reporter Troubleshooting
FR Error Messages

Why doesn't the bottom of the report print?
Problem
After modifying the report, the report is missing some data. The results
for the newly-added specifications are not displaying.
Solution
After adding new criteria, you must also change the size of the report.
1.Open Financial Report with MS Excel
2.Select Insert, Name, Define, then select "Spec¡± under Name in
Workbook.
3.Change the Refer to from "=Sheet1!$A$1:$J$nnn" and change nnn to
a larger number which meet its spec range.
See also
Financial Reporter Troubleshooting
FR Error Messages

How do I show Constant titles in FR?
For example, how do I show:
"For the Current Quarter To Date Ending: /month/day/year"
and
"For the Previous Quarter To Date Ending: /month/day/year"
Solution
The formulas would be:
="For the Current Quarter To Date Ending: "&TEXT(FRFISCAL("QEnd"),
"mmmm d, yyyy") "and"
="For the Previous Quarter To Date Ending:
"&TEXT(FRFISCAL("QStart")-1, "mmmm d, yyyy")
See also
Financial Reporter Troubleshooting
FR Error Messages

How can I turn off the comment box when
drilldown is selected?
Problem
When FR is run with the Drilldown Information selected, a Comment box
saying "Right-click and choose FR..." will be displayed for every cell that
has drilldown. This can cover the whole spreadsheet if there are many
columns.
Solution
To remove the comment boxes:
1.Select Tools >Options.
2.Select View.
3.In the Comments section, select Comment Indicator Only.
See also
Financial Reporter Troubleshooting
FR Error Messages

"Invalid account reference in cell XX" error occurs
when printing a report
Problem
The following error may occur when defining a range of accounts in
Column A using multiple structure codes, where more than one of these
structures have the same number of segments:
Invalid account reference in cell XX
For example, the criteria in Column A is:
300 ~ 370 - 50010 ~ 99999 - CT ~ PA - 15 ~ 15
The following account structures have been set up in the company:
Structure
Code

Description

Segments Used

ACCT

Balance Sheet Accounts

Account

CCACT

Cost Center - Account Group

Cost Center, Account,
Group

CCLOC

Cost Center - Account Location - Group

Cost Center, Account,
Location, Group

CCTYPE

Cost Center - Account - Type
- Group

Cost Center, Account,
Account Type, Group

Solution
The error message occurs because there is more that one structure code
with same number of segments.
Specify the structure code in the criteria to resolve the problem.
Format the criteria as follow:
aaaa[ ], bbb ~ ccc - A[ ]
Note. The square bracket indicates the structure codes.
The report should now generate without any errors.

Example:
Assume CCLOC is the structure code that you want. Set the criteria in
Column A as:
300 ~ 370 - 50010 ~ 99999 - CT ~ PA - 15 ~ 15[CCLOC]
See also
Financial Reporter Troubleshooting
FR Error Messages

Sage ERP Accpac Training
Become a Sage ERP Accpac expert with online or classroom training
through Sage University.
If you want to get beyond the basics and tap into the full power of your
Sage ERP Accpac system, nothing beats targeted training and
education.
Our training resources include a nationwide network of authorized
classroom training centers, online courses, partners who can conduct onsite training, manuals and guides for your self-study, and an annual
customer conference.
For more information on Sage ERP Accpac training, choose one of the
following links:
Find a Course

Search training courses on the Sage University Web site by product,
type, location, track, schedule—or try our advanced search.
Anytime Interactive

Anytime Interactive training offers a full range of recorded instructor-led
sessions that are easy to use, always accessible, and ready when you
are. All you need is a computer, speakers and a high-speed Internet
connection.
Anytime Interactive sessions are ideal for review material, acquainting
new-hires with basic processing skills, and cross-training staff. Interactive
sessions include product specific instruction and online review quizzes.
Classroom

Instructor-led classroom training provides you with personal interaction in
a professional atmosphere you will enjoy. Classroom training also allows
you the opportunity to become Sage certified.
Classroom training is ideal if you prefer one-on-one assistance,
interaction with other students and a classroom atmosphere.
Lunch & Learn

Lunch & Learns are one-hour Realtime (Online) sessions that cover a

particular topic or process. Each Lunch & Learn is designed to increase
productivity by simply providing you with a stronger understanding of a
specific feature or functionality within the software.
Choose one of our 40+ information packed Lunch & Learn sessions and
become more proficient in just one hour.
Realtime

Realtime training sessions are online, instructor led and scheduled for a
specific date and time. All you need is a computer, phone, and an
Internet connection. Everything happens live, so you can ask questions
and interact with other participants and the instructor.
Realtime combines the interaction of a classroom with the convenience
of staying right where you are.
Realtime sessions include live product specific instruction, electronic or
printed course materials, hands-on exercises, and online review quizzes.

Set Up a New General Ledger
Before you start

To add existing account balances and quantity data to a new
general ledger:
1.Activate your General Ledger, specifying the first full year for which
you want to keep account data, and the current fiscal year. General
Ledger will create fiscal calendars for all years that you want to
contain history.
General Ledger will also set the current fiscal year to the year before
the first full year, so you can enter opening balances for the first year.
Note: The only way to change the current year in G/L is to use Create
New Year. This form closes income and expense accounts to retained
earnings, creates opening balances in the next year, and advances
the current year.
If you do not want to enter previous-years' period balances, you
must enter the previous year's period 12 balances.
2.Start Sage ERP Accpac, using the year-end date of the year before
the earliest fiscal year for which you want to post transactions.
Create a batch with the closing balances of all your general ledger
accounts. Make sure the batch balances, and that the batch matches
your balance sheet for that year, then post the batch.
3.Run Create New Year to create the opening balances for your first full
year of period balances, and to advance the current year.
4.Set the session date for the appropriate fiscal year, and create
separate transaction batches for each of the periods that you want to
contain data. If you want a full year of comparative period balances,
you must create one transaction in each period for each account.
Because you have already entered opening balances, these batches
must contain the net changes for each account (except retained
earnings) in each fiscal period.
Do not enter the closing balance of the retained earnings

account, and do not create a batch for closing income and
expense accounts to retained earnings. You will use General
Ledger's Create New Year form to close each year after you have
posted the year's data.
5.Post all batches. Print the posting journals, and keep them as part of
your audit trail.
6.Print trial balances for each of the periods in the year to which you
posted, and compare balances to those in your current ledger.
7.Use Create New Year from the Periodic Processing form to close the
income statement accounts to retained earnings, and to advance the
current year.
8.Leave General Ledger, then start it again, using the year-end date of
the next year for which you want to enter historical data. Again, post
batches and print trial balances to check the results.
If this is a previous year, again use the Create New Year form to close
the year.
9.Print balance sheets and income statements for all past years, and
compare them to your existing statements.
Note: To use the financial statements shipped with General Ledger
sample data, you must select the Use Account Groups option in the G/L
Options form, and assign each G/L account to a group using the G/L
Accounts form.
For further information on setting up your ledger, please see Setting Up General
Ledger.
Related topics

To Set Up Recurring Entries
To set up recurring entries:
1.Open General Ledger > G/L Setup > Recurring Entries.
Click here for help on fields in this form.

2.In the Recurring Entry Code field, enter a unique code that represents
the type of entry you are creating. Your code can be up to 16
characters long. For example, if you are creating a recurring entry for
processing semi-annual amortization, your code might be AMORT.
3.In the Entry Description field, enter a description of the code, up to 60
characters long. Descriptions help to identify each code.
4.Attach a schedule for your recurring entry by clicking the Finder and
selecting a predefined schedule that appears in the list, if any. Or,
create a schedule for this recurring entry by clicking the Zoom button
located beside the Schedule Code Finder.
5.In the Start Date field, enter the date that the recurring entry for this
transaction begins. General Ledger will check the start date to
determine if the recurring entry should be included in the batch.
6.In the Expiration Type field, select No Expiration Date if you have no
end date in mind for the recurring entry, otherwise, select Specific
Date. When you select Specific Date, another field appears to let you
enter an expiration date.
7.Select the Inactive checkbox to make this entry temporarily inactive.
You can activate it at a later time. Once you change it to active, the
Start Date will be automatically updated to your current session date,
but this date can be modified.
8.Enter a description for the entry (for example, Monthly service
charge).
9.Enter a Source Code, or use the Finder to select it.
10.Select Auto Reverse if you want to reverse the transaction in the next
fiscal period.
11. Select Normal or Quick Entry mode.

12.If you have a multicurrency ledger, from the Exchange Rate dropdown list, choose Use Recurring Entry Rate, or choose Use Current
Rates.
13.Select an account in the Rounding Account field if you selected Use
Current Rates in step 12. The purpose of this field is to specify the
account that any rounding error resulting from conversion at the
current exchange rate is posted to. (You cannot select an account that
has the Post To Account field set as prohibited.)
14.Enter transaction details in the grid by clicking the Detail button and
filling out the following fields:
a.

Enter a Reference.

b.

Enter a Description.

c.

Select an Account, using the Finder.

d.

Use the Calendar icon to select the Date.

e.

Use the Finder to select the Source Code.

f.

Enter an amount in the Source Dedit or Source Crebit fields.

g.

Select the Currency if this is a multicurrency company.

h.

Enter a Comment, if needed.

i.

Repeat these steps to add a balancing entry.

j.

Click Add, then click Close to return to the Recurring Entries form.

15.In the Recurring Entries form, click Add to save a newly-created entry,
or click Save to save changes to a current entry.
16.Click Close to exit the Recurring Entries form.

Add Account Groups
Before you start

To add your own account groups:
1.Open General Ledger > G/L Setup > Account Groups.
2.In the Account Group field, enter up to 12 characters to define the
account group code.
The code can consist of alphabetical or numerical characters, or a
combination of both.
The standard account groups are numbered 01 to 26. You can
continue the sequence, or create a different set of codes.
3.Tab out of the Account Group field.
4.Type a description for the new group.
5.In the Group Category field, select the category to use to classify this
group of accounts in data snapshots.
6.Click Add.
Additional information
Related topics

Add Source Codes
To add source codes:
1.Open General Ledger >G/L Setup > Source Codes.
For help with the fields on the Source Codes form, select from the
keywords listed below:
Source code
Description

2.Click New and type a four-character source code.
The first two characters must identify the source ledger (such as
GL or AR), the second two identify the transaction type.
You can just type the code and press Tab: G/L will assume you
adding a new code.
3.Enter a description for the code.
4.Click Add, or choose Close to leave without adding a source code.
Before deleting a source code
Related topics

Add Segment Codes
Before entering segment codes

To add segment codes:
1.Open G/L Setup > Segment Codes.
For help with fields on this form, click here.
2.Choose the segment from the drop-down box for which you want to
enter valid codes.
a.

If you are entering codes for the first time, click in the empty box
below the segment selection box (or press Tab twice) to insert the
first line in the table.

b.

If editing an existing list of codes, click on the line you wish to
change (use the vertical scroll bar if the record isn't visible), or click
in the table and press the Insert key to add a code.
Note that you cannot delete a segment code that is being used by an
active account.

3.Enter or change the code in the first column (the Segment Code). The
code must be the length you specified for the segment.
4.Press Tab and enter a description.
5.Press Tab again, and, if applicable, enter the account number of the
retained earnings account to which this segment code closes.
If this account has the Post To Account field set as prohibited, you
cannot select that account as the closing account.
6.When you have added all the codes for a segment, use the Save
command.
After adding segment codes
Deleting segment codes
Additional information
Related topics

Add a New Account
Before you start

To add a new account to the General Ledger:
1.Open General Ledger > G/L Accounts > Accounts.
2.Click New, type the new Account number, then press Tab.
You can type account numbers with or without the delimiter character
used to separate account number segments.
3.Enter the Account Description.
4.Fill in the fields on the Detail tab, as described in the next steps.
5.If you have more than one segment in your account numbers, use the
Finder in the Structure Code field to choose the account structure that
matches the segments in the account you are adding.
6.Choose the Normal Balance (Credit or Debit) for this account.
7.Choose the Account Type (Income Statement, Balance Sheet,
Retained Earnings) for this account.
8.If you use account groups, use the Finder to select the Account Group
for this account.
9.In the Post to Account field, choose Detail, Consolidated, or Prohibited. (You
cannot post to a prohibited account.)
10.Choose from the following account options:
a.

If you plan to use optional transaction fields with transactions you post for
this account, specify the optional fields and their default values on
the Trans. Optional Fields tab.

b.

If you use Auto Allocation, select that option, then fill out the required
information on the Allocation tab. (This tab appears only when you
select the Auto Allocation option.) If you want to allocate balances
according to account quantities, you must also choose the Maintain
Quantities option for all accounts associated with the account
allocation, and ensure that they all use the same unit of measure.

c.

If the account is a control account, select the Control Account option,

then specify, on the Subledger tab, the subledgers that use the account .
(The Subledger tab appears only when you select the Control
Account option.)
d.

If the account is a multicurrency account, select the Multicurrency
option. The Currency tab appears. Specify the currencies which can be
posted to the account, and specify whether the account is subject
to revaluation.

e.

Select the Rollup option if you want to designate an account as a
rollup account. You can then add member accounts using the Rollup
tab.

11. When you have added data to the appropriate fields on all the tabs,
click Add, or click Save.
After adding an account
Related topics

Create Accounts Automatically
Before you start

To automatically create accounts:
1.Open General Ledger > G/L Accounts > Create Accounts.
2.Use the Finders in the From Accounts With Structure Code and
Create Accounts With Structure Code fields to select a structure code
on which to base the model accounts.
3.In the Select Account Range area, choose either Account Number,
Account Group, or Sort Code-Account Group using the drop-down
arrow in the Select By field, then enter the ranges in the From and To
fields for that selection.
4.Select Default Subledger Details and Default Currency Details options
(optional).
5.If you want to review existing accounts along with the accounts to be
added, select the option Include Existing Accounts.
6.Use the grid to specify the segments you want to create.
7.Click Preview.
The program displays a message telling you how many preview
accounts it created.
8.Click Close to close the message.
The G/L Create Accounts Preview form appears, letting you:
Change the accounts before you add them. (Note that if your
existing chart of accounts contains no accounts with the required
segments in the specified range, the program will not create any
new accounts.)
Specify optional field information for the accounts to be created.

9.To print the preview information, click Print. The Print Create Accounts
Preview Information form appears.
a.

Choose sorting options and the range of accounts you want to
print. You can sort by Account Number, Segment, or Account

Group.
b.

Select whether you want to print subledger or currency
information.

c.

Click Print.

d.

Click Close to return to the G/L Create Accounts Preview form.

10.When you have finished selecting or adjusting the accounts you want
to create, click Close to return to the G/L Create Accounts form.
In the G/L Create Accounts form, all the fields are now dimmed - you
cannot change them. (However, you can click Preview to return to the
Preview form.)
11. Click Process to add the accounts to your chart of accounts.
If processing is successful, the program creates the accounts,
then displays a message telling you processing has finished and
the number of new accounts that were created.
Click Close to close the message. You then receive a message
asking whether you want to clear the temporary file. You must
clear the preview accounts before you can create another set of
accounts. If you click No, you are returned to the G/L Create
Accounts form, but (as before) all the fields are dimmed.
If there is an error in processing the accounts, you are returned to
the G/L Create Accounts form, but all fields are dimmed. Click
Preview to view and remove any unsuitable accounts, or click
Clear to abort the process. Note that some accounts may have
been added to your Chart of Accounts.
12.Click Clear to delete the temporary file (so that you can create a
different set of accounts in the future).
After creating accounts automatically
Related topics

Add a Rollup Account
Before you start

To select member accounts for a rollup account:
1.Open General Ledger > Accounts.
Click here for help on fields in the G/L Accounts form.

2.Use the Finder in the Account field to select the account you are
designating as a Rollup account.
3.Select the Rollup option on the Detail tab.
4.Click the Rollup tab that appeared when you performed step 3.
5.Click the Finder in the Account column to add individual member
accounts.
Or
To add a range of member accounts, click the Zoom button beside
"Select Member Accounts".
a.

In the G/L Account Selector popup, select the ranges of Account
Numbers, Account Segments, or Account Groups that will be
members of this rollup. You can also use the Account Optional
Fields as a selection criteria.

b.

Select Account Types.
Note: Accounts selected will include only those accounts whose
account types match the Account Types selected here. For
example, if the Income Statement option is not selected, then even
if the Account Number range includes income statement accounts,
those accounts will not be copied into the grid.
You can select criteria based on your segments. Also, an
additional criteria for Account Optional Fields can be used to select
member accounts.

c.

Click the Preview button to view your choices. A message
appears, advising you that processing is completed, and shows
how many Rollup Member(s) were created and can be viewed.
Click Close in the message to move to the G/L Account Selector

Preview window. Each of the accounts in the range you selected
are included in the list. You can double-click in the Add column to
change the entry to No from the default Yes if you decide not to
include some of these accounts.
Note: If the rollup account is single-currency, only single-currency
accounts which meet the G/L Account Selector will be generated in
the Preview window. Accounts that already exist or were already
added in the Rollup grid will not be shown again in the Preview
window.
d.

Click Copy in the G/L Account Selector Preview window. A
message is displayed, showing how many rollup member accounts
were created.

e.

Click Close. You return to the Rollup tab of the G/L Accounts form.
The accounts from the G/L Account Selector Preview window
appear in the grid.

6.Click Save. The accounts in the grid now also appear in the tree.
To delete member accounts from a rollup account
Additional information

Add a Journal Entry
To add an entry:
1.Open General Ledger > G/L Transactions > Journal Entry.
Click here for help on fields in this form.

2.Click the New button beside the Batch field. (General Ledger
automatically provides the next batch number and moves to the Batch
Description field.)
3.Enter a description for the batch.
4.Click the New button beside the Entry Number field. General Ledger
automatically inserts the next entry number.
To edit an existing entry, use the Finder, the navigation buttons, or
type the entry number.
5.Enter a description for the entry.
6.If you use Sage ERP Accpac Intercompany Transactions, use the
Finder in the Originator field to select a company. (Transactions in an
intercompany batch can have different originating companies.) Note
that the Originator field appears only if you install and activate
Intercompany Transactions.
7.Use the Calendar icon to select the date.
8.Select the fiscal year and period of the transaction.
9.Enter the source code for the transaction, or use the Finder to select
it.
General Ledger displays the default source code you chose on the
Posting tab of the Options form, but you can change the code, if
necessary.
10.Select a Normal or Quick entry mode.
This option controls the number of fields visited when you are adding
new transaction details.
11. Select the Auto Reverse option if you want to reverse the transaction
in the next fiscal period.

12.Enter information in the detail grid.
Click the Field List button at the top of this Help page for details about
each field.
Note that you can click the Detail button to open the Journal Detail
form, where you can make additions or edits quickly and easily,
tabbing from field to field, then clicking Close to return to the Journal
Entry form, where these entries now appear.
Additional information
Related topics

Edit a Batch
Before you start

To edit the contents of an existing batch
1.Open General Ledger > G/L Transactions > Journal Entry.
If the Batch List form is open, select the batch from the list and
choose Open (or double-click the entry).
2.Enter the number of the batch you want to edit (or click the Finder
button and select the batch from the list).
After editing a batch
Related topics

Create an Allocation Batch
Before you start

To create an allocation batch:
1.Open General Ledger > G/L Periodic Processing > Create Allocation
Batch.
2.Enter a Batch Description.
3.In the Create Batch For field, use the drop-down arrow to choose the
full account ID or one of the account segments.
4.Specify the range of account numbers or account-number segments.
5.If you use optional fields with your system,

check or change the optional field

information that will be included with the generated transactions.

6.Specify the Journal Entry Date and the fiscal year and period to which
you want to post each entry.
7.In the Allocation Method field, use the drop-down arrow to choose
Account Balance, or Account Quantity, or Both Account Balance and
Quantity.
8.If you selected to allocate accounts by quantity, specify the range of
fiscal periods for determining the net changes in quantity.
9.Click Process to produce the batch (or click Close if you decide not to
produce the batch).
After creating an allocation batch
Additional information

Create a Revaluation Batch
Before you start

To create a batch of revaluation transactions:
1.Open General Ledger > G/L Periodic Processing > Create
Revaluation Batch.
Click here for help on the fields in this form.

2.Type a name for the batch description (such as, Currency devaluation
05/05/2010).
3.Enter or select the source currency that you are revaluing.
4.Select how you are choosing accounts for revaluation (Revalue By).
You can choose accounts by specifying a range of account numbers,
or a range of a particular segment.
5.Select the range of account numbers or segments that you wish to
revalue.
6.If you use optional fields,

check or change the optional fields assigned to the revaluation batch.

7.Select the range of fiscal periods that you want considered for the
revaluation.
8.Select the revaluation code.
9.Enter a date for the journal entry (default is the session date).
10.Enter the exchange rate and date at which account balances will be
revalued.
11. Choose whether or not to force currency revaluation.
12.Enter as many currencies as you need to revalue, then click Process
when ready.
After creating a revaluation batch
Related topics

Post Transaction Batches
Before you start

To post transaction batches:
1.Open General Ledger > G/L Transactions > Post Batches.
You can post all batches or a range of batches.
2.Choose the batches to post by selecting All Batches or Range. (To
post a single batch, enter the same number for the beginning and end
of the range.)
If you do not use the Force Listing of Batches option, you can post
unlisted batches once you select "Ready to Post" on the Batch List
form for each batch.
3.Choose Post to post batches permanently.
Choose Provisional Post to post on a temporary basis.
4.If you decide not to post batches, click Close.
After posting batches
Additional information

Select a Printer for Reports
Sage ERP Accpac lets you choose a default printer for all reports that
you print, as well as assign different printers to specific reports (such as
invoices or labels).
To change the default printer for all reports:
1.Select File > Page Setup.
2.Click the Printer button.
3.From the drop-down list, choose the printer that you want to use.
The printer list includes all printers that have been added to the
Printers and Faxes list in Windows.
4.Click the Properties button to change available settings for your
particular printer.
5.Click OK to close the Properties form.
6.Click OK again to return to the Page Setup form.
7.Click the Print Destination button and check that the print destination
is set to Printer.
If you are using a laser printer, you would normally select the Report
Paper Size and Report Orientation options on the Print Destination
form.
8.Click OK on the Print Destination form, and then click OK on the Page
Setup form.
To assign a specific report to a specific printer:
1.Open the report form which you want to assign to a printer.
2.From the menu on the report form, Select File > Print Setup.
3.Choose whether you want to choose the printer that is set as the
Windows default printer, or choose a specific printer for this report.
Note: By default, the specific printer is the one chosen as the printer
on the Page Setup form selected from the File menu on the Sage
ERP Accpac Desktop.

4.The printer list includes all printers that have been added to the
Printers and Faxes list in Windows.
5.Choose a paper source if you want to select a particular paper tray or
paper stock for this report.
6.Click OK.
To clear the assigned printer for this report
Prompt for printer each time you print
Related topics

Print a Financial Report
1.Open General Ledger > Financial Reporter > Print Financial
Statements.
2.In the Statement Name field, use the Browse button to select the
report (that is, the spreadsheet file) you wish to print.
3.Choose the Year/Period in the Fiscal Option section.
4.Choose a Report Type (Actual or Provisional).
5.Select Separate or Consolidated in the Report As section.
The "Separate" option is available only after you select Segment in
the Sort By area of the form, and then enter the range of segments
(do not choose the Account segment).
6.In the Include area, select Report Options and/or Drilldown
Information options (optional).
Drilldown will only be available when you select File or E-mail as the
Print Destination.
7.In the Sort By area, choose Account Number, Segment, or Account
Group (changes to "Account Sorted Group" when you check the
Select Groups by Sort Code Range option below this list.), then:
If you chose Account Number, enter the range of account
numbers.
If you chose Segment, choose the segment (for example,
Division, Area, Region), then enter the range of segments.
If you chose Account Group, enter the range of account groups.
if you chose Select Account Groups by Sort Code Range,
enter a range of sort codes.
8.In the grid, enter the segment name, the range of segments, and
double-click to choose either Consolidated or Separate in the Report
As column. ("Separate" is available only if you chose Separate in the
Report As area at the top of the form. See step 5.)
9.Select the Print Destination:

Printer
Preview
File
E-mail
10.Click Print:
If you chose Printer, the Print for Print Financial Statements dialog
box appears:
a.

Select the printer.

b.

Select the paper size and orientation.

c.

Enter the number of copies.

d.

Click OK. The report prints to the selected printer.

If you chose Preview, a Microsoft Excel read-only preview screen
displays the report. You can click the Print button to print from the
preview.
If you chose File, the Save As dialog box appears:
a.

Enter a filename or leave the default (the default is the report
name plus 001, 002, 003 etc; for example,
Incsum05_FR.001.xls. The program adds the FR to the
filename.)

b.

Select the folder where you want it saved.

c.

Click OK, then check the folder to ensure that the file was
saved to the correct location. You can open the file from here.

If you chose E-mail, the Set E-mail Report As dialog box appears:
a.

Enter a filename or leave the default (the report name plus an
XLS extension, for example, Incsum05_FR.xls. The program
adds the FR to the filename).

b.

Select a folder to save the file to.

c.

Click OK.

d.

In the e-mail that appears (with the file displayed as an
attachment), enter the recipient's e-mail address change the

subject if you wish (it is, by default, the filename), then click
Send.

Financial Reporter Error Messages
The following table describes error messages that appear on the
generated report when running Financial Reporter modules.

Error Messages When Running FrView in
Statement Designer and in Print Financial
Statements
Message

Meaning

Invalid account
reference in cell.
<cell locationL> : <cell
value V>

The account reference you entered in Column
A is incorrect because it does not match the
requirements of Column A cells. See also invalid
account reference.

You entered an incorrect selection criteria in
Invalid selection criteria this cell. Follow the criteria in Column B to
in cell.
refine the account selection (for example, a
<cell location L> : <cell filter that restricts the range of accounts to a
value V>
particular account group, account type, or
account name).
Invalid zerosuppression formula in
cell.
<cell location L> : <cell
value V>

You entered an incorrect definition for a zero
suppression formula in this cell. Follow the
criteria in Column C to determine which lines
are to be excluded.

Invalid detail level in
You entered an incorrect consolidation switch
cell.
in this cell. Follow the criteria in Column D for
<cell location L> : <cell
consolidating account ranges.
value V>
Invalid formula or
expression in cell.
<cell location L> : <cell
value V>

This is a general message indicating that a
formula or expression at the stated cell
location cannot be interrupted by FR in
generation.

Invalid specification line
Invalid spec line definition at cell location L
type in cell.
with value V (not a comment line, or valid
<cell location L> : <cell
default line, or body line).
value V>

FR cannot further
generate any line for
the worksheet.

Generated lines are almost over spreadsheet
limit. FR generation has been stopped.

Invalid consolidation of
posted transactions on
specification in row
<Row R>.
The specified consolidation method for posted
Consolidated details
transactions on the spec lines in row R must
cannot be generated
match with a specific sorting order.
using the combination
of detail level and
sorting order.
For further information, see Purpose of Column A, Purposes of Columns B, C, and D, and What
Each Column Does.

Error Messages When Starting G/L Statement
Designer or Running Print Financial Statements
Message

Meaning

"Error in creating Excel object."

Make sure Excel has been
installed.

"Page Break Preview is not
available in Print Financial
Statements (GL9100). Please go
to Statement Designer (GL9200) to
use this function."

The Print Financial Statements
feature does not support Page
Break Preview, therefore use the
G/L Statement Designer instead.

"There are no printers installed.
One is required when print
destination is Printer or Preview."

You must install a printer before
you can view output or choose a
print destination.

"FileSystemObject object model
cannot be initiated. Please make
sure that Scripting type library is
properly installed in Windows
System."

Cannot find Microsoft Scripting
Runtime Object - required when
starting FR.

Some Abnormal Errors Detected When Starting
FR
If you receive error messages that are in this format: cmdStart : <error
message>, reinstall Microsoft Excel, or General Ledger, or System
Manager, restart the system, then check to see if the problem has
disappeared. If the problem cannot be resolved by reinstalling these
programs, call your system administrator.
Initializing FR Error (< error id>J): Failure in starting Statement
Designer
Initializing FR Error (<error id>): Failure in starting Print Financial
Statements
See also
Purpose of Column A
Purposes of Columns B, C, and D
What Each Column Does
Specifying Data for a Single Cell
Specifying Ranges of Accounts
Specifying Information for Columns of a Report
Financial Reporter Troubleshooting

G/L Statement Designer
The Statement Designer lets you create or edit a report specification for
generating financial statements.
When you choose the Statement Designer icon from the Financial
Reporter folder, Sage ERP Accpac starts the Microsoft Excel
spreadsheet program with the Financial Reporter add-in.
It is important to remember that this spreadsheet add-in is available only
when you start Excel from the Statement Designer icon.
The add-in adds the FR menu item to the Microsoft Excel menu bar. The
FR menu includes the following Financial Reporter commands:
FR View
FR Paste
FR Clear
FR Options
FR Drilldown

Key Financial Reporter concepts
The Financial Reporter is based upon a few simple concepts:
A financial report is a spreadsheet containing functions that read data
directly from the general ledger.
You can place Financial Reporter functions anywhere in a
spreadsheet. The spreadsheet program looks up the General Ledger
values when it recalculates the spreadsheet.
You can also use any other spreadsheet functions to further
manipulate that data.
A financial statement specification is a structured description of the
statement you want to produce. Financial Reporter creates a
statement based on the specification and the options you choose
when you want to print or view the final statement.
Statement specifications allow you to assign default functions and

formulas to columns of the spreadsheet, and to specify that a range of
accounts will be expanded to many rows on a final statement.
Statement specifications make statements easier to create and more
flexible, but you don't have to use them.
Financial Reporter lets you specify at print time the account
segments, account group, fiscal period, and fiscal set (actual or
provisional amounts) to include in the report.
Keep in mind when designing statements that a generalized financial
statement can be printed with the actual or provisionally-posted
amounts of any particular department or division.
When creating a financial report in Financial Statement Designer, you
can enter formulas that allow you to drilldown to associated
transactions in the resulting report.
It is our assumption that most of the statements you create will be
generated from statement specifications.
See also
Financial Reporter Commands
Financial Reporter Functions
Purpose of Column A
Purpose of Columns B, C, and D
Column E of the Spec Range
How to Set the Spec Range
Enlarging the Spec Range

Switch the Accounting Method for Foreign
Currency Translation
Before you start

We will use the following example to explain the steps:
Sample Company Ltd is a multicurrency company. Its functional
currency is Canadian dollars. In the fiscal year 2009, Sample
Company Ltd used the Realized and Unrealized Gain/Loss currency
translation method. The company revalues balances of monetary
accounts once a year.
We assume, for this exercise, that there is only one US customer,
and, as of December 31, 2009, their balance in USD is 1,000.00 with
CAD equivalent of 1,500.00. Sample Company Ltd also maintains a
USD bank account, with a balance in the account of 5,000.00 as of
December 31, 2009. The CAD equivalent functional amount is
6750.00.
Sample Company Ltd wants to switch to the Recognized Gain/Loss
currency translation method as of January 1, 2010.
Steps to take in 2009:
1.Open Accounts Receivable to revalue the balances of your accounts
receivable. Assume that the exchange rate on December 31, 2009 is
1 USD = 1.4000 CAD.
Thus, when revaluation is performed in A/R, the following reversing
G/L entry will be created on December 31, 2009:
G/L Account

Receivables
Control
Unrealized
Exchange Loss

Debit

Credit

Debit

Functional
Currency
Credit

0.00

0.00

0.00

100.00

0.00

0.00

100.00

0.00

Source Currency

[(1.4000 x 1,000) - 1,500 = 100.00]
2.Go to General Ledger and revalue the balance of USD bank
accounts, using 1 USD = 1.4000 CAD as the exchange rate for
Year/Period 2009-12.
The G/L revaluation will create the folloiwng reversing entry on
December 31, 2009:
G/L Account

Debit
250.00

Functional
Currency
Credit
0.00

0.00

250.00

Source Currency
Debit
0.00

Credit
0.00

USD Bank
Unrealized
0.00
0.00
Exchange Gain
[(5,000 x 1.4000) - 6,750 = 250.00]
3.Print the Trial Balance Report.
It will show the following entries:

G/L Account

USD Bank
Receivables
Control
Unrealized
Exchange Gain
Unrealized
Exchange Loss

Source Currency
Debit
5,000.00
1,000.00

Credit

Debit
7,000.00

Functional
Currency
Equivalent
Credit

1,400.00
250.00
100.00

4.Run Create New Year (from General Ledger > G/L Periodic

Processing > Create New Year).
Steps to take in 2010:
1.Post the reversing revaluation entries created by the 2009
revaluation:
G/L Account

Source
Currency
Debit

Credit

Receivables
0.00
0.00
Control
Unrealized
0.00
0.00
Exchange Loss
{(1.4000 x 1,000) - 1,500 = -100.00]

G/L Account

Source
Currency
Debit Credit
0.00
0.00

USD Bank
Unrealized
0.00
0.00
Exchange Gain
{(5,000 x 1.4000) - 6,750 = 250.00]

Functional
Currency
Debit

Credit

100.00

0.00

0.00

100.00

Debit
100.00

Functional
Currency
Credit
250.00

250.00

0.00

2.In Common Services:
a.

Open the Options tab of the Company Profile.

b.

Select Recognized Gain/Loss in the Gain/Loss Accounting Method
field.

c.

Click Save.

3.In General Ledger:
a.

In the G/L Accounts form, create new accounts for Recognized
Exchange Gain and Loss.

b.

In the Revaluation Codes form, modify existing revaluation codes
or create new ones.

c.

Assign the new revaluation codes to the newly created accounts.

4.In Accounts Receivable (Accounts Payable):
a.

Modify existing account sets or create new account sets for the
USD customers.

b.

Revalue the balances of your accounts receivable.
In our example, we assume that the exchange rate on January 31,
2010 is 1 USD = 1.6500 CAD. Thus, when revaluation is
performed in Accounts Receivable, the following General Ledger
entry will be created on Janauary 31, 2010:
G/L Account

Source
Currency
Debit Credit

Receivables
0.00
0.00
Control
Exchange Gain
0.00
0.00
{(1.6500 - 1.5000) x 1,000 = -150.00]

Debit

Functional
Currency
Credit

150.00

0.00

0.00

150.00

5.Open General Ledger and revalue the balance of the USD Bank
account using 1 USD = 1.6500 CAD as the exchange rate for
Year/Period 2010-01.
The General Ledger revaluation will create the folloiwng entry on
January 31, 2010:
G/L Account

USD Bank
Exchange
Gain

Debit
0.00

Credit
0.00

Debit
1500.00

Functional
Currency
Credit
0.00

0.00

0.00

0.00

1500.00

Source Currency

{(5,000 x 1.650) - 6,750 = -1,500.00]
6.Print the Trial Balance report.
The multicurrency accounts will display the following values for
January 31, 2010:

G/L Account

Source
Currency
Debit
5,000

Credit

Debit
8,250.00

Functional
Currency
Equivalent
Credit

USD Bank
Receivables
1,000
1,650.00
Control
Unrealized
0.00
Exchange Gain
Unrealized
0.00
Exchange Loss
Exchange Gain
1,650.00
Exchange Loss
0.00
[(5,000.00 + 1,000) x 1.6500] - (1,500.00 + 6,750.00) =
1,650.00
Additional information

Create a New Year
Create New Year creates a batch of transactions and posts them.
Before you start

To create a new year:
1.Create a fiscal calendar for the next year. (Click Common Services >
Fiscal Calendar.)
2.Click General Ledger > G/L Periodic Processing > Create New Year.
3.Click Proceed. (Each closing detail is assigned the source code GLCL and is posted to period 15.)
After creating a new year
Additional information

Run Period End Maintenance
Before running Period End Maintenance

To use Period End Maintenance:
1.Open General Ledger > G/L Periodic Processing > Period End
Maintenance.
2.Select the procedures you want done:
Delete Inactive Accounts.You can delete an account only if it:
Has an Inactive status.
Has zero balances for the current year, and for all previous
years for which you retain transaction data.
Is not assigned as the default closing account on the G/L
Options form. (If necessary, you can assign a different
account number to be the default account.)
Delete Transaction Detail History / Delete Fiscal Set History
.General Ledger deletes historical financial, quantity, and budget
details that are older than the number of years you specified for
the Years of Fiscal Sets and Years of Transaction Detail options on
the Posting tab of the G/L Options form.
Reset Batch Number. Use this option to set the batch number
back to 1.
3.Click Process.
Related topics

Comparison of ACCPAC Plus and Sage ERP
Accpac Specification Codes
The following set of charts lists all of the ACCPAC Plus for DOS Financial
Reporter codes that extract data from the General Ledger accounts, and
provides the equivalent codes in the Windows version of the Financial
Reporter.
You may find these charts useful when checking financial report
specifications that have been converted to the Sage ERP Accpac format.
Net change in balance during:
DOS

Windows

Selected fiscal period

M

NETP

Selected quarter to date

Q

NETQ

Selected half year to date

S

NETS

Selected year to date

Y

NETYTD

nth fiscal period of current
year

nM

NETnP

nth quarter of current year

nQ

NETnQ

nth half of current year

nS

NETnS

Last (previous) fiscal period LM

NETLP

Last quarter

LQ

NETLQ

Last half year

LS

NETLS

Last year (total year)

LY

NETY.L1

Preceding quarter (3
periods)

PQ

NETPQ

Preceding half year (6
periods)

PS

NETPS

Preceding year (12 or 13
periods)

PY

NETPY

Net change in balance last year:
DOS

Windows

nth fiscal period

LYnM NETnP.L1

nth quarter

LYnQ NETnQ.L1

nth half year

LYnS

Previous period last
year

LYLM NETLP.L1

Previous quarter last
year

LYLQ NETLQ.L1

Previous half year last
LYLS
year
Preceding quarter last
year

NETnS.L1

NETLS.L1

LYPQ NETPQ.L1

Preceding 6 periods last
LYPS NETPS.L1
year
Net change in balance to date, relative to report date:
DOS

Windows

nth half year to date

nSS

NETnSTD

nth quarter to date

nQQ

NETnQTD

Same period last year LYM

NETP.L1

Same quarter last
year

LYQ

NETQ.L1

Same half year last
year

LYS

NETS.L1

Last year to date

LYY

NETYTD.L1

nth quarter to date
last year

LYnQQ NETnQTD.L1

nth half year to date

LYnSS NETnSTD.L1

last year
Budget net change in balance to date, relative to report date:
DOS

Windows

Selected fiscal period

BM

1NETP

Selected quarter

BQ

1NETQ

Selected half-year

BS

1NETS

Current year

BY

1NETYTD

nth quarter

BnQQ 1NETnQTD

nth half-year

BnSS 1NETnSTD

Budget net change in balance during complete:
DOS

Windows

Current year

B

1NETY

Last period

BLM

1NETLP

Last quarter

BLQ

1NETLQ

Last half year

BLS

1NETLS

Preceding quarter

BPQ

1NETPQ

Preceding half year

BPS

1NETPS

nth period

BnM

1NETnP

nth quarter

BnQ

1NETnQ

nth half year

BnS

1NETnS

DOS

Windows

Selected fiscal period

BAL

BALP

Beginning of selected
period

BAL-M BALLP

Account balance as of:

BAL-

n periods ago

nM

Beginning of selected
quarter

BAL-Q BALLQ

Beginning of selected
half year

BAL-S BALLS

3 periods ago

BALPQ

BALPNETPQ

6 periods ago

BALPS

BALPNETPS

12 or 13 periods ago

BALPY

BALPNETPY

Opening balance
previous year

O

BALOPEN.L1

BALnPA

As with the DOS version of the Financial Reporter, all balances or nets
are computed relative to the fiscal period set for the report, except for
BALOPEN, NETADJ, BALCLOSE, NETCLOSE, and fields referencing a
specific time period.

Fiscal Set Prefix
The codes listed in the chart above provide access to actual data and
budget data only. However, Sage ERP Accpac can store more financial
data than listed above.
The next table lists the prefixes you can add to specification codes to
gain access to the various fiscal sets provided.
Fiscal set designator
Code

Fiscal Set

Blank

Defaults to report setting

A

Actual

P

Provisional

Q

Quantities

QA

Actual Quantities

QP

Provisional Quantities

1,2,3,4,5

Budget sets 1,2,3,4, and 5

For example:
NETP Net amount for the current period (provisional or actual,
depending on the report setting).
ANETP Actual net amount for the current period
QNETP Net quantity for the current period (provisional or actual,
depending on the report setting)
NETR Net amount for the current period in the reporting currency
(provisional or actual, depending on the report setting).
1NETP Budget set 1 amount for the current period
2NETP Budget set 2 amount for the current period

Fiscal Year Suffix
Sage ERP Accpac lets you enter codes for specific years or use codes
relative to the current year. Years are identified by the following suffixes.
Fiscal year
Code

Fiscal Set

Blank

Defaults to current year

1998, 1999,
etc.

Specific year identification

L1, L2, L3
etc.

Last year, the year before, etc.

N1, N2, etc.

Next year, the year after next,
etc.

For example:
NETP Actual net amount for the current period
NETP.L1 Actual net amount for this period last year
NETP.1996 Actual net amount for this period in 1996

1NETP.N1 Budget set 1 amount for this period next year
For more help on Financial Reporter functions, choose one of these
key words:
Financial Reporter functions
Fiscal Set Field Names
FR
FRAMT
FRAMTA
FRCREDIT
FRDEBIT
FRFISCAL
FRPOST
FRRATE
FRSDESC
FRTRN
FRTRNA
FRTRNCR
FRTRNDR

See also
Differences Between ACCPAC Plus for DOS and Sage ERP Accpac Financial Reporters

Differences Between ACCPAC Plus for DOS and
Windows Financial Reporters
The Financial Reporter in Sage Accpac is a more powerful and flexible
tool than its DOS-based counterpart, offering these advantages:
It's easier to use.
It provides access to more information.
It can manipulate, format, and graph General Ledger data.
The Financial Reporter adds Sage Accpac-specific functions and
commands to Excel to allow them to read General Ledger data. The
financial reports are generated within a spreadsheet which uses special
Sage ERP Accpac functions. Once the data is in the spreadsheet, the
Financial Reporter uses the spreadsheet's formatting and printing
capabilities to produce the statement.
Ordinarily, you do not see the spreadsheet when you print a report: you
simply select the report, choose the print options you want, then click
Print. However, if you want, you can open the report specification directly,
generate the report, then use the spreadsheet to manipulate the data.
The Financial Reporter gets a lot of its power and flexibility from the
spreadsheet it uses.

Report Specification Files
Like the DOS version of Financial Reporter, each financial statement is
defined in a report specification. The specification tells Financial Reporter
which data is included on the statement, and how it should be formatted.
Because the specification is actually a spreadsheet, you can use
spreadsheet formulas, formatting commands, and graphing abilities to
embellish the report, and you can transfer the data to multidimensional
models for more sophisticated data analysis.

Excel Report Files
When you use Print Financial Statements, Sage ERP Accpac looks at the
filename extension of the spreadsheet you specify, and if the file you

specify has an XLS filename extension (or XLSX for Excel 2007), the
Financial Reporter starts Excel. If the file does not use one of those
extensions, Financial Reporter will have a problem detecting the Excel
program directory while reading the registry record stored during your
installation of Excel.
See also
Comparison of ACCPAC Plus for DOS and Sage ERP Accpac Specification Codes

Glossary
1099 Form
A/R Invoice Type
Account Description
Account Groups
Account Number Segment Overrides
Account Number Segments
Account Number Structures
Account Segment
Account Set
Account Status
Account Types
Accounting Equation
Accounting Method
Accounting Period
Accounts Payable
Accrual
Accrual Carry-Over Date
Accrual Method
Accrual-Basis accounting method
Accrued Expenses
Activating taxes
Activation
Active Order
Actual Fiscal Sets
Adjustment Period
Adjustments
Advance
All Users
Allocated Tips
Allocation Account
Allow Posting to Previous Years
Allow Provisional Posting
Annual Maximum
Annualization
Assets
Assign UI Profile IDs
Audit Trail
Authentication Method
Automatic Reversal
Backdated document
Bad Debts
Balance Sheet
Base Account
Base Deductions
Base Earnings
Base Hours
Base Taxes
Base Wage Multiplier
Basic Account Information
Basic Project style
Batches
Benefit
Billing Type
Billings And Costs accounting method
Budget Fiscal Sets
Calculation Base
Calculation Methods
Calculator
Carrying Over Vacation, Sick, and Compensatory Time Accruals
Carry-Over
Cash Advance
Cash Benefit
Cash Flow Statement
Cash Method
Category
Category Percentage Complete accounting method
Ceiling
Chart of Accounts
Class Codes
Classified Statements

Clearing Exchange Gain or Loss
Close to Segment / Account
Closing Account
Closing Period
Closing the Books
Common Stock
Company Database
Company Desktop
Company Profile
Compensatory Time
Completed Project accounting method
Consolidated Batch
Control Account
Control Account for Subledgers
Conversion Rate
Corporation
Cost Accounting
Cost Center Overrides
Cost Center Segments
Cost of Goods Manufactured
Cost of Goods Sold
Cost Plus project
CPRS
Credit
Currencies
Currency Rate Type
Currency Rates
Currency Table
Current Assets
Current Liabilities
Custom (and Local) Taxes
Customization Directory
Customize User Interface
Database
Database ID
Date Matching
Debit
Decimal Places for Quantity
Deduction
Default Closing Account
Default Currency
Default Hours
Default Rate Type
Default Source Code
Defining a Source Journal
Defining Meaningful Account Number Segments
Delimiter Character
Depreciation
Detail and Consolidated Posting Options
Detailed Batch
Details
Direct Labor Costs
Distribution Accounts
Distribution Code
Distribution Set
Dividend
Drilldown
Earning/Deduction
Earning/Deduction Frequencies
Earnings
Edit Imported Entries
Effective Date
Employee History
Employee Level Security
Employee Selection List
EMU
Equity
Euro Conversion Rates
Euro Currency
Euro Option
Exchange Gain or Loss
Exchange Rate
Expense Reimbursement
Expenses
Exporting

Factory Overhead
Federal and State Taxes
Field
Financial Statements
Finder
Fiscal Calendar
Fiscal Periods
Fiscal Sets
Fiscal Year
Fixed Assets
Fixed Price project
FOB Point
Force Listing of Batches
Foreign-currency Bank
Functional Currency
Functional Currency Code
Functional-Currency Equivalent
Future Order
G/L Batch
G/L Options -- Account tab
G/L Options -- Company tab
General Ledger Account
Gross Pay
Gross Profit on Sales
History
Imported Account Data
Imported Batches
Importing
Income
Income Statement
Information in G/L Accounts
Integration Access Pack
Integrity Check
Inventory
Invoice Type
Journal
Journal Entry
Labor Hours Percentage Complete accounting method
LanPak
Last Run Date
Last Year Information
Ledger
Level
Liabilities
Local and Other Custom Taxes
Lock Budget Sets (1-5)
Long-Term Liabilities
Lookup Table
Macro
Maintain Quantities Options
Manual Check
Matching Concept
Menu Bar
Miscellaneous Charge
Multicurrency Accounting
Multicurrency Bank
Multicurrency Fiscal Sets
Multicurrency G/L Accounts
Multicurrency G/L Option
Net Pay
No Users
Normal (Account) Balance
Number of Fiscal Periods
Optional Fields
Original Invoice
Override Segments
Overtime Rate Multiplier
Overtime Schedule
Owner Equity
Partnership
Pay Factors
Payroll Class Codes
Payroll Distribution Accounts
Period Minimum and Period Maximum
Periods Per Year

Picking Slip
Post in Specified/All Currencies
Posting
Posting Statistics
Posting tab in G/L Options
Preferred Stock
Prepaid Expenses
Price List
Printing Scheduled Reports
Printing Source Journal Definitions
Profile ID
Profit
Profit and Loss Statement
Profit Center
Programs (Applications)
Project Percentage Complete accounting method
Project Type
Provisional Fiscal Sets
Provisional Posting
Provisional Posting Journal
Quantities in G/L Accounts
Quantity Fiscal Sets
Quarter With 4 Periods
Quote
Rate Operation
Rate Type
Rates
Realization
Realized Exchange Gain or Loss
Reallocation Account
Recognized Exchange Gain or Loss
Reconcile (Bank)
Record
Record of Employment
Recurring Transaction
Remit-to Location
Repayment Deduction
Reported Tips
Reporting Currency
Restart Record
Retainage Accounting
Retainage Invoice
Retained Earnings
Revaluation
Revaluation Codes
Revenues
Reversed Unrealized Exchange Gain or Loss
Salary and Wages
Salary and Wages Payable Account
Sales
Sales Table
Sample Account Segments
Schedule Code
Schedule Reports
Schedule Transactions
Script
Security Group
Segment Codes Validation
Selection List
Service Years
Services
Session Date
Settlement Rate
Settling Transactions
Shareholders
Shareholders' Equity
Shift Differential Rate
Shift Differential Schedule
Ship-Via Code
Sick Time
Sole Trader
Source Codes
Source Currency
Source Document
Source Journal Profiles

Source Journals and Consolidated Transactions
Specific User
Spread
Standard Project style
Standing Order
Statement of Retained Earnings
Status
Stock
Subsidiary Ledger
Surtax Multiplier
Suspense Account
System Database
Tax Authorities
Tax Classes
Tax Groups
Tax Tables
Template (employee setup)
Time And Materials projects
Timecards
Tip Disbursement
Total Cost Percentage Complete accounting method
Transaction Rate Type
Trial Balance
Type
UI Profile ID
UI Profile Maintenance
Unrealized Exchange Gain or Loss
User Authorization
User Record
Vacation Time
Wage Bracket Table
Wage Garnishment
Web Desktop
Withdrawal
Workers' Compensation Code
Worksheet
Years of Fiscal Sets
Years of Transaction Detail

Features Added in General Ledger 5.6
Sage ERP Accpac version 5.6 includes enhancements to the Trial
Balance and Transaction Listing reports, resulting in improved
functionality.

General Ledger Report Changes
New reports that show net changes for a specific period can be
printed using the G/L Trial Balance Report form.
The Transactions Listing form has new options (Include Balances and Net
Changes and Include Posting Sequence and Batch-Entry Numbers).
You now have the option of sorting all transactions by date within the
accounting periods in the Transaction Listing reports.
See also
Features Added in General Ledger 5.5
Features Added in General Ledger 5.4

Features Added in General Ledger 5.5
The following points summarize the new or changed features in General
Ledger 5.5:
We introduced the most sophisticated treatment of currency revaluation on the market.

With this version, we increased the number of segments, account
structures, budgets, and years of history you can keep:
Sage ERP
Accpac 100

Sage ERP
Accpac 200

Sage ERP
Accpac 500

Account
Segments

up to 3 account
segments

up to 4 account
segments

no change

Account
Structures

up to 3 account
structures

up to 4 account
structures

no change

Budgets

up to 2 budgets

up to 3 budgets

no change

Years of
history

keep 7 years of
history

keep 7 years of
history

no change

Sage ERP Accpac 100 lets you define custom account groups. This
feature was previously supported in the 200 and 500 editions only.
You do not need a separate license for G/L Security. Since version 5.5, it is
installed with General Ledger and is activated when you activate
General Ledger. (To use G/L Security, select the Use G/L Security
option on the Account tab of G/L Options, then close and reopen your
company database. You can then use the Account Permissions icon,
which becomes available in the G/L Accounts folder, to assign
permissions.)
If you use Sage ERP Accpac 500 ERP, you can designate an account
as a rollup account to which you can add member accounts. You can create
multiple levels of account relationships.
, and
You can also view rollup amounts in
You can print rollup information for certain reports

.

you can use rollup features in Financial Reporter
several inquiry forms

.

For instructions on creating rollup accounts, see To add a rollup account.

Sixteen new FR reports are available.
Balance Sheet summaries
Financial Analysis statements
Forecasting
Income Statement summaries

.

We have also enchanced multi-user entry and posting

.

Journal Posting rights and Journal Entry rights are now separated

has been enhanced to include options for creating
the recurring entries in a new batch or appending to an existing batch.
Create Recurring Entries Batch

Dashboard security permission lets you customize the dashboard
Web site. If you have access to G/L Dashboard, you can access any
dashboard pages that are based on data stored in General Ledger.
See the System Manager online help for information about using
dashboards.
See also
Features Added in General Ledger 5.4

Features Added in General Ledger 5.4
General Ledger 5.4 introduced the following changes and new features:
We rebranded ACCPAC Advantage Series General Ledger as Sage
ERP Accpac General Ledger.
The Enterprise Edition is now Sage ERP Accpac 500.
The Corporate Edition is now Sage ERP Accpac 200.
The Small Business Edition is now Sage ERP Accpac 100.
We introduced a number of changes to G/L Account Groups.
We enhanced General Ledger reports

.

FR can consolidate by \\acctgroup (account group) and by
\\acctgroupsort (account sorted group).
You can set an optional field as Required without also requiring a
default value. You must also set the Auto Insert option for the required
optional field to Yes.
Finders display account optional fields.
You can view the year to be created in Create New Year.
We have removed the Go button from the Account History Inquiry, the
Source Currency Inquiry, and the Transaction History forms. General
Ledger displays results automatically when you change any input
field.

G/L Security
G/L Security is a feature of the General Ledger program that lets you limit
the accounts that individual users can view or work with to minimize the
risk of unauthorized activity.
If you use G/L Security, an Account Permissions icon appears in the G/L Accounts
folder that lets you assign access rights to accounts.
You assign access depending on your security needs. For example, you
can set up identical access rights for all Sage ERP Accpac users within a
department, division, or business unit that restrict access to accounts
outside that group. For maximum security, you can block your entire chart
of accounts to all Sage ERP Accpac users except user ADMIN.
With G/L Security, you can assign account access rights to individual
users to control which accounts they can view and work with to
minimize the risk of unauthorized activities.
You can block off entire account segments or only the most sensitive
accounts (for example, Payroll, Sales, Retained Earnings, Common
Stock and Preferred Stock).
Once you turn on G/L Security, you can set the default account access:
All Accounts. Allows all Sage ERP Accpac users unrestricted access
to General Ledger accounts unless you set up restrictions in the G/L
Account Permissions window.
Note that you do not require permission to all accounts to perform
periodic maintenance functions, such as deleting inactive
accounts.
Occasionally, you may find that you cannot edit or delete a
structure code, segment, or source code because it is in use by an
account that you cannot see. In this case, a user with access to all
accounts will have to modify the accounts that use the unseen
code or segment.
No Accounts. Prevents all Sage ERP Accpac users except user
ADMIN from seeing accounts and account data in General Ledger
and subledger applications unless you grant individual access rights

to accounts in the G/L Account Permissions window.
If you choose No Accounts, other Sage ERP Accpac users won't
be able to enter Accounts Receivable invoices or post transactions
unless you assign them permissions.
Notes re Rollup Accounts
If you are using G/L Security and want to create rollup accounts, you
must have access rights to view all member accounts of the rollup
account in order to view the rolled up balances in the higher level
account.
If a roll up account is accessible under the user’s security rights, all of its
member accounts are also assumed to be accessible.

How Access Restrictions Affect Sage ERP
Accpac Users
Account access restrictions affect Sage ERP Accpac user activities in the
following ways:
Account lookup and inquiry. Users can't look up restricted account
numbers in Finders or perform account inquiries in General Ledger.
If users enter restricted account numbers into fields, they will see an error
message stating that the specified account does not exist in the General
Ledger.
Adding new accounts. Users cannot add new accounts that fall within a
restricted segment range.
Posting and other batch-related activities. Posting is limited to
batches that do not contain restricted accounts. Users cannot view a
batch that contains transactions with restricted account numbers. The
batch will not appear in batch list windows.
Even if the user has Journal Posting rights, they cannot post batches if
G/L Security has been set to No Accounts.
Invoice entry. Users cannot enter invoices for restricted accounts in
Purchase Orders or Accounts Receivable.
Importing and exporting account data. Users cannot import and export

data for restricted accounts.
Report generation. Restricted account ranges do not appear in financial
reports created using Financial Reporter.

Security for Accounts that Use Blank Segments
If you use a mix of account structures in your chart of accounts, you need
to consider how the program handles accounts that do not contain all the
segments you use in your system.
If an account number does not include a particular segment, say division,
the program considers this segment blank. Unless you specifically restrict
blank values for the division segment, the segment will be allowed.
For instance, for the sample company, SAMLTD, account 1000 contains
only the account segment. If you do not restrict blank division and region
segments and the account segment 1000 is allowed, account 1000 will
be visible.
To allow accounts that include division 100 - but restrict those that do not
contain the division segment - you would set account permissions as
follows:
If the default access in G/L Options is All Accounts:
Allow Segment From To
No

Division

Yes

Division

ZZZ
100

100

All division segments with a blank value are restricted.
If the default access in G/L Options is No Accounts:
Allow Segment From To
Yes

Account

ZZZZ

Yes

Region

ZZ

Yes

Division

No

Division

100

100

Note that the order of permissions for the division segment is important.

Designing Your General Ledger
Before you begin setting up any part of your general ledger, design your
chart of accounts by listing the accounts you need and deciding on an
account numbering scheme that suits your financial reporting
requirements. If you don't have the services of an accountant to assist
you, use one of the sample data charts of accounts as a guideline for
designing your own chart of accounts. Print the sample charts of
accounts by selecting General Ledger Reports > Chart of Accounts.

Common Services System-Wide Options
You must choose some system-wide options in System Manager's
Common Services before setting up your General Ledger. These include:
Multicurrency setting.
With multicurrency turned on, you can process transactions in more
than one currency. If you select multicurrency, you must also select
your home currency (called the functional currency). You make this
selection in the Company Profile form of Common Services.
Number of fiscal periods.
Select either 12 or 13 periods for your fiscal year. You make this
selection in the Company Profile form.
Currency codes, rate types, tables, and rates.
You maintain all currency information in the Currency windows. For
information, see Common Services help, or refer to the System
Manager help.
You do not have to create fiscal calendars before you activate General
Ledger. General Ledger creates fiscal calendars during activation based
on the number of years of account history you want to add.
See also
Before setting up General Ledger
General Ledger Options form
Setting up General Ledger

Current Fiscal Year
General Ledger activation uses this date (and the Oldest Fiscal Year
Starting Date) to determine how many fiscal calendars it needs to create.
For example, if your year starts in April, and it is now June, 2001, your
current fiscal year is 2002.
General Ledger will create calendars for prior fiscal years up to the
current year, and it will also create a calendar for the current fiscal year if
one doesn't already exist.
Note: This year is used only to create the correct fiscal calendars. When
activation is finished, General Ledger sets the current fiscal year to the
year before the oldest fiscal year you specified, so you can enter the
opening balances for your ledger.
See also
Oldest Fiscal Year Starting Date

Revaluation Codes Field List
Click the following links for help with fields on the Revaluation Code
form:
Revaluation code
Rate Type
Source code
Unrealized exchange gain account
Unrealized exchange loss account
Recognized Gain/Loss Account

Account Structures Field List
For help with the fields in the Account Structures form, select from the
keywords listed below:
Structure code
Description
Choose the segments to be added to this account
Segments currently used by this account
Use as Company Default Structure

Recurring Entries Field List
For help with the fields in the G/L Recurring Entries form, select from the
list below:

Transaction header information
Recurring Entry Code
Entry Description
Schedule Code
Start Date
Expiration Type
Last Run Date
Last Maintained
Inactive
Description
Source Code
Entry Mode
Auto Reverse
Current Debit or Credit
Out of Balance By

Details grid
Account description
Account (number)
Comment
Date
Description (of recurring entry)
Optional Fields
Quantity
Reference
Source Ledger / Source Type

Multicurrency fields
Currency
Exchange Rate
Functional Debit/Credit
Rate
Rate Date
Rate Type
Source / Functional Credit
Source / Functional Debit

G/L Accounts — Optional Fields Tab
This tab lets you assign an unlimited number of optional account fields to
hold additional information that your company wants to track for the
account.
Any optional account fields that you set up for automatic insertion appear
on the tab, along with their default values.
If you set up an optional field as a Required field, the optional field should
be in the account's Optional Fields tab; if it isn't, you won't be allowed to
save or add the account.
Note that you must first define optional fields for your company in
Common Services, and then set up optional fields for General Ledger
(using the G/L Optional Fields setup form), before you can assign
optional fields to accounts.
You can include these account fields on the report when you print the
long form of your chart of accounts. You can also use these optional
account fields as selection criteria when printing your chart of accounts,
trial balances, transaction listings, and source journals.
For each optional account field that you want to assign to the
account:
1.In the Optional Fields column, use the Finder to select optional
account fields that you have defined using the G/L Optional Fields
setup form. When you choose an optional field, the program fills in the
description and the default value for the optional field.
2.If you wish to change the value for the optional field, use the Finder in
the Value column to select a value.
Click the links below for information on individual tabs:
Detail

Trans
Optional
Fields

Allocation

Click here for hints on using forms

See also

.

Currency

Subledger

Rollup

Adding a new account
Changing account information
Deleting an account
Displaying account information
G/L Optional Fields Form
Using Optional Fields in General Ledger

G/L Accounts - Transaction Optional Fields
Tab
This tab lets you add an unlimited number of optional fields for additional
information that you wish to include with transactions processed for a
selected account.
Transaction details that use the account will include these optional fields,
whether you enter the transactions through General Ledger's Journal
Entry, Create Allocation Batch, Create Revaluation Batch, or Create
Recurring Entries Batch form, or you create them for General Ledger in a
Sage ERP Accpac subledger.
Note: To save optional fields with posted transactions, you must select
Detail as the Post To Account option on the Detail tab. The program does
not keep optional field information with consolidated transactions.
For each optional transaction field that you want to assign to the
account
1.In the Optional Fields column, use the Finder to select optional
transaction details fields that you have defined using the G/L Optional
Fields setup form. When you choose an optional field, the program
fills in the description and the default value for the optional field.
2.If you wish to change the value for the optional field, use the Finder in
the Value column to select a value.
Later, when you use the account in a journal entry, General Ledger
includes the optional transaction fields and values you assigned.
Using the Same Optional Fields for Transactions and Accounts
If you want to use the same optional fields for transactions as you use for
the account, click the Replace Optional Fields button.
Providing you have set up matching optional fields for accounts and
transaction details in G/L Optional Fields, the program replaces the
optional fields on this tab with optional fields that match those used on
the Accounts Optional Fields tab. (If an optional account field has no
matching optional transaction field in G/L Optional Fields, the field is not
used for transaction details.

Click the links below for information on individual tabs:
Detail

Optional
Fields

Allocation

Currency

.

Click here for hints on using forms

See also
Adding a new account
Changing account information
Deleting an account
Displaying account information
Using Optional Fields in General Ledger.

Subledger

Rollup

G/L Options Field List
For help with the fields on the G/L Options form, select from the list
below:
Company tab

Account tab
Functional currency
Multicurrency option
Default rate type
Use account groups
Maintain quantities
Decimal places in quantities
Default closing account
Reporting rounding account (Euro functional currency only)
Use G/L Security
Default Access

Posting tab
Lock budget sets
Allow posting to previous years
Allow provisional posting
Force listing of batches
Default source code
Edit imported entries
Years of fiscal sets
Years of transaction detail

Segments tab
Segment number
Segment name
Length
Use in closing
Account segment
Segment delimiter
Default structure code

G/L Options � Company tab
This tab lets you:
Change the contact name, telephone number, and fax number for the
General Ledger.
To change the company name and address, or to change the contact
name, telephone number, and fax number at the company level, use
the Company Profile form in Common Services.
For information about other G/L Options tabs, choose from the tabs
shown below:
Account

Posting

Segments

Company name and address
To change the company name and address, or to change the contact
name, telephone number, and fax number at the company level, use the
Company form in Common Services.
To change the contact name, telephone number and fax number for the
General Ledger administration, use the Options form in G/L Setup.
See also
Account revaluation codes
Account structures
General Ledger icons
Segment codes
Source codes
Source journal profiles

G/L Options — Account tab
This tab lets you change settings that determine how accounts are
processed in the General Ledger.
You would usually change account settings only after year-end closing.
Options on this tab include:
Multicurrency accounting. You specify whether the ledger uses
multicurrency accounting and, if so, the default rate type.
Account groups. Whether you will assign each account to a group.
Quantities. Whether you will keep quantity balances (such as number
of units sold), and, if so, how many decimal places you want to use for
quantities.
Default closing account. You close income and expense accounts at
year end to this account.
For information about other G/L Options tabs, choose from the tabs
shown below:
Company

Posting

Segments

Multicurrency and quantities settings
You can turn on the Multicurrency or Maintain Quantities options at any
time in the Options form in G/L Setup. But, once you turn them on, you
cannot turn them off.
You can increase the number of decimal places for quantities at any time
(up to 3), but you cannot decrease the number of decimals.
Note: The Multicurrency option will not appear on this tab unless you
install the Sage ERP Accpac Multicurrency product and chose the
multicurrency option on the Company Profile.

Account groups and retained earnings account
You can change your choice for the Use Account Groups option, or
change the default closing account at any time.

G/L Security
After turning on G/L Security, you use the G/L Account Permissions form
to define account access permissions for individual users.
Note: Depending on the Default Access setting, you will need to use the
Account Permissions form mainly to grant access to accounts, or to
restrict it.
See also
Account Permissions
Account revaluation codes
Account structures
General Ledger icons
Segment codes
Source codes
Source journal profiles

G/L Options — Posting tab
This tab lets you:
View and change the budgeting, batch-editing and posting controls
originally set for General Ledger during installation.
You can change these settings at any time.
View the posting information that is maintained by General Ledger.
Specify a source code to use as the default for journal entries.
For information about other G/L Options tabs, choose from the tabs
shown below:
Company

Account

Segments

The posting statistics on this tab of the form are provided by the system
and display information about batch posting activity for the current fiscal
year.
See also
Account revaluation codes
Account structures
General Ledger icons
Segment codes
Source codes
Source journal profiles

G/L Options — Segments tab
This tab lets you:
Choose and change the structure code that appears as the default
when you add new accounts.
Specify during setup which segment in your account numbers
represents that account code. (You cannot change this setting later.)
Specify during setup which character you use to separate account
segments. (You cannot change this delimiter later.)
Define the segments (divisions or portions) you use in your General
Ledger account numbers.
You can add segments at any time. The number of segments you can
create depends on the edition of Sage ERP Accpac you are using:
Up to 10 segments can be created in Sage ERP Accpac 500.
Up to 4 in Sage ERP Accpac 200.
Up to 3 in Sage ERP Accpac 100.
For information about other G/L Options tabs, choose from the tabs
shown below:
Company

Account

Posting

Account number size
Each account number can contain up to 45 characters, including
segment delimiters (separator characters). However, most General
Ledger reports that include account numbers assume your numbers
will be 24 characters or fewer.
If you use longer numbers, you will have to modify your reports.
You can define up to ten segments to be used in your General Ledger
account numbers, and you can use up to 15 characters in a single
segment.
Individual account numbers can contain from one to ten segments,
and you can vary the number and order of segments used in account

numbers in the same general ledger.

Account number format
One segment of the account number is called the account segment.
This segment identifies the exact purpose of the account (such as
petty cash).
You specify the number of the account segment in the Account
Segment field on the Segments tab of the G/L Options form. Every
account number and account number structure you add must include
the account segment.
Other account segments can identify divisions, departments,
warehouse locations, and so on.
The delimiter character is used to separate the segments of the
account number during entry and display, and on reports, making it
easier to read.
You can use each account number segment you define to select and
sort accounts that appear on reports and inquiries.

Changing segments
At any time, you can:
Add new segments
Change segment descriptions.
Delete a segment, providing it is not assigned to an account number
structure.
Change the length of a segment, providing it is not used in an account
number structure.

After defining account segments
If you define more than one account number segment, you must also:
Define account number structures — the various combinations of segments used
in your account numbers. (Use the Account Structures form.)
List the segment codes that are valid for each segment. (Use the Segment

Codes form.)
Valid segment codes could be the codes for all departments in the
company, the company’s division codes, etc.

Account structures
An account structure identifies which account segments are used by
particular accounts in your general ledger, and the order of those
segments in the account number.
Account structures let you use different numbers of account segments in
your codes within the same General Ledger.
The number of account structures you can define is determined by the
version of Sage ERP Accpac you are using (3, 4, or an unlimited
number).
The following example illustrates how account structures work.
If you defined four account segments in the G/L Options form:
You can define one account structure that uses only two segments in
account numbers (such as the account segment and the department
segment).
You can define another structure for account numbers that have four
segments, such as the account segment, and segments for the
department, sales region, and product type.

Single-segment account numbers
A one-segment account number has only an account segment. You
cannot create account structure codes or segment codes for a singlesegment account number.
You cannot close single-segment income and expense accounts by
account number segment. Instead, G/L closes the accounts to the default
closing account specified on the Account tab of the G/L Options form.
See also
Account revaluation codes
Account structures
General Ledger icons
Segment codes
Source codes

Source journal profiles

Group Category
Group categories organize your accounting information for presentation
in the Income Statement and Balance Sheet snapshots in the Sage ERP
Accpac portal.
These snapshots retrieve data using group categories that are linked to
your accounts through the standard account groups.
If you plan to use the Income Statement and Balance Sheet snapshots,
note that before you configure the snapshots, you must:
Assign all account groups to appropriate categories from the standard
set of group categories that comes with General Ledger. You can
assign any number of account groups to the same category.
Assign all general ledger accounts to appropriate account groups.
Otherwise, the snapshots may display incorrect information, or no
information.

Changing Sort Codes
You can change the order in which accounts appear, and you can insert
new account groups within an existing order.
You change sort codes only in the Change Sort Codes window, as
described in this topic.

To change the sort order for account groups
1.Open G/L Setup > Account Groups.
2.Click the Change Sort Codes button to display the Change Sort
Codes window.
3.Double-click in the New Sort Code column for the account group you
are changing.
4.Change the code, then tab out of the column.
The account group moves to its new position in the list.
5.Assign the same sort code to the other account groups in the set.
6.Click the Process button to save your changes.

Field List for G/L Optional Fields
For information about fields in the G/L Optional Fields form, click these
links:
Auto Insert
Default Value and description
Optional Field and description
Optional Fields For
Required
Value Set

Working With Detail Entry Grids
The first tab of each transaction entry form in Inventory Control contains
a detail entry grid that shows the document details in tabular format.
If there are more columns than can be displayed at one time, you can
use the horizontal scroll bar at the bottom of a list to view the additional
columns. You can also rearrange the order of columns, or change column widths,
consistent with how you enter data.
If you need to view or edit options for a single detail, you can select a
detail and open a separate form that lets you see all the fields for the
selected detail.
To add details using the detail grid, do one of the following
If a blank line is highlighted, tab to the Item Number field, then either
type the item number or select it from the Finder. Enter the remaining
information for the detail.
To start a new line, press Insert or tab through the end of the last line
on the grid. If you want to insert a new line in a particular location,
highlight the line above the location, then press Insert.
A detail line is saved as you enter it on the detail entry grid.
To edit details using the detail grid
Highlight the line you want to edit, then enter your changes on that
line.
To delete details using the detail grid
1.Highlight the line you want to delete.
2.Press the Delete key on your keyboard.
3.If you see a message asking you to confirm the deletion, click Yes.
To open a Detail form (F9)
In most cases, you can enter all the necessary details for a document
right on the grid.
You can also view and edit all the fields for a single detail on a separate

Detail form.
To open the Detail form to edit item information or to change options,
highlight the detail on the grid, then either click the Detail button or press
the F9 key on your keyboard.
See also
Changing column widths in data-entry forms

Drop-Down Lists
Drop-down lists are used throughout Windows programs. To select from
a set of choices, click on the down arrow, and Windows will display the
list.
You can also:
Tab to the list field and press the Down Arrow to scroll through list
choices.
Tab to the list field and press Alt-Down Arrow to display the list.

Using Help
Welcome to Sage ERP Accpac online Help! Help is available from both
the Sage ERP Accpac desktop and from Sage ERP Accpac on a Web
browser.

Obtaining Online Help
For help on using Sage ERP Accpac:
Click Help Topics on the Help menu on the Sage ERP Accpac
desktop, or
Press F1 in your browser from an open form.
To view the Help contents for a specific module, open a form for the
module, then click Contents on the module's Help menu or press F1.
Click the What’s This command from the Help menu or click the
Context Help button to obtain help about the Sage ERP Accpac
desktop.

Drilldown Button
Click the Drilldown button on the Journal Entry form to drill down to the
transaction in the source ledger from which this journal entry originated.
For example, you can drill down to an Accounts Receivable invoice or
Accounts Payable payment entry to check the details.
To drill down to an associated transaction from a statement that you
generated in G/L Statement Designer, see FR Drilldown.

Navigation buttons
Click the navigation buttons to move through the list of existing batches
or entries.
Use the previous button to go to a previous record; use the next button to
go to the next one. You can also jump directly to the first and last records.
Note that the navigation commands only find records that match the
criteria set for them. If you cannot find a record, see if Set Criteria is
checked on the menu.

Account Structure Report — Features
This report lists:
The account structure codes in the range you selected.
The description for each code.
The segments included in each account structure, in the order they
appear.
For instructions about printing the report, see Account Structure report — printing.
Every account you define must have at least one structure code.
See also
General Ledger reports
Printing the Account Structure report

G/L Options Report — Features
This report lists the options selected and information entered on the G/L
Options form, including the following:
account-number segments defined for your ledger and the
descriptions associated with those segments
which (if any) budget sets are locked
posting preferences
For instructions on printing the report, see G/L Options report — printing.
See also
General Ledger reports

Recurring Entries Report — Features
The recurring journal entries report lists recurring journal entries set up
using the G/L Recurring Entries form.
This report lists recurring entries by code, states which account(s) the
codes pertain to, and shows the type of schedule and its frequency. It can
also include optional fields entered with transaction details, if you choose
to include them.
For instructions on printing the report, see Recurring Entries Report — Printing.
See also
General Ledger reports

Transaction Details Optional Fields — Features
Similar to the G/L transaction listing, this report lets you select and print
transactions that use specified optional transaction fields and optional
field values.
The report lists posted transactions that include the specified optional
transaction fields whose values fall within the specified range of values
for the selected accounts.
For instructions on printing the report, see Transaction Details Optional Fields Report Printing.

Information printed on the report
The range of optional fields and values, account numbers, segment
codes, account groups or account sorted groups you specified for the
report.
The order in which accounts are listed, by account number, segment,
account group, or account sorted group.
Posted transaction details that meet the specified criteria are listed
with the posting sequence, batch number, year and period for the
transaction, as well as the optional field codes and values, debit or
credit amount, quantity, and unit of measure used for each detail.
The total of the details posted to each account.
In multicurrency ledgers, the report print amounts in both source and
functional currency or in functional currency only.
See also
General Ledger reports
Printing the Transaction Details Optional Fields report

General Ledger Menu Commands
The menu bar appears in all General Ledger screens immediately below
the screen title.
General Ledger menu commands are the same as appear on other Sage
ERP Accpac forms. For more information about menu commands, click
one of the following links:
File menu
Help menu
Settings menu

See also
General Ledger forms
General Ledger reports
Using Help

General Ledger Reports
General Ledger prints two main types of reports:
Audit reports that provide you with transaction listings and status
information (such as batch listings, posting journals, source journals,
the chart of accounts, and the trial balance).
Financial reports (such as balance sheets, income statements, and
statements of changes in financial position).
If you have a multicurrency ledger, these reports can also include source
and functional-currency (home currency) information (on letter size, legal
size, or A4 paper).
See also
Financial reports
Reports Features
Printing Reports

Create Accounts Preview Report
To view this report, enter data into the fields in the G/L Create Accounts
form, click the Preview button, then click File / Print.
1.Select a Sort By option:
Account Number (then select From/To range)
Segment (then choose the segment)
Account Group
2.Choose the option Select Account Groups by Sort Code Range, then
fill in the From / To Sort Code fields. (optional)
If you do not select this option, enter the range of account groups for
the selection in step 1.
3.In the grid, select the range of Segments.
4.Include the following details (optional):
Subledger
Optional Fields
5.Click Print.
This report displays account numbers, status (active or inactive), account
group, etc.
See also
Create Accounts

G/L Accounts — Allocation Tab
The Allocation tab tells General Ledger how to distribute the balance of
an account when you run Create Allocation Batch (in the G/L Periodic
Processing folder).

To define account reallocations
1.Select the source code for the reallocation transactions.
2.Choose whether the account is reallocated based on the account
balance or on the account quantities.
Reallocation by account balance distributes the balance in the
account to the target accounts based on the percentages that you
specify on the Allocation tab. (For example, you could distribute 25%
of the balance to each of four accounts.) This choice distributes
balances only, and does not distribute quantities.
Reallocation by account quantities distributes the net quantity in an
account to the target accounts according to the percentages that you
specify. It then distributes the account balance to the target accounts
based on the quantities that were distributed. All accounts must
maintain quantities, and they must use the same unit of measure.
3.List the accounts to which you are allocating balances, together with
the reference, description, and percent of the account balance or
quantity that you want to assign to each transaction detail.
Note: The total percent allocated must be 100%.
Click the links below for information on individual tabs:
Detail

Optional
Fields

Trans
Optional
Fields

Click here for hints on using forms

See also
Adding a new account
Changing account information
Deleting an account
Displaying account information

.

Currency

Subledger

Rollup

G/L Accounts — Currency Tab
This tab is available only if the Multicurrency option is selected:
On the Company Profile form in Common Services.
On the G/L Options form.
For the account on the Detail tab of this form.
The Currency Information tab lets you specify which currencies are valid
for the account.

To specify currencies
1.Choose whether you want to allow posting from all currencies defined
in Common Services, or only specific ones.
2.Choose the currency you want appearing as a default during
transaction entry.
3.If you chose specified currencies, enter each of the currencies in
which you want to enter transactions.
Even if you choose all currencies, use the table to specify which
currencies you want to revalue automatically for the account (if any).
Double-click with the mouse, or press the Spacebar, to turn on
Revaluation for a particular currency.
You can save disk space by reducing the number of valid source
currencies for an account. When an amount is posted in a valid source
currency, the system creates Source, Functional, and Equivalent fiscal
sets to store original and converted currency amounts.
Click the links below for information on individual tabs:
Detail

Optional
Fields

Trans
Optional
Fields

Click here for hints on using forms

See also
Adding a new account
Changing account information

.

Allocation

Subledger

Rollup

Deleting an account
Displaying account information
Source Currency Inquiry

G/L Accounts — Rollup tab
This tab lets you:
Create relationships between accounts that can be used for
classification, budgeting, and reporting.
Creating a relationship between accounts lets you consolidate (rollup)
account balances (and quantities, if applicable) to provide a summary
balance similar to the consolidation options provided in Financial
Reporter.
Change a rollup account to a non-rollup account (by clearing the
Rollup option on the Details tab for that account).

Cautions
You should be aware of the following rollup cautions when creating rollup
groups:
A parent account cannot be a child of itself. That is, when you create
a rollup group, you cannot add the top account as a member of the
same group.
New accounts do not get added automatically to existing rollup
groups.
When you prohibit posting to a rollup account, you can still post to that
account in other ledgers (A/R, A/P etc), but not in G/L.
Be aware that if a user is granted security rights to view a parent
account, they also will be able to view the member accounts in the
group.
An account can be a member of more than one rollup group.
Be careful how you set up the rollup groups so as to avoid doublebalances in reports.
To select member accounts for a rollup account

Click the links below for information on individual tabs on the Accounts
form:
Optional

Trans

Detail

Fields

Optional
Fields

Allocation

Currency

Subledger

Click the Field List button at the top of this topic for information about
fields on all tabs of the G/L Accounts form.
.

Click here for hints on using forms

See also
Adding a new account
Changing account information
Deleting an account
Displaying account information

G/L Accounts Field List
For help with the fields on the G/L Accounts form, select from the list
below:
Replace Optional Fields button
Detail tab
Optional Fields tab
Trans. Optional Fields tab
Allocation tab
Currency tab
Subledger tab
Rollup tab

G/L Accounts — Detail Tab
The G/L Accounts form contains tabs of information about each general
ledger account, depending on the options you have chosen for the
particular account you are adding or displaying. The Detail tab contains
all the information that is required for every account and is the tab that
appears whenever you open the G/L Accounts form.
To add information to fields on the Detail tab, click here.

Click the links below for information on individual tabs:
Optional
Fields

Trans
Optional
Fields

Allocation

Click here for hints on using forms

See also
Adding a new account
Changing account information
Deleting an account
Displaying account information
Entering account balances
Chart of accounts

.

Currency

Subledger

Rollup

G/L Accounts — Subledger Tab
This tab appears when you select the Control Account option on the
Detail tab.
The Control Accounts Subledgers Information tab lets you specify which
subledgers use the account as a control account.

To specify the subledgers which use a control
account
1.On the Detail tab, specify that this account is a control account for
subledgers.
2.Choose the Subledger tab.
3.Choose the subledgers which will use this account as a control
account.
Click the links below for information on individual tabs:
Detail

Optional
Fields

Trans
Optional
Fields

Click here for hints on using forms

See also
Adding a new account
Changing account information
Deleting an account
Displaying account information
Source Currency Inquiry

.

Allocation

Currency

Rollup

Rollup Account
An account that shows the relationships between accounts that can be
used for classification, budgeting, and reporting. Creating a relationship
between accounts lets you consolidate or rollup account balances (and
quantities, if applicable) to provide a summary balance similar to the
consolidation options provided in Financial Reporter.

Journal Entry Inquiry
Use this form to look up the journal entry details from which the
transaction you selected on the Transaction History form was created.
Information includes:
batch and entry number
fiscal year and period
all the debit and credit details in the journal entry
total debits and credits for the journal entry
For each detail you can see:
reference
description
account number
quantity
date
source ledger
source code
debit amount
credit amount
In multicurrency ledgers, you can also see the currency, rate date, rate
type, and exchange rate, as well as the debit and credit amounts shown
in functional currency.
To open the Journal Entry Inquiry form, select a transaction line in the
Transaction History form, then double-click the line.
Choose Close to return to the Transaction History form.

Account Permissions Field List
User ID

Segment tab
Allow
Segment
From
To

Account tab
Allow
From
To

Batch Status Report — Features
This report lists information about General Ledger batches, including the
debit and credit totals, the number of entries and, for printed batches, the
number of outstanding errors. The report also lists the batch descriptions,
to let you track the original entry of transactions. Print the report as part
of the transaction-entry cycle, to discover batches for which you need to
print or reprint listings before posting, and batches that contain errors.
For instructions on printing the report, see Batch Status report — printing.

Information printed on the report
The following information is printed on the report:
The range of batch numbers, source ledgers, and batch creation
dates for the batches that you want printed.
Whether it includes batches that have already been listed.
The batch type.
The status of the batches you chose to print.
For each batch, the report lists the batch number, the batch
description, the source ledger, the number of entries (unless posted),
the creation date, the last edit date, the status, the batch type, the
posting sequence, the number of reported errors, and the batch totals
(amounts and quantities).
A batch summary at the end of the report lists the number of batches
of each status: number of batches, number of entries, and total debits
and credits.
See also
General Ledger reports
Printing the Batch Status report

Batch Listing — Features
This report lists posted and unposted batches of general ledger
transactions.
For instructions on printing the report, see Batch Listing — printing.
To enforce a strict audit trail, turn on the Force Listing Of Batches option
on the G/L Options form. This option prevents you from posting batches
that are unlisted.

Information printed on the report
The following information is printed at the top of the report:
The range of batch numbers, source ledgers, and batch creation
dates for the batches that you want printed.
Whether it includes batches that have already been listed.
The

batch type.

The

status of the batches you chose to print.

Displays the account description.
The body of the report lists batches sequentially.
For each batch, the report lists the batch number, the batch description,
the creation date, the status, the batch type, all entries in the batch, and
the batch total.
The batch description indicates whether the batch was retrieved from
ACCPAC Plus for DOS.
The first two characters of the source code identify the source ledger
(for example, IC for Inventory Control). The last two characters
identify the transaction type (for example, RC for receipt)
Any comment lines you entered with an entry detail are listed
immediately after the detail. These comments appear on the posting
journal, but are not stored with posted transactions (in other words,
they do not appear in a source journal or on the G/L Listing).
Batch totals are listed after all the batch entries.

The report also lists the number of entries in each batch and the
number of batches in the report.
If you have a multicurrency ledger, you can print amounts in both
functional currency and source currency (on letter size, legal size, or
A4 paper). If you print source-currency information, the report also
contains rate information for each multicurrency entry, including the
rate type, the date the rate was entered, and the rate itself.
The Account Description is included on the report.
Optional fields that were posted with details are printed for each entry, if
you chose to include optional transaction fields on the report.
The report also identifies entries within posted batches that were not
posted successfully.
See also
General Ledger reports
Printing the Batch Listing report

Posting Journals — Features
The Posting Journal is the record of every entry that is posted to General
Ledger accounts. It is an essential part of the audit trail, linking the batch
listings to the G/L Transactions listing. You can post provisional
transactions if you use the Allow Provisional Posting option on the G/L
Options form.
For instructions on printing the report, see Posting journal — printing.
Print the journal in account number order or in posting sequence order.
(All batches posted at one time are assigned the same posting sequence
number.) You can also select the range of posting sequences to print.
Once you have printed the journal to a printer or file, you can clear the
data for the posting sequences printed, but you do not have to clear the
journal between posting sequences. You can keep adding to it with each
posting until you are ready to change the fiscal year, when you must clear
the entire journal.
The Create New Year form also produces a posting journal that shows
the entries generated to close revenue and expense accounts.

Information printed on the report
The range of posting sequences in the report.
The sorting order (either by posting sequence or account number).
The report lists the following information for each detail:
The batch number and entry number. Like the posting entry number,
these numbers remain with the posted transactions unless you
consolidate. The numbers let you track transaction details back to the
original batch listings.
All details and comments that appeared on the batch listing and were
successfully posted in this sequence.
The journal includes the original details which are consolidated on
posting. The consolidated entries are listed in the summary at the end
of the report.

Comments appear on this journal, but not on the G/L Transactions
Listing or on source journals.
Optional transaction fields posted with journal entry details, if you
chose to print them.
The number of posting entries in this posting sequence.
In multicurrency ledgers, you can print both source-currency and
functional-currency information on letter, legal, or A4 paper.
The Posting Journal Errors Report lists all entries containing errors,
together with the number of the new batch into which they were
placed. These entries must be corrected, then posted again.
Note: if the posting journal has been printed and the Reprint
Previously Printed Journals option was not selected, the
corresponding Posting Journal Errors report will not print.
See also
General Ledger reports
Printing Posting Journals reports

Journal Entry Field List
For help with fields on the Journal Entry form, click the links in the
following list:
Batch information
Batch description
Batch number

Journal entry information and options
Auto reverrse
Date (journal entry)
Entry description
Entry number
Normal/Quick entry
Source code
Status (Ready to Post or Open)

/

Year Period

Journal details
Account description
Account
Comment
Credit/Source Credit
Date (detail line)
Debit/Source Debit
Description
Optional Fields
Quantity
Reference
Source code
Source ledger and Source type (entry grid)

Multicurrency fields
Currency
Func DR/CR
Rate
Rate date
Rate type

ICT Company fields
Destination (ICT company field)
Originator (ICT company field)
Route (ICT company field)

Intercompany Transactions Batches
If you use Sage ERP Accpac Intercompany Transactions, additional
fields appear on the Journal Entry form in General Ledger, letting you
identify the originating company for the batch and a destination company
and route number for each transaction.
Note that you can enter intercompany transactions only in the company
in which you activated Intercompany Transactions.
If you are not using a company in which Intercompany Transactions has
been activated, the ICT fields do not appear on G/L forms and reports.

Customize
Administrators can use this command from the File menu of a form to
hide fields and/or buttons in forms and dialog boxes for specific users or
for all users assigned to a particular UI Profile. For example, when fields
are hidden, data that would normally appear in these fields cannot be
printed, and hiding the Add or Delete buttons restricts users from adding
or deleting data.
See also UI Profile Maintenance and Assign UI Profiles in System
Manager online help.

Settings Menu
Depending on the form that is open, the Settings menu will contain the
following commands:
Auto Clear: The Settings menu in the Journal Entry form includes an
Auto Clear command to help you streamline data entry. Select the
Auto Clear option to start a new entry automatically when you add a
transaction (as if you clicked the Add button, then the New button).
Save Settings as Defaults and Clear Saved Settings: Other Sage
ERP Accpac forms include these two commands in the Settings
menu. After you print a statement using specific settings that you
saved, when you open the same Report icon again, those settings will
have been retained.

Create Revaluation Batch Field List
For help with the fields on the Create Revaluation Batch form, select from
the list below:
Batch description
Currency code
Revalue by
Account / Account Segment range
Revaluation codes
Fiscal year
Fiscal period range
J/E (journal entry) date
Revaluation rate
Rate date
Force revaluation
Optional fields

Before Consolidating Transactions
1.Post outstanding batches.
2.Print the G/L Transactions Listing to obtain a report of full transaction
detail for your audit trail.
3.If you will not be consolidating by source code, print the source
journals you require.
4.Determine whether to consolidate by account number or segment,
and the range of accounts or segments to consolidate.
5.Decide on the fiscal year and period up to which to consolidate
transactions.
6.Determine whether to consolidate by account and fiscal period or by
account, fiscal period, and source code.
If you do not consolidate by source code, assign the source code to
assign to consolidated transactions.
7.Back up data.
Note that when you consolidate transactions, you lose any optional field
information that was posted with the transactions.

After Consolidating Transactions
To determine how a transaction was consolidated, check its description
and posting sequence number.
A transaction created by the Consolidate Posted Transactions form
has the description "CONSOLIDATED" and has a posting sequence
number of 0. The batch number is 000000.
A transaction consolidated during posting has the description
"CONSOLIDATED POSTING" and it has a posting sequence number.
If you have some accounts that you consolidate regularly because they
accumulate detail that you do not need, you should consider using the
option to consolidate those accounts during posting.

Intercompany Transactions Company
An Intercompany Transactions company creates transactions between
companies, using one company as the originator of a transaction (for
example, Company A pays for a transaction for Company B), and another
as the destination company (Company B). There can be intermediate
companies between the originator and the destination.

Chart of Accounts Report — Features
This report lists all or a range of General Ledger accounts according to
the selection criteria and the sort and format criteria you specify.
For instructions on printing the report, see Chart of Accounts — printing.
At printing time, you can select accounts by account number, segment,
account group, account sorted group, or optional field. Then specify the
type of report and range of entries, either accounts or segments, you
want to print.

Information printed on the report
The range of account numbers, segment codes, account groups, or
account sorted group you specified for the report.
The order in which accounts are listed, by account number, segment,
account group, or account sorted group.
The type of information you are printing:
Detail - Short form
Detail - Long form
Valid Currencies
Allocation
Control Account Subledgers
Fiscal Set Comparison
Rollup Accounts

The Account Configuration column displays letter codes for each
account, in a definite order, each code followed by a comma. The first
code represents the account type, followed by the code for the
account balance type, followed by the code for the currency type,
followed by the code for a rollup account (only when the account is a
rollup account or a rollup member, if not, no code appears in this
position).
Account Type codes include:

B = Balance sheet account
I = Income and expense account
R = Retained earnings account
Account Balance Type codes include:
CR = Credit account
DR = Debit account
Currency Type codes include:
M = Multicurrency account
F = Functional currency
Rollup Account codes include:
R = Rollup account
M = Member of a rollup account
B = Both a rollup account and a member of a rollup account
The Control Accounts column indicates whether an account is a
control account. To see which ledgers use the control account, print
the Control Account Subledgers version of the report.
The Post In column displays whether to post in detail or consolidated
format, or whether posting to this account is prohibited.
For a Rollup Account report, the report displays all rollup accounts, all
of their directly-related rollup member accounts, and a Yes/No field to
indicate if those rollup member accounts are themselves rollup
accounts.
See also
General Ledger reports
Printing the Chart of Accounts report

G/L Transactions Listing — Features
This report lists all the transaction details for each selected account for
the periods you specify.
For instructions on printing the report, see G/L Transactions Listing — printing.
Print this report before consolidating posted transactions and before
printing financial statements. You can view the same details (ordered and
extracted by different criteria) with the source journals. Because posted
transactions can be consolidated, this listing may not show all the details
that were entered in batches:
Transactions can be consolidated during posting. (Set posting
consolidation on the G/L Accounts form.)
You can consolidate transactions after posting using the Consolidate
Posted Transactions form.
A consolidated transaction created during posting retains the posting
sequence number on the G/L Transactions Listing, so the consolidated
amount can be traced through the posting journal to the batch listings.
Transactions that are consolidated after posting are consolidated by
fiscal period and source code, but not by posting sequence number. The
description in this case is "Consolidated."

Information printed on the report
Whether you included accounts with no activity (and no opening
balance).
Whether you printed adjustment entries or closing entries. (You can
print these entries only if you are printing data from period 12 or 13 —
whichever is the final period of the year.)
The order of the report: either by account number, segment, account
group or account sorted group.
The ranges of account numbers, segments, and account groups, or
account sorted groups.
The year and range of fiscal periods.

The last year closed.
The last posting sequence used. The sequence number identifies all
transactions posted together. Each time you post transaction batches,
the posting sequence number increases by 1.
Any optional fields that were used with the transactions, if you chose
to print optional transaction fields.
Balances and net changes for each account over the selected period
Posting sequence and batch-entry numbers
For each account, the report lists:
The account number, description, and opening balance.
Details posted to the account in the specified periods.
The period, source code, date, reference, posting sequence, batch
number, entry number, and debit or credit amount.
The net change for the account, and the period closing balance.
If you chose "Use Rolled Up Amounts", the report lists the
transactions of a rollup account and all of its rollup member accounts
(at any level), rolled up into a single amount for each transaction.
All transactions listed will be sorted by date within the accounting periods,
if the Sort Transactions By Transaction Date option is selected.
If you use multicurrency accounting, you can print amounts in both
source and functional currencies (on letter, legal, or A4 paper sizes). You
can also print the report in functional currency only.
The report includes:
Source-currency opening balances. For multicurrency accounts, the
report lists the opening account balance in each source currency.
Functional-equivalent figures.
Functional-currency opening balances.
Consolidated details. When the account is consolidated, a separate
transaction is created for each currency, as well as for the other
consolidation options (source code, fiscal period).

Change in balance by currency. The report shows the change in the
account balance in the last period specified, by source currency.
Note: You can print the report in the reporting currency only if you use
the euro as your functional currency and have specified a reporting
currency.
See also
General Ledger reports
Printing the G/L Transactions Listing report

G/L Optional Fields Report - Printing
This report lists the optional account fields and the optional transaction
fields you have defined for General Ledger.
For information on the contents of this report, see Optional Fields Report - Features.

To print the report
1.Choose the Optional Fields icon from the G/L Reports folder.
2.Choose

Print.

See also
General Ledger reports
Optional Fields Report - Features

Revaluation Codes Report — Features
This report lists each of the revaluation codes in the specified range,
along with the description and other information entered to define the
code in the G/L Revaluation Codes form.
For instructions on printing the report, see Revaluation Code report — printing.
You define revaluation codes only if you have a multicurrency ledger and
if you plan to revalue source-currency amounts automatically with Create
Revaluation Batch.

Information printed on the report
The range of revaluation codes selected for the report.
The revaluation code and description.
The rate type you want the Create Revaluation Batch form to use as a
default for generating revaluation transactions.
The source code to be assigned to details generated by the Create
Revaluation Batch form using the revaluation code.
The accounts to which the exchange gains/losses are posted.
See also
General Ledger reports
Printing the Revaluation Code report

Segment Code Report — Features
For instructions on printing the report, see Segment Code report — printing.

Information printed on the report
The range of segments selected for the report.
For each segment, the report lists:
All or a range of codes defined for the segment, together with the
code descriptions and the numbers and descriptions of the retained
earnings accounts to which the segment codes are closed.
See also
General Ledger reports
Printing the Segment Code report

Source Codes Report — Features
This report lists a range of source codes, along with the description
entered in the Source Codes form for each code.
For instructions about printing the report, see Source Codes report — printing.
Each transaction entered in General Ledger (or in subledgers) must
include a source code to identify the type of transaction. For example,
GL-AD could identify all adjustments entered in General Ledger, and GLCA might identify all cash payments.
Source codes add flexibility to your General Ledger, because you define
them. You can select and print lists of posted transaction details by
source codes, using the Source Journal report from the G/L Reports
folder.

Information printed on the report
The range of codes you selected.
Each source code and its description.
The number of source codes printed on the report.
See also
General Ledger reports
Printing the Source Codes report

Source Journals Report — Features
Source journals list the details of posted transactions for the source
codes that you included in the source-journal definition, and in the order
you specify at print time.
You specify the source codes that appear in a report in the source journal
profile, and you specify the following items when you print the source
journal:
The sorting order of the report (by account number, account segment,
account group, or account sorted group).
The ranges of account numbers, segment codes, account groups, or
account sorted groups.
The ranges of fiscal periods, references, dates, posting sequences,
and batch numbers.
In other words, the journal profile specifies the type of transaction, but
you refine the detail selection at print time. The result is a very flexible
report for tracing all kinds of transactions, originating in any of the
subledgers.
For instructions about printing the report, see Source Journals — printing.
Source journals can include up to 50 source codes for each journal. If
you have less than 50 source codes in your ledger, you could print all
transactions posted on a particular date or with a particular reference
code.

Information printed on the report
The name of the journal. (Journals are identified by name.)
The ranges you specified for each column of the report.
Details listed in the order indicated by the columns.
The total debits and credits of all details printed.
Optional fields posted with transaction details, if you choose to include
them.
If you use multicurrency accounting, you can print amounts for the

report in both the source currency and the functional currency (on
letter, legal, or A4 paper), or in reporting currency only.
See also
General Ledger reports
Printing the Source Journals report

Source Journal Profiles Report — Features
This report lists all or a range of the source journal definitions that have
been added to the ledger. Source journals allow you to list posted
transactions that were entered with particular source codes. The source
journal lists the source codes that are included in the journal, as well as
the default report that's used to print the journal.
For instructions on printing the report, see Source Journal Profiles report — printing.

Information printed on the report
The range of journal profiles in the report.
The journal names.
The source codes included in the report.
See also
General Ledger reports
Printing the Source Journal Profiles report

Trial Balance Report � Features
The trial balance report prints the balance for each account in the range
of accounts, segments, account groups, account-sorted groups, or
optional fields in the general ledger as of the fiscal period you specify.
There are up to seven different trial balance report formats you can print.
Report
Worksheet
Quantity Report
Provisional Quantity
Provisional Included
Provisional Separate
Provisional Worksheet

The last four report formats in the previous list are available only if the
Allow Provisional Posting checkbox is selected on the Posting tab in the
G/L Options form. As well, the Quantity Report format is only available if the
Maintain Quantities checkbox is selected on the Account tab.
All reports can be printed with Balances as of Year/Period or Net
Changes except worksheet formats.
For instructions on printing the report, see Trial Balance report � printing.
The worksheet is particularly useful at month end and year end. The
worksheet format is a double spaced listing of General Ledger accounts,
including columns for you to make the adjusting entries. The report
format is a single-spaced listing of the accounts and their balances.
You can also print a shorter version of the report or worksheet that omits
accounts with no activity.

Information printed on the report
The fiscal period and range of accounts, segments, account groups,
or account sorted groups you chose to print.
The ordering of the report (either by account number, segment,

account group, or account sorted groups).
Debit and credit account balances in separate columns.
Additional columns on the worksheet for manual adjustments when
you are preparing financial statements.
The total debits and credits for all accounts listed on the report, and
the amount by which the report is out of balance (if you printed a
range of accounts).
The amounts and quantities (if applicable) of a rollup account and all
of its rollup member accounts (at any level), rolled up into a single
amount or quantity. (Rollup member account amounts are included
only once in the rolled up amounts.)
The net balance of all revenue and expense accounts included on the
report [stated as Net Income (Loss) For Accounts Listed]. If you
include all revenue and expense accounts, the figure will be the net
income to date.
See also
General Ledger reports
Printing the Trial Balance report

Financial Reporter Functions
Accounts in General Ledger contain two main types of data:
Account master information, which includes the account name,
account type, and other defining information concerning the account.
Fiscal set values, which are balances and net amounts stored with
each General Ledger account.
In the Financial Reporter functions, you gain access to this data -- and all
other data in the General Ledger.

Use FR Paste to create formulas
Each of the functions described in this section can be pasted into a
financial statement using the FR Paste command on the Financial
Statement Designer menu bar (under the FR menu). See FR Paste.
The FR Paste command inserts a function into the current cell, and
prompts you for each parameter of the function (so you don't have to
memorize parameters).
Information provided by Financial Reporter functions include:
FR

G/L option & company data, and
statement print options

FRACCT

account data, including optional fields

FRAMTFRAMTA

,

FRCREDITFRDEBIT

fiscal set data
,

fiscal set data

FRFISCAL

fiscal calendar dates

FRPOST

transactions detail data, including
optional fields

FRRATE

exchange rates

FRSDESC

segment code descriptions

FRTRNFRTRNA

,

FRTRNCRFRTRNDR

transactions detail data
,

transactions detail data

Typographic Conventions
This table shows the notational conventions used for functions.
UPPERCASE

Words appearing in uppercase
letters are function names.

()

Function arguments are
surrounded by parentheses.

,

Function arguments are
separated by a comma.

,

Optional arguments are
separated by a comma.

For example, the following function illustrates each of the features
defined in the table:
FRACCT(fieldname.account number)
or
FRACCT(fieldname.account number.criteria, format)
The optional criteria and format arguments are separated by commas.

Most Function Parameters are Text
Unless otherwise noted with the individual Financial Reporter functions,
all function parameters are text.
This means that parameters are either:
In quotation marks.
Or
A reference to a cell that contains a text value or a text-valued
formula.

Errors in Financial Reporter Functions
All Financial Reporter functions return ERROR if the parameters of the
function are wrong or if the referenced values are not defined. (In other
words, they display the word "ERROR" as the value of the financial

reporter function.)
The FRACCT function returns a blank if the account reference is missing
or the account cannot be found.
The FRAMT, FRAMTA, FRDEBIT, and FRCREDIT functions return "0" if
the account reference is missing or if a specific account cannot be found.
Financial Reporter treats the hyphen like zeros for line suppression if you
use the "Z" option.

Specifying Ranges of Accounts When the Account
Segment is not First in the Account Structure
Account references work best when the account segment is the first
segment of your account numbers. Not only is it easier to specify account
ranges, but Financial Reporter processes them more quickly as well.
If you do not have the account segment first, you can still specify a range
of account segment codes and print the accounts in account segment
order.
Note the following examples:
4000~8000 specifies all accounts with an account segment code
from 4000 to 8000, no matter how many segments are in
the number, and no matter where the account segment is
in the account structure.
A~C-400~600|ACCT specifies all accounts with an account segment
value between 400 and 600, and with a Department
segment value from A to C. “|ACCT” indicates that the
accounts are ordered by account segment.
%-400~600-%|ACCT specifies account segment values from 400 to
600, no matter what the value of other segments. Again,
the accounts are ordered by account segment.
%%|ACCT specifies all account numbers ordered by the account
segment. To specify a range or account segments, add a
criterion in column B, such as ACCTSEGVAL >= "4000"
AND ACCTSEGVAL >= "6000".
The last example is the most flexible, because it specifies a range of
account segment values no matter where the account segment lies in the
account structure. This is especially useful if you have more than one
account structure.
See also
Account Ordering, Processing Order, and Account Segment Ranges
Specifying Account Structures
Wild-card Characters in Account Code References

Consolidating the Financial Statements of Multiple
Companies in Microsoft Excel
To consolidate Excel financial statements for multiple companies:
1.Open the largest company in Sage ERP Accpac.
2.Open General Ledger > Financial Reporter > Statement Designer.
3.Open the Financial Statement that you want to consolidate and
generate it using FR View. These instructions will refer to this
generated sheet as Co#1.
4.Scroll to the generated portion of Co#1 (below the specification
section) and align the first line of descriptions at the topmost cell of
your screen.
5.Go to the tool bar at the top of your screen and click New, select
Sheet, then click OK. You will have a blank sheet covering your
screen. (These instructions will refer to this blank sheet as "Consol".)
6.Turn off "automatic calculation" in the new spreadsheet. If you do not
do this, the system will update your consolidated spreadsheet
continuously, slowing down the system.
7.Start with Sheet 2, leaving Sheet 1 for the consolidating sheet.
8.Copy, Paste, and Link all companies to separate sheets and then
consolidate within Excel to Sheet1. This will eliminate the problem of
viewing the tiled spreadsheets while copying cell references.
See also
General Ledger reports
Printing Financial Reports

Print Destination (in Print Financial Statements
form)
At the bottom of the Print Financial Statements form, you can find the
Print Destination selection area, where you select a print destination for
the financial statement. (For Financial Reporter statements, you use
these settings instead of choosing the destination from File > Print
Destination on the Sage ERP Accpac desktop.)
The choices include:
Printer:

Prints to a physical printer.

Preview:

Displays the report onscreen.

File:

Saves the report as a file.

E-mail:

Sends the report as an attachment in an e-mail.

See also
Fiscal Options
Report Type
Report as
Include
Sort by
Select Accounts

Fiscal Set Field Names
The following chart provides the names of all balance and net change
fields that you can print with the Financial Reporter.
After the chart of field names are two small charts listing the fiscal set
prefixes and fiscal year suffixes that can be added to the field names.
Note in the following codes that n is a number that can refer to the fiscal
period (from 1 to 13) or to the quarter (from 1 to 4).
In addition, you can print year-end adjustments and transactions to close
income accounts to retained earnings with NETADJ and print closing
figures with NETCLOSE and BALCLOSE.

Prefixes to NET and BAL indicate the fiscal set
(for example, "QNETP")
NET and BAL can have a prefix A, P, Q, QA, QP, 1*, 2*, 3*, 4 or 5 to
indicate actual, provisional, quantity, quantity actual, quantity provisional,
or any of the five budget sets. (*Budget sets 1 and 2 are only available in
Sage ERP Accpac 100, while budget sets 1, 2, and 3 are available in
Sage ERP Accpac 200. Budget sets 4 and 5 only apply to Sage ERP
Accpac 500.)
If no prefix is specified, the default is either actual or provisional
depending on the type of the report. Similarly, "Q" by itself is either actual
or provisional quantities depending on the type of report.
For example, "BALP" provides the actual or provisional balance at the
current fiscal period "ABALP" always provides the actual balance; and
"1BALP" provides the balance from budget set 1 for the current fiscal
period.
Field
description

Reporter
BAL
code
(balance)
suffix

NET
(net
changes)

Period balance and net
change
Current period

P

BALP*

NETP*

Last period

LP

BALLP

NETLP

nth period

nP

BALnP

NETnP

n periods ago

nPA

BALnPA

NETnPA

Current quarter (to
Q
end)

BALQ

NETQ

Current quarter to
QTD
date

BALQTD

NETQTD

Last quarter

LQ

BALLQ

NETLQ

Last quarter to
date

LQTD

BALLQTD NETLQTD

nth quarter

nQ

BALnQ

Quarter balance and net
change

NETnQ

nth quarter to date* nQTD

BALnQTD NETnQTD

n quarters ago

nQA

BALnQA

n quarters ago to
date*

nQATD

BALnQATD NETnQATD

NETnQA

Preceding quarter
PQ
(3 prds*)

BALPQ

Preceding qrtr. n
prd. ago

BALPQnPA NETPQnPA

PQnPA

NETPQ*

Half year balance and net
chg.
Current half year
(to end)

S

BALS

NETS

Current half year to
STD
date

BALSTD

NETSTD

Last half year

BALLS

NETLS

LS

Last half year to
date

LSTD

BALLSTD NETLSTD

nth half year

nS

BALnS

nth half year to
date*

nSTD

BALnSTD NETnSTD

n half years ago

nSA

BALnSA

NETnS

NETnSA

n half years ago to
nSATD
date*

BALnSATD NETnSATD

Preceding half yr
(6 prds*)

BALPS

PS

Preceding half yr. n
PSnPA
prd ago

NETPS

BALPSnPA NETPSnPA

Total year balance and net
chg.
Total year

Y

BALY

NETY

Year to date

YTD

BALYTD

NETYTD

Preceding yr (12 or
PY
13 prds)

BALPY

NETPY

Preceding year. n
PYnPA
prd. ago

BALPYnPA NETPYnPA

Beginning of year. OPEN

BALOPEN

End of year*

CLOSE BALCLOSE NETCLOSE

Period 14
adjustments

ADJ

NETADJ*

Figures are computed relative to the report period
All fiscal set field values are computed relative to the fiscal period set for
the report, except for BALOPEN, NETADJ, BALCLOSE, NETCLOSE,
and fields referencing a specific time period.
BALOPEN is the opening balance of the account for the year,

NETADJ is the amount posted to the adjustment period,
BALCLOSE is the closing balance of the account, and
NETCLOSE is the amount posted to the closing period.
References to future periods return zeros as if the transactions had not
yet been posted.

Fiscal Set Prefix
Code

Fiscal Set

Blank

Defaults to report setting -- either
actual or provisionally-posted
amounts

A

Actual monetary figures

P

Provisionally-posted monetary
figures

Q

Quantities (either actual or
provisional depending on the
report setting)

QA

Posted quantities

QP

Provisionally-posted quantities

1,2,3,4,5

Budget sets 1*,2*,3*,4*, and 5*

R

To retrieve the rollup amount.
The R must be the first character
and can be used in conjunction
with other prefixes.

*Budget sets 1 and 2 are available if you are using the Sage ERP Accpac
100 edition; budget sets 1, 2, and 3 are available in the 200 edition, while
all five budget sets are available in the 500 edition.
For FRTRN, FRTRNA, FRTRNCR, and FRTRNDR commands, the fiscal
set designators available are A, Q, and QA.

Fiscal Year Suffix
The fiscal year suffix is the last part of the field name parameter, and is
separated from the field name by a period. For example, in the following
formula, "ABALP" is the actual current balance, and "2008" is the fiscal
year suffix.
FRAMT("ABALP.2008","1000%","(ACCTTYPE="B")")
Code

Fiscal Set

Blank

Defaults to current year

2008, 2009,
Specific year identification
etc.
L1, L2, L3
etc.

Last year, the year before, etc.

N1, N2, etc. Next year, the year after next, etc.
References to non-existent data will return "#ERROR."

Currency Code and Currency Type
The currency code reference has two parts: currency code and currency
type, which are separated by a period. For example, in the following
formula, "DEM" is the currency code, and "R" is the type (reporting
currency).
FRAMT("PBALP.L1","1000-33-248"; "DEM.S")
Currency
Code

Fiscal Set

Blank

Defaults to functional (home) currency

xxx

A three character currency code (such
as CAD for Canadian dollars, USD for
US dollars).

Currency
Type

Fiscal Set

Blank

Defaults to home (functional)

currency
S

Source currency

E

Equivalent amount in the functional
currency

F

Functional currency total (including
functional equivalents of all source
amounts)

R

Reporting currency (only available if
you selected the euro as your
functional currency and specified a
reporting currency in the Company
Profile form in Common Services)

Date formats
The date formats in some versions of Excel are set to jj/mmm/aa instead
of dd/mmm/yy if you choose Canada[English] for the country setting in
the Windows Control Panel. If you have problems with dates in your
statements, choose the International icon from the Control Panel, and
select US or Other Country instead of Canada.
See also
FR
FRAMT
FRAMTA
FRCREDIT
FRFISCAL
FRPOST
FRRATE
FRSDESC
FRTRN
FRTRNA
FRTRNCR
FRTRNDR

Differences between printing from the Financial
Statement Designer and printing from the
Financial Statements icon
The Financial Statement Designer's print form is not identical to the
Financial Statements form which appears when you choose the Financial
Statements icon.
The Financial Statement Designer differences are as follows:
You can generate an audit information tab as well as account audit
information in the first column of the report. (See Include.)
The audit information tab lists information such as the print ranges
and any specified processing order.
You can create formulas for each value that appears in the report
range instead of the values themselves. (See Include.)
This means that you can update the report simply by recalculating the
spreadsheet. (Note that spreadsheet formulas make the spreadsheet
a lot larger.)
If you generate a series of statements for a group of departments, the
separate statements are generated in consecutive sheets in an Excel
workbook. (See Report as.)
When you print a set of statements using the Financial Statements
icon, the program repeats the report generation process for each
account segment, printing a series of separate statement.
See also
General Ledger reports

Segment Codes Field List
For help with the fields in the Segment Codes form, select from the
keywords listed below:
Segment name
Segment code
Description
Closing account

Before Adding an Account
Before you can add an account, you must decide the following:
The account number and description (name) of the account.
The account structure code.
The account type, and normal account balance (debit or credit)
The account group in which the account belongs, if account groups are
used for the company.
Whether to post transactions in detailed or consolidated form, or to
prohibit posting to certain accounts.
Whether to close an income or expense account to an account
specified for a particular account code segment.
Whether this account is to be used as a control account for a subledger, and
if so, for which subledger.
Whether to reallocate the account balance to other accounts on a
regular basis, and if so, to which accounts and in what proportions.
The currencies in which you want to enter transactions for the account
(if you have a multicurrency ledger).
Whether to store additional information for the account by using
optional account fields.
Whether you want to keep optional fields with transactions you post to
the account.
Whether to maintain quantity data for the account, and, if so, the unit of
measure to use.
Whether to roll up accounts, and which accounts can be rolled up.

Design the chart of accounts carefully before
adding any accounts
How you organize your chart of accounts depends on how you intend to
use particular features of the General Ledger system.

You must decide:
Which accounts you need.
Which account segments each account requires.
How you will assign account numbers.
Design your chart of accounts carefully. It is much easier to move
accounts around before entering them, than to change them afterward.
See also
Detail tab
Allocation tab
Currency tab
Subledger tab
Rollup tab
Adding a new account
Displaying account information

Post to Account
When you define an account in the G/L Accounts form, you specify
whether the individual debit and credit details entered for the account are
to be posted in detail or consolidated form, or whether users are
prohibited from posting to the account.
Detail. All the debits and credits posted to an account are kept and
can be listed individually on source journals and the G/L Transactions
Listing report. You can also select Detail to save optional field
information with transactions.
Consolidated. If you post consolidated transactions, the optional
transaction fields are not saved.
There are two methods of consolidating posted amounts in General
Ledger:
During the posting process if you select the consolidated posting
option for the account.
After the transactions have been posted using the Consolidate
Posted Transactions form.
Prohibited. Users cannot post to an account.

G/L Create Accounts Preview Form
The GL Create Accounts Preview form displays a list of accounts that the
program will add to your chart of accounts when you click Preview in the
G/L Create Accounts form.
The G/L Create Accounts Preview lets you change the accounts before
you add them permanently to your chart of accounts, as follows:
You can change the entry in the Create field only if you have not yet
processed the account. If you do not wish to create an account that is
marked Yes for creation, change the entry to No for the selected
account by double-clicking the Create field, or by selecting the field
and pressing the spacebar.
When you select a preview account that is based on a subledger
control account, the Subledger button becomes available.
To view or change the information that will be added to the Subledger
tab on the new G/L Account record, click the Subledger button. You
can also double-click the Control Account field for any account whose
control account attributes you want to change.
When you select a preview account that is based on a multicurrency
account, the Currency button is available.
To view or change the information that will be added to the Currency
tab of the G/L Account record, click Currency button. You can also
double-click the Default Currency field of a multicurrency account to
change the default currency for the account.
When you select a preview account to which the program will assign
optional account fields or optional transaction detail fields, the
Optional Fields and the Trans. Optional Fields buttons become
available.
To view or change the optional fields that will be added to the Optional
Fields tab of the G/L Account record, click the Optional Fields button.
The Preview Account Optional Fields form appears.
To remove an optional account field, highlight that line on the grid,
then press the Delete key.

To add an optional account field, press the Insert key, double-click
in the Optional Field column for the line you are editing, then enter
the code for the optional field or use the Finder to select the code.
To change the default value for the optional account field, doubleclick in the Value column for the line you are editing, then enter the
value or use the Finder to select it. (Note that if the optional field
requires validation, you must select a value you have set up for the
field in Common Services.)
In the G/L Optional Fields setup form, double-click in the Value Set
field to change the entry from No to Yes. Also, optional fields which
are set as Required in the G/L Optional Fields setup form need to
appear in the Optional Fields zoom form in the Create Accounts
preview. The system won't allow you to proceed until required
optional fields appear in the Optional Fields zoom form.
To view or change the optional transaction details fields that will be
assigned to the account on the Trans. Optional Fields tab, click the
Trans. Optional Fields button. The Transaction Optional Fields dialog
box appearsl, displaying any transactional optional fields that were
previously selected.
To remove an optional transaction details field, select it on the grid,
then press the Delete key.
To add an optional transaction details field, press the Insert key,
double-click in the Optional Field column for the line you are
editing, then enter the code for the optional field or use the Finder
to select the code.
To change the default value for the optional account transaction
details field, double-click in the Value column for the line you are
editing, then enter the value or use the Finder to select it. (Note
that if the optional field requires validation, you must select a value
you have set up for the field in Common Services.)
For the account you are going to create, you can set up the
following options for Transaction Optional Fields:
Value Set
Default Values

Required
Auto Insert.
Transaction Optional Fields which are set to Required in the G/L
Optional Fields setup form for Transaction Details need to be in
the Trans. Optional fields zoom form in the Create Accounts
Preview. The system won't allow you to proceed until required
transaction optional fields appear in the Transaction Optional
Fields zoom form.
Note: If you have not yet processed an account, No appears in the
Processed field.

Oldest Fiscal Year Starting Date
General Ledger uses this date for two separate purposes:
To create fiscal calendars that begin with this month and date.
General Ledger creates calendars for the current year and all
previous years to one year before the date you enter here. The year
prior to the Oldest Fiscal Year is required for opening balances (which
you post to period 12 or 13 of the year).
To set the current fiscal year to the year for your opening balances.
You are then ready to enter your prior-year data.
The best way to add prior-year data is to:
Set the fiscal year to the first year, enter and post final-period
balances, then create the next year (thereby closing the currentyear income and expense accounts to retained earnings and
moving the current fiscal year to the newly opened year).
Enter and post period net changes for each of the prior years,
creating a new year after entering each year's batches to close to
retained earnings and advance the current fiscal year.
Enter and post current-year transactions (or period net changes)
up to the current period.

Sample starting dates
For example, if your fiscal year starts on April 1, and you want
comparative figures from April 1, 2002, enter 04/01/2002.
If you don’t want to enter any prior-year data, enter the current year. Note
that you cannot change to an earlier date after activation.
See also
Current Fiscal Year after Activation
Designing Your General Ledger
G/L Options form
Setting Up General Ledger

Default Source Code
Enter, or select using the Finder, the source code you prefer to use as the
default in Journal Entry.

Optional Fields (indicator)
The Optional Fields check box on the Journal Detail form and the
Optional Fields column on the detail entry grid (on the Journal Entry form)
indicate whether any optional fields are assigned to a selected journal
entry detail.
If you assigned optional transaction fields to the account used in a journal
entry detail, the program selects the check box.
You can view or change the optional fields assigned to a selected detail
on the Optional Fields detail form.
To open the Optional Fields detail form, either:
Click the zoom button ( ) beside the Optional Fields check box on the
Journal Detail form.
Or
Select the detail line on the detail entry grid, then press Shift+F9.
You can then edit or delete the optional fields in the Optional Fields detail
form that appears. If you delete all the optional fields for a detail, the
program unchecks the Optional Fields check box (or field) for the detail.
You can add any transaction optional fields that are assigned to the
account.
Optional Fields should be set to Yes for the transaction detail to be saved
or inserted. To set this to Yes, double-click on the Value. You can specify
a value or leave it blank, depending on how you set up the optional field
in Common Services. Also note that if you have optional fields set up as
Required for an account in the transaction detail (you set this up in the
Accounts/Trans. Optional Fields), the system won't let you proceed if this
optional field is missing in the transaction detail. Make sure the optional
field exists and that it is set to Yes if you want the transaction detail
saved.

